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13,14).
4. Diagram on 1-4 shows HOST to CAM connection. If AVCHI is used, this connection is replaced by HOST to APC100

COM3.
5. Should VisionCube be added to table on pg 1-5?
6. Update OLH screens (pgs 1-18 and 5-34,35) so the module # references are current.
7. Get software to properly identify the Active Symbology List on the Symbology tab (3-4).
8. Define Com Initialization String (3-16).
9. Define Serial Trigger Mode (3-22).
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16. Get software to eliminate reference to the Decoder as PC on Utilities Menu and message screens (5-19,33).
17. Need to clarify/correct Test Focus Value button info and screens (5-28).
18. Add details to Utilities/Smart Illum Control and Status (5-31,32). (See list of questions concerning this feature.)
19. Need to update screens for About Accu-Setup and About Camera (5-38). Note that the screen in the manual for

About Accu-Setup does not mention it is for AccuVision.
20. Need an update of Compatibility screen (5-39).
21. Confirm/correct the Dimensioning min/max values for Appendix B (6-7).
22. Should we add a SMIO Commands list as an Appendix in Chapter 6?
23. Add missing terms to glossary (app.E). For example: Aztec and RSS codes and all terms for dimensioning.
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Microsoft, Windows, and Windows NT are registered trademarks of the Microsoft Corporation.
POSTNET and PLANET are trademarks of the United States Postal Service.



I

INTRODUCTION

This is the Accu-Setup for AccuVision Software Manual Version 4.0.
It provides details on everything you need to operate the setup software provided
with your AccuVision System.

MANUAL NOTE BOXES

The following note boxes are used throughout this software manual to assist the
reader in finding and understanding many useful details regarding the Accu-
Setup for AccuVision software program.

This note box is used to identify important WARNINGS and CAUTIONS regarding the
use of certain procedures and functions available in Accu-Setup. In many cases,
these WARNINGS and CAUTIONS advise you that use of a given function may
adversely affect system performance or may require the assistance of an Accu-Sort
trained and authorized technician.

This note box is used throughout the manual to identify supplementary information
important to the current topic. Important information, cross-references, and useful
tips are contained in these note boxes throughout the manual.

MANUAL REVISION CONTROL

The Accu-Setup for AccuVision Software Manual Version 4.0 is under revision
control. Any addenda or other documents associated with this manual are under
separate revision controls. A revision number is changed by 0.1 whenever
technical information is changed or added to a document. Any revision less than
1.0 is automatically considered preliminary. Any document with a revision 1.0 or
greater has been officially released by the Accu-Sort Systems ECN process. The
document Revision History can be found in Appendix F located in Chapter 6
of this manual.

DISCLAIMER

No part of this document is to be reproduced or utilized in any form or by any
means, electronic or mechanical, including photocopying, recording, or by an
information storage and retrieval system without the prior written consent of
Accu-Sort Systems, inc. All materials contained in this manual are the property
of Accu-Sort Systems, inc. and shall not be reproduced, copied or used in whole
or in part as the basis for the sale or manufacture of software or devices without
prior written permission.

Copyright© 2001 Accu-Sort Systems, inc.
All Rights Reserved
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SOFTWARE LICENSING AND WARRANTY
INFORMATION

USE OF SOFTWARE AGREEMENT

You have received, along with your Accu-Sort product, a copy of Accu-Setup for
AccuVision. This software is available for use on as many PCs as you require.
You may have received a copy of Accu-Setup that can be used with your network
and can be made available to all network users. Or, you may have received a
single user version of Accu-Setup. Feel free to have this software in use by as
many users as necessary or copy this program to as many PCs as you require.

The software you have purchased is not copy protected, allowing you to make
working copies of the program and one backup copy for archival purposes.

WARRANTY

Accu-Sort Systems, inc. warrants the physical disks and physical documentation
to be free of defects in material and workmanship for a period of 30 days from
the date of purchase. In the event of notification within the warranty period of
defects in material or workmanship, Accu-Sort will replace the defective diskette
or documentation. The remedy for breach of this warranty shall be limited to
replacement and shall not encompass any other damages.

Accu-Sort specification disclaims all other warranties of merchantability and
fitness for any particular purpose. In no event shall Accu-Sort be liable for any
loss of profit or any other commercial damage.

Additional details on the coverage, support, and services available for your bar
code scanning and automated systems equipment is available from:

Accu-Sort Systems, inc.
2800 Crystal Drive 511 School House Road 2398 North Penn Road
Hatfield, PA 19440 Telford, PA 18969 Hatfield, PA 19440

Phone: (215) 723-0981
1-800-BAR-CODE

FAX: Telford Main ........... (215) 721-5551
Customer Service... (215) 723-1515
Systems ................. (215) 996-8181
Sales...................... (215) 996-8282
Acct/Mktg ............... (215) 996-8249
TMS ....................... (215) 996-8787
North Penn............. (215) 997-4848

Internet: www.accusort.com
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CHAPTER 1: INTRODUCING ACCU-SETUP FOR
ACCUVISION

Welcome to Accu-Setup for AccuVision, the Windows®-based program used to
configure your AccuVision Camera Systems. It is the primary user interface to
set up, monitor, and diagnose the operations of your AccuVision System. Accu-
Setup also enables you to modify the operating parameters of your AccuVision
System to accommodate any changes you may need to make in the future.

AccuVision: Accu-Setup Main Window (AVM4.0)

When Accu-Setup is launched, the Accu-Setup Main Window is displayed as
shown above. There are several drop-down menus and a button bar menu
available from the Accu-Setup Main Window as well as two information
windows, Camera Type and Communication Log.

Before learning more about the Accu-Setup software, it is important to have a
basic knowledge of the various components that are included in your AccuVision
System. This background information will enable you to better understand how
Accu-Setup works within your system.

NOTE: It is not the intent of the Accu-Setup for AccuVision Software Manual
to cover any details specific to the camera, illumination, decoder, and other
components of your AccuVision system. For further details on the components
used in your system, please refer to the manuals provided with your system.



ACCU-SETUP FOR ACCUVISION SOFTWARE MANUAL   VERSION 4.0 1-3

Solutions with vision.

THE ACCUVISION SYSTEM

The AccuVision System incorporates a set of hardware modules (also referred to
as the AccuVision system) that are utilized, along with the AccuVision software,
to track packages through a scanning area while imaging and processing data
from the surfaces of the packages.

What sets AccuVision Systems apart from other scanning systems is the use of a
camera (i.e.: lens and single-line CCD sensor array) instead of a low-power laser,
to image and decode bar code symbologies. While AccuVision Systems can be
used in nearly all decoding applications to improve read rates at higher speeds,
they are primarily used in applications where two-dimensional symbologies
cannot be accurately decoded with a traditional laser scanner.

ACCUVISION APPLICATIONS

In addition to reading 2D symbologies, an AccuVision System can be used in a
variety of imaging and decoding applications. For example: Data from the
AccuVision System may be used for the sortation and routing of product. This
data is also made available for transmission to a host computer.

Applications Description
Image-Only The AccuVision system is used to capture only images of the

packages. These images are then sent to a peripheral for
further processing.

Decoding An AccuVision system is used to detect and decode valid bar
code symbologies located on packages that pass through the
scanning area.

Imaging & Decoding AccuVision is used to both capture images and decode valid bar
code symbologies detected on packages.

Tunnel Two or more AccuVision cameras are clustered around the
scanning area to detect bar codes from several package
surfaces simultaneously.

OCR Optical Character Recognition
VES Video Encoding System
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ACCUVISION HARDWARE COMPONENTS

All AccuVision Systems consist of three basic components: a camera, a light
source (illumination), and a decoder as illustrated in the following block diagram.

ACCUVISION
CAMERA

ILLUMINATION

APC100
DECODER

LIGHT
CURTAIN

17” COLOR
SVGA MONITOR

KEYBOARD
w/TRACKBALL

TACHOMETER

PHOTOEYE

HOST
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TRIG

FOCUS

ILLUM

COM

GRAY
IMAGE

DATA

HOST

QUAD RELAY BOXI / O

UNINTERRUPTABLE
POWER SUPPLY

GRAY
IMAGE

DATA
AUX

SYNC
OUT

AccuVision System Block Diagram

The primary function of the basic AccuVision components is imaging and
decoding. As the block diagram illustrates, an AccuVision System may include
several additional hardware components. Your application requirements define
the hardware configuration used for your system.
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Hardware Description
Camera Also referred to as the imaging module, the camera is an integrated

imaging system that incorporates a camera head, Smart Input/Output
(SMIO) interface, and power supply. The camera also includes either a
fixed-position or dynamically adjustable focusing mechanism.

Illumination This device provides the lighting needed to adequately illuminate the
scanning area where packages are imaged. Some cameras use a self-
contained illumination source while others use an illumination module that
is separate from the camera. The light source is either sodium or LED.

Trigger This device is used to identify the presence of a package within the
scanning area. The majority of applications use either a light curtain or
photoeye as the trigger. When a light curtain is used, it also performs the
focusing function.

Focusing In applications where package sizes vary, typically a light curtain is used to
detect the variations in package height as they enter the scanning area.
(Also see Dimensioning option.)

Tracking This device is used to monitor the travel of packages as they move through
the scanning area. Either a tachometer or a signal from the transport is
used or the camera is set up internally to handle tracking.

Decoder Image data from the camera is sent to the decoder for analysis and
decoding. Resident on the decoder are the Accu-Setup, AVCore, SMIO
Talk, AVCHI, and Decode Engine software modules.

Monitor/Keyboard
(optional)

This option is used, in conjunction with the decoder, to set-up, view, modify,
and troubleshoot the AccuVision system using Accu-Setup.

Dimensioning
(optional)

This optional approach is used instead of a light curtain trigger to provide
more complete dimensioning information to the AccuVision system.
Depending on the application, either VisionCube dimensioning software or
a DM-3000 dimensioning unit may be used.

Quad Relay Box
(optional)

This optional component is used to control the interface between up to four
digital outputs from the camera and the external devices they are
controlling (e.g.: alarms, diverters, etc.).

ACCUVISION SOFTWARE COMPONENTS

 An AccuVision system also utilizes the AccuVision Suite of software. In most
applications, all five software applications reside on the Accu-Sort APC100
Decoder. This manual covers the Accu-Setup for AccuVision Software version
4.0.
 

 Software  Description
 Accu-Setup  The Windows®-based primary user interface that provides all the necessary

functions to set up, monitor, and diagnose the operations of an AccuVision
System.

 AVCore  The main WindowsNT®-based application running on the decoder that provides a
program interface for the decoder as well as advanced image collection and
diagnostics. Additionally, AVCore contains multiple threads for real-time data
movement and time critical processing.

 AVCHI  The AccuVision Custom Host Interface (AVCHI) is a customer-specific application
designed to provide a customized interface for systems utilizing a host computer.
AVCHI provides all communications between the AccuVision system and host,
including the formatting and transmission of messages and responses to host
commands.

 SMIO Talk  A WindowsNT® application that provides a TCP/IP communication interface from
the camera’s SMIO to the outside world. Enables multiple external processes to
occur simultaneously. AVCore, Accu-Setup, and AVCHI communicate with the
camera through SMIO Talk.

 Decode
Engine

 The Decode Engine analyzes the image data and decodes valid bar codes based
on the symbology parameters defined using Accu-Setup. All data from the
Decode Engine is provided to AVCore for the necessary handling through AVCHI
to the host computer or other customer-supplied device.
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 HOW ACCUVISION WORKS

 The process starts when a light curtain or photoeye detects the leading edge of a
package.  Using transport speed information the camera tracks the package to the
scan line.  If the camera includes dynamic focusing, the focal point of the camera
is adjusted to match the distance from the surface of the package.
 
 As the package passes through the scan line (i.e.: the area imaged by the CCD
sensor array) the reflected light from the surface is collected by the camera lens
and focused on the CCD array. The array is a single line of photosites
(commonly called pixels) that convert the light energy into electrical energy.
The electrical signals are processed into gray scale image data, which is
transmitted out the camera’s GRAY IMAGE DATA port.  Optional binary
image data can be provided simultaneously over the same gray data port by
adding a binary board to your system. The camera transmits height and speed
information out a serial port.
 
 The AccuVision Camera, also known as an imaging module, is positioned in a
designated scanning area along the path of package travel. Camera(s) and their
associated illumination modules are set up to read images from predetermined
surface(s) of the packages. Where images must be read from more than one
package surface, more than one camera may be used in what is called a tunnel
configuration.
 

 

NOTE: The camera used by your AccuVision System is identified in the Camera
Type information window of the Accu-Setup Main Window when a connection
with the camera is established. The AccuVision cameras that are compatible with
your version of Accu-Setup are identified in the Compatibility List found in the
Help drop-down menu. (See Chapter 5 for details.)

The camera head (located inside the camera module) contains:
•  the lens,
•  auto-focusing optics, and
•  a single-line CCD sensor array.

While the imaging module is referred to as a camera, it does not create images by
taking “snapshots” of packages. Instead, the linear CCD sensor array uses a
single scan line to build images, line-by-line, as packages move through the
scanning area. For this reason, the speed at which a package travels through the
scanning area must be consistent to assure proper imaging and/or decoding takes
place. (For details, see How Images Are Acquired on page 1-10.)

The illumination module (connected to the camera’s ILLUM port, unless self-
contained within the camera) is the light source that is used to illuminate the
packages to be imaged. While laser scanners rely on reflected laser light to
perform the scanning process, cameras utilize either a line of LEDs or sodium
lamp(s) as the light source for this task, depending on the depth of field required
by the application. (For additional details, see the manual for your illumination
module.)

Tracking of packages through the scanning area is of particular importance to an
AccuVision system since the camera is dependent on consistent travel speeds in
order to assure accurate imaging and/or decoding. In applications where the
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conveyor may vary in speed or may be stopped and started frequently, a
hardware tachometer is physically mounted to the conveyor and connected to the
camera through the TACH port of the camera. (A direct signal from the transport
may also be used for tracking.)  If the conveyor is running at stable and regular
speed with little chance of variation, a software tach is used, as programmed
through Accu-Setup.

A trigger device provides package detection, alerting the AccuVision system
when and where packages enter the scanning area. The trigger device being used
varies depending on the application. In applications with a limited depth of field
a photoeye is often used and is connected to the TRIG port of the camera. When
a larger depth of field is needed, a light curtain is used to provide not only a
trigger to identify the package presence but also to define the height of package.
The light curtain, connected to the camera’s FOCUS port, uses a series of
emitters and receivers, positioned 0.25 inches apart, to provide package height
information to the camera so it can dynamically focus its optics.

The relationship of the camera, illumination module, and trigger mechanism
(either light curtain or photoeye) to the conveyor and direction of package travel
are illustrated in the AccuVision Scanning Area Diagram.

AccuVision Scanning Area Diagram (Side View)

NOTE: In the AccuVision Scanning Area Diagram, DPI (Dots Per Inch) refers to
the resolution of the camera at the far working distance. The camera optics
disperses the scan line as the distance from the camera increases. Information
about the camera head can be used to determine the DPI, minimum/maximum
optical distances, and the DPI at those distances. For these details, see About
Camera Head in the Help drop-down menu. (See Chapter 5.)
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The gray data and package data are sent to the AccuVision APC100 Decoder
Module (or other customer-supplied peripheral). Accu-Sort’s decode software
analyzes this image data to locate and decode bar code symbols on the surface of
the package.

The decoded data is then available for other applications. Typically, this data
would be transmitted via a serial port or an Ethernet connection to a sorter
control system or to an inventory control database (or both).

The AccuVision camera is set up for either fixed focus or dynamic focusing. A
fixed focus is used to image packages that are all the same height. The internal
camera optics are set at a fixed focal point so it remains focused at the same
height (within 0.50 inch). Dynamic focusing is used when package heights vary.
The internal camera optics adjust their focal point based on parameters defined
within Accu-Setup and physical package detection provided by the light curtain
or dimensioning system.

The Smart I/O (SMIO), is located in the camera and is considered the
AccuVision control center. All physical interconnections between the camera,
other AccuVision modules, and the outside world occur through the SMIO. The
SMIO is a single-board computer that provides real-time control of the
illumination, package detection, and package tracking, while monitoring the
operation of the system, controlling imaging, and handling all communications
with the Accu-Setup user interface and the host computer.

The Accu-Sort Decoder (APC100), performs all pattern recognition functions to
identify any data imaged by the camera that may be valid bar code symbologies.
As shown in the AccuVision Functional Block Diagram, the decoder contains the
AVCore, Accu-Setup, AVCHI, SMIO Talk, and Decode Engine software
modules. The decode engine utilizes the majority of the decoder resources. Accu-
Setup is accessed through a host network connection to the AccuVision System
or by a remote PC connected to the Decoder.

Either the VisionCube dimensioning software or an Accu-Sort Dimensioning
System (DM-3000) is used with an AccuVision System when imaging several
sides of packages, as in a tunnel configuration when several cameras are used to
image the top, bottom, front, and sides of products. The DM-3000 is mounted
over the conveyor and uses a solid state laser diode and linear CCD array to
provide width and height data to the AccuVision cameras. A tachometer and
photoeye combination (separate from that used by the AccuVision System) is
used to measure the length of packages and determine package orientation on the
conveyor.
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The following functional block diagram illustrates how the AccuVision hardware
is interconnected and how the software handles data between the hardware and
software components.

AccuVision Functional Block Diagram
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HOW IMAGES ARE ACQUIRED

The camera is either preset at a fixed focus or is dynamically focused to
compensate for variations in distance between the camera and packages in
response to the signal from the light curtain or dimensioning system. When
dynamically focused, the focus response time is ≤ 70 milliseconds.

The light reflected from the package is collected through the lens of the camera
and focused onto the linear CCD sensor array.

When a 2-tap (i.e.: 2-channel) configuration is used, the light value for all odd
numbered pixels (starting with pixel 1) are buffered through one channel while
the light values from the even numbered pixels (starting at pixel 2) are buffered
through the second channel. (See the illustration below, Image Acquisition - 2
Channels.)

Image Acquisition – 2 Channels Image Acquisition – 4 Channel

Lines per inch (LPI) defines the number of scan lines that the camera is required
to generate per inch of conveyor travel. The scan line frequency (also referred to
as scan line rate) represents the speed at which the camera needs to “clock” data
out of the array to meet the required LPI. For example: A camera that has a 100
LPI requirement running at 500 FPM needs a scan line rate of 10,000
scans/second. If 100 LPI is required at 250 FPM, a scan line rate of 5,000
scans/second is required.

When a 4-tap (i.e.: 4-channel, 25MHz/channel) configuration is used, the scan
line rate is approximately doubled. (See the illustration above, Image Acquisition
- 4 Channels.) This is accomplished because the light values are buffered into
even and odd buffers starting with both the left and right side of the array
simultaneously.

The linear CCD sensor array converts the reflected light energy into an analog
voltage. The analog information is then processed by the Decode Engine.
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HOW IMAGES ARE PROCESSED

AccuVision Systems being used for image capture and processing convert gray
scale data into binary image data on the SMIO. An example gray scale image and
binary image are provided below. This data is output through the GRAY
IMAGE DATA port on the camera. Each pixel’s data is 8 bits (7 most
significant bits are gray data and the last significant bit is binary image data,
either 0 for black or 1 for white). This process is not required for bar code
reading.

Gray Scale Data Image Binary Data Image

NOTE: Additional details on the GRAY IMAGE DATA port (including mechanical
and electrical interfaces) are available from Accu-Sort. Contact your customer
service representative for more information on the document AccuVision Real
Time Imaging Systems Camera Output Specifications.
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GETTING TO KNOW ACCU-SETUP

INFORMATION WINDOWS ON MAIN WINDOW

There are two information windows at the bottom of the Accu-Setup Main
Window that provide basic information about your AccuVision: The Camera
Type and Communications Log information windows.

Accu-Setup for AccuVision Main Window (AVM4.0)

Camera Type

The Camera Type information window identifies the type of camera used by the
system and whether the system is Image Only or Decoder based. There are three
tabs available in the Camera Type Window: SMIO, AVCore, and Decoder.

NOTE: The information in all three tabs is useful for diagnostic purposes. Please
have all Accu-Setup Main Window tab information available before contacting
Accu-Sort customer service regarding your AccuVision System.
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SMIO Tab

The SMIO (Smart I/O) is responsible for basic system control and
internal/external data and communications interfaces. It provides real time gain
and offset correction of raw pixel data from the sensor board.

Camera Type Information Window – SMIO Tab

The SMIO tab provides the following details:

Tab Item Description
Software Name Version of SMIO software the system is currently running.
Command Version Version of Accu-Setup SMIO command file.
System Name User-definable name. For more information about entering a

system name, or to change the name, see Useful Tip below.
Serial Number Factory-set camera serial number. For more information, see

Useful Tip below.

USEFUL TIP: It is recommended that your camera have a descriptive name
entered for System Name. This is especially important in systems with multiple
cameras (e.g.: tunnel applications). Use a concise yet descriptive System Name,
for example: Camera1/Lane1 or Camera1/TopRead. To define the system name,
use Modify Camera Name and Serial Number found in the Utilities drop-down
menu for more information. (Go to Chapter 5.)

AVCore Tab

AVCore, a Windows NT® application, is the software interface between the
decoder and camera. AVCore also provides TCP/IP communication interface
from the SMIO to the outside world as well as advanced diagnostics and image
collection.

Camera Type Information Window - AVCore Tab
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The AVCore tab provides the following details:

Tab Item Description
Software Name Version of AVCore software the system is currently running.
Command Version Version of AVCore software command file currently running.
Network Information about the camera IP address, Gateway address, and

Netmask options if your system is connected to a network. In the
example of the Camera Type Information Window - AVCore Tab, the IP
address is 10.0.40.26, the Gateway address is 10.0.16.21, and the
Netmask is 255.255.240.0. (For additional details on these settings, see
Modify Setup / Communication Tab / Advanced in Chapter 3.)

Decoder Tab

The decoder is responsible for locating and decoding bar codes from the data
supplied by the camera through the SMIO. Decoded bar code data is processed
through AVCore, which is also resident in the decoder.

Camera Type Information Window – Decoder Tab

The Decoder tab provides the following details:

Tab Item Description
Software Name Name and version of the decoder software the system is using.
Command Version Version of the decoder command file the system is currently using

to communicate with the camera.

NOTE: This tab will be blank if the system is not using a Decoder.

NOTE: This tab will be blank if the system is not using a Decoder.



ACCU-SETUP FOR ACCUVISION SOFTWARE MANUAL   VERSION 4.0 1-15

Solutions with vision.

Communication Log

The Communication Log information window on the Accu-Setup Main
Window shows a real-time scrolling list of messages about the status of the
AccuVision current operations. Additionally, any Accu-Setup functions
performed by the user are displayed along with any related responses from the
AccuVision system.

Communication Log
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BUTTON MENU

Accu-Setup provides the following Button Menu selections from the Accu-Setup
Main Window:

NOTE: The following functions are also available from the drop-down menus
provided across the top of the Accu-Setup Main Window: Retrieve from Camera,
Retrieve from Disk, Save to Camera, Save to Disk, and Diagnostics and Utilities.

Button Menu

Button Menu Description
Establish Connection A toggle button that is used to establish and release

connections to your camera(s).
Retrieve From Camera Used to retrieve the current set of parameters being used

by the camera connected to Accu-Setup.
Retrieve From Disk Used to retrieve a set of parameters that have been stored

to disk.
Modify Setup Provides access to a series of 12 tabs that enables you to

setup or modify these parameters: Symbologies,
Communications, Trigger, Tracking, Imaging, Decoder
Diagnostics, Package Management Diagnostics, Logging,
Outputs, Tunnel, Decoder Display / Power Mgmt, and
Dimensioning. (See Chapter 3.)

Save To Camera Used to save a set of parameters to the camera connected
to Accu-Setup, enabling the camera to operate using these
parameters.

Save To Disk Used to save a set of parameters to disk as a backup copy
of the parameters that have been saved to camera.

Diagnostics and
Utilities

Provides access to a series of eight diagnostic and utilities
tabs including: System Status, SMIO Com, Decoder
Monitor, Trigger, Imaging, Logging, Package History, and
Outputs. (See Chapter 4.)

Exit Accu-Setup Used to exit the Accu-Setup program after releasing a
connection to a camera.

NOTE: Details on the various selections available from the Button Menu are
provided in Chapter 2. All Modify Setup functions are covered in Chapter 3.
The Diagnostics and Utilities functions are outlined in Chapter 4.
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DROP-DOWN MENUS

The Accu-Setup Main Window provides the following drop-down menus located
across the top of the screen.

Accu-Setup Drop-down Menu Selections

Drop-down Menus Description

File Offers a series of options including: Compare, Retrieve From
Camera, Retrieve From Disk, Save To Camera, Save To Disk,
and Exit. Most of these functions are also available from the
Button Menu.

Edit Provides the option to save or restore a backup of the
parameters by using either Create Backup File or Recover
From Backup File. The Modify Setup functions (also available
from the Button Menu) can also be accessed from the Edit
Menu.

Options Offers four options: Auto Backup, Auto Retrieve, Display
Values in US Format, and Display Values in Metric Format.

Utilities Offers eight utilities: Recover from Backup File, View Changes,
Diagnostics and Utilities, Modify Gain Table, Modify Focus
Table, Modify Camera Name and Serial Number,  Smart
Illumination Setup and Diagnostics, and Reboot Decoder. The
Diagnostics and Utilities are also available from the Button
Menu.

Help This menu provides access to Accu-Setup online help through
the Contents and Search functions. In addition, four functions
enable you to get additional information: About Accu-Setup,
About Camera, About Camera Head, and a Compatibility List.

Details on the various selections available from these drop-down menus are
provided in Chapter 5 of this manual.



1-18 CHAPTER 1: INTRODUCING ACCU-SETUP FOR ACCUVISION

Accu-Sort System, inc.

ACCU-SETUP: ONLINE HELP

In addition to the Accu-Setup for AccuVision Software Manual, you can also
use online help when you need more information on using the many features of
Accu-Setup.

Online help is accessed through the Help Drop-down Menu at the top of the
Accu-Setup Main Window or when using the Help button located on any of the
Accu-Setup window tabs. (For details, see Chapter 5.)

When selecting Contents from the Help Drop-down Menu, the Accu-Setup
Online Help Home screen is displayed.

Accu-Setup Online Help Home Screen

Online help is structured to make information easy to find. Explanations of all
Accu-Setup parameters are clearly defined. Through the use of the Contents and
Search functions, you will be able to easily navigate through the wealth of
information of the various features of Accu-Setup and your AccuVision System.
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ACCUVISION SETUP SOFTWARE OPTIONS

WHAT WE DO PRIOR TO SHIPMENT

When your AccuVision system is manufactured and tested here at Accu-Sort, we
use Accu-Setup to preset all of the system parameters to specifications provided
for your AccuVision application. Therefore, although the Accu-Setup for
AccuVision Software Manual provides details on the various parameters that can
be set-up or modified, the majority of these parameters should not be altered in
any way without first consulting an Accu-Sort customer service representative.

CAUTION: Be advised that arbitrary changes to your system parameters may
seriously affect system performance. Adhere to all cautions and warnings
regarding any parameter modifications made via the setup software, especially
those requiring the assistance of an Accu-Sort trained and authorized technician.
Training on the AccuVision hardware and software are available from Accu-Sort.

ACCU-SETUP FOR ACCUVISION

Accu-Setup for AccuVision is the Windows-based program used by Accu-Sort
to configure your system. It is the primary user interface to set up, monitor, and
diagnose the operation of your AccuVision System. Accu-Setup also enables you
to modify the operating parameters to accommodate any changes you may need
to make in the future. You may use Accu-Setup, which is resident on the
APC100 Decoder Module, via the optional monitor and keyboard or by loading it
onto a PC or host computer connected to the system.

NOTE: The Accu-Setup for AccuVision software provides an intuitive graphical
user interface that includes several key function buttons, a series of drop-down
menus, as well as the Modify Setup tabs and Diagnostic and Utilities tabs. The
program’s features are outlined in the document you are now reading.

ACCUVISION SMIO COMMANDS

The AccuVision SMIO Commands software may also be used to configure,
monitor, or diagnose the operation of your system. The SMIO Commands are
designed to work with a WYSE terminal or any PC with WYSE terminal
emulation software (e.g.: ProComm Plus). Unlike the user-friendly user interface
of Accu-Setup for AccuVision, the SMIO Commands use ASCII text
characters to enter the commands/data.

NOTE: The SMIO Commands provide a series of setup, diagnostics, and
troubleshooting commands that can be used by entering ASCII characters. For
details, reference the AccuVision SMIO Commands Manual.
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CHAPTER 2: BUTTON MENU

The Button Menu, located on the main window of Accu-Setup, provides you
with access to the various programmable parameters and diagnostic features of
your AccuVision camera system.

Button Menu Segment of Accu-Setup Main Window

NOTE: Several button menu functions are also available from the drop-down
menus provided across the top of the Accu-Setup Main Window.

1) Retrieve from Camera, Retrieve from Disk, Save to Camera, Save to
Disk, and Exit are also available from the File drop-down menu.

2) Modify Setup is also found in the Edit drop-down menu.
3) Diagnostics and Utilities can also be accessed from the Utilities drop-

down menu.
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ESTABLISH/RELEASE CONNECTION

The Establish/Release Connection  button is used to establish and release the
communications connection between Accu-Setup and your AccuVision camera.
Before attempting to establish a connection, be sure that all the necessary
hardware cable connections have been completed. (Details on these connections
can be found in the reference manuals supplied with your equipment.)

Accu-Setup communicates with the AccuVision camera over a network or locally
(decoder-to-camera via SMIO Talk and AVCore), depending on your
application. The Accu-Setup communications connection with a camera is made
using the Establish Connection button and the associated System Connection
screen.

Establishing or Releasing a Camera Connection

The Establish/Release button on the Accu-Setup Main Window is a toggle
button. If Accu-Setup is not connected to a camera, the button displays Establish
Connection.

Establish Connection Button

When connected to a camera, Release Connection is displayed.

Release Connection Button

If the Establish Connection button is displayed, click on it to establish a
connection to the camera. The System Connection window opens when a
connection between Accu-Setup and a camera is established.

System Connection Window
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From the System Connection window, select the required connections as
outlined in the table below.

Connection Description
Com 1-4 Enables serial connection between the decoder running Accu-Setup

and the camera’s SMIO port. Com1-4 are used in Image Only systems
and do not work with Accu-Setup prior to version 2.0x.

Local Indicates Accu-Setup is running on an Accu-Sort decoder
communicating directly with the camera. The connection is made
internally to SMIO Talk and AVCore.

Network Indicates the connection to camera is established using the TCP/IP
network. When using a network connection, it is necessary to enter a
network address in the IP Address field.

IP Address The network address of camera. Contact your network administrator for
additional information on the camera IP address.

Once the System Connection is selected, click the OK button to establish a
connection or Cancel to return to the Accu-Setup Main Window.

Once a connection is made, the toggle button displays Release Connection, the
appropriate connection messages appear in the Communications Log, and the
Camera Type information window of Accu-Setup’s Main Window displays
information in the SMIO, AVCore, and Decoder tabs.

Established/Released Connections and Communications Log

All established and released camera connection messages are displayed in the
Communication Log of Accu-Setup’s Main Window.

Example Communication Log of Accu-Setup Main Window

IMPORTANT: Remember to use the Release Connection button before
attempting to establishing a connection to another camera or exiting Accu-Setup.
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Alert Message: Could Not Connect Camera via Network

If you are attempting to connect to a camera via a network and a connection is
not made, an alert message is displayed.

Alert Message - Could Not Connect Camera via Network

You should check the following:

•  the camera is powered on,
•  a physical interconnection is made between camera and network, and
•  network address you are using is correct.

Alert Message: Could Not Connect Camera Locally

If you are attempting to connect to a camera locally and a connection is not
made, an alert message is displayed.

Alert Message - Could Not Connect Camera Locally

You should check the following:

•  the camera is powered on, and
•  a physical interconnection is made between camera and decoder.
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Alert Message: Lost Connection to Camera

If you lose an established connection with a camera, an alert message is
displayed.

Alert Message – Lost Connection to Camera

You should check the following:

•  the camera is powered on,
•  a physical interconnection is made between camera and decoder, and
•  release and re-establish the connection using the Establish/Release

Connection button.

IMPORTANT: If you have difficulty establishing a camera connection with Accu-
Setup, reference the troubleshooting section of the Operations Manual.
Remember that it is recommended to routinely use the Release Connection
button before attempting to establish a connection to another camera.
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RETRIEVE FROM CAMERA

Selecting the Retrieve from Camera function retrieves current parameters from
the camera with which Accu-Setup has established communications. (This
function also found in the File drop-down menu.)

Retrieve from Camera Button

IMPORTANT: The Retrieve from Camera option is only accessible if a
communication link has been established with the camera. The Communication
Log field shows the condition of the communication link.

To retrieve setup parameters from the camera:
Step 1: Click on the Retrieve from Camera button or select this function from
the File drop-down menu.

Step 2: Accu-Setup sends a message requesting the camera’s current settings.
While the parameters are being retrieved from the camera, the following
messages are displayed along with the percentage of the parameters retrieved:

Retrieve SMIO Parameters
Retrieve Decoder Parameters

Step 3: Once all parameters are retrieved from the camera, the Retrieve
Parameters window is opened and a message is displayed indicating Accu-Setup
has been automatically updated to match the camera settings.

Retrieve Parameters Window

It is recommended that both the original settings and any changes be stored to a
disk file in case you need to return the camera to a previous configuration. (See
Save to Disk on page 2-12.)
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RETRIEVE FROM DISK

Selecting the Retrieve from Disk function enables you to restore camera settings
from a disk file that contains a copy of previously stored camera parameters.
(This function is also found in the File drop-down menu.)

Retrieve from Disk Button

To retrieve setup parameters from disk:
Step 1: Selecting the Retrieve from Disk function opens a standard Windows
Open file window.

Open File Window

Step 2: Locate the Values folder where the parameters are stored. (The Open file
window should automatically default to the Values folder.)
Step 3: Click on the appropriate *.VAL file name.
Step 4: Click Open or press the <Alt><O> key.

Once parameters are retrieved, Accu-Setup is automatically updated to match the
retrieved settings. To update the camera with the file you have retrieved, use the Save to
Camera button. (See Save to Camera on page 2-11 for details.)

Parameters can be retrieved from disk only after they have been saved to disk. It is
recommended that any changes be stored to a disk file, in case you need to return a
camera to a previous configuration. (See Save to Disk for details.) The parameters are
stored in files with a *.VAL extension.

IMPORTANT TIP: It is good practice to store any *.VAL files in the Values folder
of the Accu-Setup directory so that they can be easily located.
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MODIFY SETUP

The Modify Setup button provides access to all the programmable operating
parameters of the AccuVision camera system via the Modify Setup Window.
(This function is also found in the Edit drop-down menu.)

Modify Setup Button

When Modify Setup is selected, the Symbologies tab is automatically displayed.

 Modify Setup Window – Symbologies Tab

The modifiable parameters are organized into groups identified by 12 tabs across
the top of the screen. Click on a tab to display the parameters that can be setup or
modified from within that tab. The Modify Setup tabs and a brief description of
each are provided in the following table.
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Modify Setup Tabs Tab Descriptions
Symbologies Provides all settable bar code parameters including: the types of bar

codes your system will decode, the sequence in which they are sent to
the host, the minimum/maximum length, symbology options, postal
symbology options, and advanced decoder options.

Communications Used to define all communications parameters with the camera,
decoder, and host including the baud rate, parity, data bits, stop bits,
and format of messages sent to the host. Also provides settings for
advanced network communications (i.e.: Decoder Network Adapter and
Network Identification).

Trigger Defines all settings for the light curtain and/or photoeyes used to trigger
package detection including distance to scan line, maximum package
length, minimum package height, debounce, and advanced light curtain
settings. (See the Diagnostic and Utilities / Trigger tab in Chapter 4.)

Tracking Contains all settable parameters for monitoring package travel through
the system including tracking mode (leading, trailing, or immediate),
distance to transmit point, belt speed settings, and camera mounting.

Imaging Defines scanning parameters for the camera including focus, gain, and
scan line clock mode. (See the Diagnostic and Utilities / Imaging tab
in Chapter 4.)

Decoder Diag Used to enable or disable diagnostics related to the decoder including
unrestricted and conditional decoder action. (See the Diagnostic and
Utilities / Decoder Monitor tab in Chapter 4.)

Pkg Mgmt Diag Used to enable or disable diagnostics related to the management of
packages as they are tracked through the system including unrestricted
and conditional tracking action. (See the Diagnostic and Utilities /
Decoder Monitor tab in Chapter 4.)

Logging Used to enable or disable diagnostics logs related to the camera,
decoder, and other system components and functions. (See the
Diagnostic and Utilities / Logging tab in Chapter 4.)

Outputs Defines the condition to activate, the active time (msec), and output
signal of up to four optional digital outputs that may be used to control
external devices (e.g.: alarms, package diverters, etc.). (See the
Diagnostic and Utilities / Outputs tab in Chapter 4.)

Tunnel Provides settings for applications where camera(s) are used to read bar
codes on multiple sides of packages. The Tunnel tab is used to enable
or disable multi-sided imaging mode, tunnel focus mode, and also
identifies the active tunnel configuration.

Decoder
Display/Power Mgmt

Used to enable or disable the remote display of the APC100 decoder
and to protect the decoder in the event of a power failure or system
shutdown.

Dimensioning Provides access to the various dimensioning parameters that must be
defined for the optional VisionCube dimensioning software. The
Dimensioning Tab is disabled unless the VisionCube software is used
by your system.

For detailed procedures on using the Modify Setup functions, reference Chapter
3 of this manual.
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SAVE TO CAMERA

Select the Save to Camera button on the Accu-Setup Main Window when you
need to:

•  send all Modify Setup parameters to the camera,
•  send only the changes you have made to the parameters, or to
•  send parameters to the camera that you have retrieved using the Retrieve

from Disk function.

(These functions are also found in the File drop-down menu.)

Save to Camera Button

To save setup parameters to the camera:
Step 1: When the Save to Camera function is selected, the Send Parameters
screen is displayed.

Send Parameters Window

Send Functions Description
Send Setup Parameters Sends all of the current settings and any changes to the camera,

unless Send Changes Only is enabled. Once saved to camera, the
settings will not be lost if the camera loses power.

Send Changes Only When a check appears in this box, only the parameters that have been
changed will be sent to the camera.

Close Use to close the Send Parameters screen.

NOTE: This option is only accessible if a communication link has been
established with the camera. The Communication Log in the Accu-Setup Main
Window shows the condition of the communication link.
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Step 2: Determine whether you wish to send all parameters or only the changes
to the camera. If you wish to send only changes, then be sure that the Send
Changes Only box is checked, otherwise leave the box empty to send all
parameters to the camera.

Step 3: Click on the Send Setup Parameters button. Once the parameters are
received successfully by the camera, the following message appears in the
Communication Log:

All Parameters were successfully sent.

Step 4: Click on the Close button to close the Send Parameters window.

NOTE: To close Send Parameters window without sending the parameters,
simply click on the Close button without using the Send Setup Parameters
button.

SAVE TO DISK

To specify a file name and location to store the current settings contained in
Accu-Setup, select the Save to Disk button from the Accu-Setup Main Window.
(This function is also found in the File drop-down menu.)

Save to Disk Button

To save setup parameters to disk:
Step 1: Selecting the Save to Disk function opens a standard Windows Save As
file window.

Save to Disk Window
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Step 2: Locate the Values folder where the parameters are stored. (The Save As
window should automatically default to the Values folder.)

Step 3: Enter a name for the file in the File name field. The .VAL extension will
be added to the name when you save the file to disk.

Step 4: Click Save or press the <Alt><S> keys. When this operation is
successfully completed, the following message appears in the Communications
Log:

Parameters saved to disk.

If you have not already done so, be sure to update the camera with the file you
have saved, using the Save to Camera button. (See Save to Camera on page 2-
11 for details.)

It is recommended that the previous settings and any changes be stored in
separate files, in case it becomes necessary to return the camera to a previous
configuration. The default file extension for these files, as well as the default
folder and directory, is *.VAL.

IMPORTANT TIP: Parameters can be retrieved from disk only after they have
been saved to disk. It is recommended that any changes be stored to a disk file in
case you need to return a camera to a previous configuration. It is also a good
practice to store any *.VAL files in a Values folder of the Accu-Setup directory so
that they can easily be located.
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DIAGNOSTICS AND UTILITIES

Clicking the Diagnostics and Utilities button on the Accu-Setup Main Window
opens a series of tabs used for monitoring system performance and diagnosing
various operating conditions. (This function is also found in the Utilities drop-
down menu.)

Diagnostics and Utilities Button

The Diagnostics and Utilities are particularly useful for monitoring how changes
made using Modify Setup affect overall system performance.

When Diagnostics and Utilities is selected, the System Status tab is
automatically displayed.

Diagnostics and Utilities Window – System Status Tab

The diagnostics and utilities are organized into eight groups identified by tabs
across the top of the screen. Click on a tab to display the functions available from
within that tab.

The Diagnostic and Utilities tabs and a brief description of each are provided in
the following table.
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Diagnostic Tabs Tab Descriptions
System Status Useful for checking performance of decoder, camera, and other system

components. Enables user to monitor belt speed, tach, package count,
error count, late decodes, and illumination.

SMIO Com Used to send test messages to check if all system communications are
functioning properly as well as provides a running count of various
messages (Rx, Tx, framing, Rx overflow, Tx overflow) by
communications port (host, com, and illum).

Decoder Monitor Used to monitor the decoder and package tracking conditions that have
been enabled using the Modify Setup / Decoder Diag and Pkg Mgt
Diag tabs. Any enabled conditional or unrestricted action messages are
displayed in the Rolling Text window. Any enabled conditional or
unrestricted action images are displayed in the Image Edit window.

Trigger Monitors the operation of all devices used to trigger package detection
including light curtain, photoeye, and tach encoder and counts various
errors (package too long, too short, too close). (See the Modify Setup /
Trigger tab in Chapter 3.)

Imaging Provides AVScope and manual control for testing the camera scanning
parameters including focus, gain, and scan line frequency. Also includes
error counts for focus faults, clipped focus, clipped gain, and clipped
scan line clock. (See the Modify Setup / Imaging tab.)

Logging Used to view diagnostics logs related to the camera, decoder, and other
system components and functions. (See the Modify Setup / Logging
tab in Chapter 3.)

Package History Used to view a detailed history of the last 16 packages that have been
tracked through the system.

Outputs Defines the condition to activate, the active time (msec), and output
signal of up to four optional digital outputs that may be used to control
external devices (e.g.: alarms, package diverters, etc.). (See the Modify
Setup / Outputs tab in Chapter 3.)

WARNING: A number of the diagnostic and utilities features (especially the log
files) will adversely affect system performance. These functions are intended for
diagnostic purposes only and should be disabled during normal system operation.

For detailed procedures on using the Diagnostics and Utilities functions,
reference Chapter 4 of this manual.
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EXIT ACCU-SETUP

IMPORTANT TIP: It is recommended that you release the connection to camera
(by using the Release Connection button) before using the Exit Accu-Setup
function.

Click on the Exit Accu-Setup button to leave the program. (This function is also
found in the File drop-down menu.)

Exit Accu-Setup Button

If any changes made during the use of Accu-Setup were not saved, the following
alert message appears.

Alert Message – Changes Have Not Been Saved

Click Yes or press the <Alt><Y> keys to leave without saving changes.
Click No or press the <Alt><N> keys to remain in Accu-Setup. You will still be
able to save changes before exiting Accu-Setup if you click No.

USEFUL TIP: Before you exit Accu-Setup, did you remember to:
1. Save any necessary changes to camera
2. Save a backup file of changes to disk
3. Release the connection to the camera
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CHAPTER 3: MODIFY SETUP

The Modify Setup window provides access to all of the adjustable operating
parameters of your AccuVision camera system through the Accu-Setup software
interface. These parameters are organized into functional groupings identified by
12 tabs across the top of the screen.

Modify Setup Tab Selections

To access this screen, click the Modify Setup button on the Accu-Setup Main
Window button menu.

Modify Setup Button

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

NOTE: The Modify Setup tabs may also be selected from the Edit drop-down
menu located at the top of the Accu-Setup Main Window. Note that when Modify
Setup is selected, the Symbologies tab is automatically displayed.

In most cases, your AccuVision system has already been configured to your
application’s specifications prior to shipment to your facilities. However, you
may find it necessary to use the Modify Setup features to update or change
specific parameters to correct or improve overall system performance.

The Symbologies tab and Communications tab are two of the more commonly
used features of Accu-Setup because they provide access to the bar code
symbology and communication parameters used by your system.

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

NOTE ON DIMENSIONAL REFERENCES: While this manual discusses all
dimensional values in US format, Accu-Setup can display these values in either
US or metric formats. To set this format, reference the Options drop-down menu
in Chapter 5. A table that shows the settable parameters in both their US and
metric values is also provided in Chapter 6 / Appendix B.
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VIEWING PARAMETERS OR MAKING CHANGES

To access any tab and modify the parameters of the tab:

Step 1: Click on one of the tabs to view the parameters that can be set.

Step 2: Follow the procedures provided in this section of the manual for
modifying the setup of any tab.

Step 3: When finished on any tab, to move to another tab without temporarily
saving any changes, simply click another tab to view or
change other parameters.

Step 4: To temporarily save changes made on any tab, click the OK button
located on the bottom right of the tab’s screen to return to the Accu-Setup Main
Window.

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

IMPORTANT: It is possible to make changes from within any tab, however, those
changes will only be enabled temporarily in Accu-Setup if you click OK. Click
Cancel to clear changes you have made. OK or Cancel also returns you to the
Accu-Setup Main Window. (Use Save To Camera and Save To Disk to use and
store a copy of any modified setup.)

Step 5: To leave any Modify Setup tab without making changes to the previously
set values, click the Cancel button to return to the Accu-Setup Main Window.

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

USEFUL TIP: The Accu-Setup tab screens provide a Help button at the bottom
right-hand of each screen. By clicking the Help button, you can access topics
related to that screen in Accu-Setup: AccuVision Module Help. (If there is no
information for that specific screen, an error message is displayed.) The online
help Contents and Search features can also be accessed from the Help drop-
down menu. (See Chapter 5 for details.)
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SYMBOLOGIES TAB

The Symbologies tab contains all adjustable parameters that define the type and
size of bar code(s) that the camera reads. When the user clicks on the tab, the
window displayed is divided into two areas: Symbologies to Read and Postal
Symbology Options. There is also a button for Advanced Decoder Options.

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

NOTE: The messages sent to the host are built in the same order that the Active
Symbology List is created. In the example Symbologies Tab Window, the host
message order would be Code 128, Interleaved 2 of 5, then Maxicode.

Modify Setup – Symbologies Tab

SYMBOLOGIES TO READ

This segment of the Symbologies tab provides a Symbology drop-down menu of
all bar code types that can be read by your AccuVision camera. It also enables
you to set the minimum and maximum length of each symbology. In addition,
you may also set specific symbology options.

All symbologies that your system is already setup to read (i.e.: factory preset by
Accu-Sort) are listed in the Active Symbologies List located to the right of the
Symbology drop-down menu.
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Symbology Drop-down Menu

The AccuVision System has the ability to decode many bar code symbologies.
The bar code types that can be decoded by your system are listed in the
Symbology drop-down menu. Before your system can scan and decode a
symbology, that bar code symbology and its related minimum and maximum
lengths and options must be added to the Active Symbologies List.

Symbology Drop-down Menu & Active Symbologies List (***updated***)

Active Symbologies List

In the Symbologies to Read segment of the Symbology Tab, the Active
Symbologies List identifies all bar code types and their associated min/max
lengths and options that your system has been setup to search for and decode.

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

IMPORTANT: Before adding a symbology to this list, remember that the
messages your AccuVision system sends to the host are built in the same order
that the Active Symbologies List is created. In the example Symbologies Tab
Window, the host message order would be Code 128, Interleaved 2 of 5, then
Maxicode. If you wanted Maxicode sent first, Code 128 sent second, and
Interleaved 2 of 5 sent third, you would need to remove all three symbologies from
the active list and re-enter them in the correct order.

Adding A Symbology

To view the bar code list and add a symbology to the Active Symbologies List:

Step 1: Click the down arrow to the right of the symbology displayed. The
Symbology drop-down menu is displayed.

Step 2: Scroll up and down the Symbology drop-down menu until the required
code type is highlighted, then release the mouse button to select the highlighted
code.

Step 3: The Min Length, Max Length, and Options fields appear in place of the
list of symbologies. Set all parameters associated with the code (e.g.: minimum
length, maximum length, and options).

Step 4: Click Add. The newly added code will appear in the Active Symbologies
List field along with the minimum length, maximum length, and options.
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If two or more variations of the same code are to be read by the system, repeat
the process, making the necessary entries that will enable the system to
differentiate between the code variations.

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

REMEMBER: Build your Active Symbologies List of bar codes in the order in
which you want them decoded and sent in your host messages.

Removing A Symbology

To remove a code from the Active Symbologies List:

Step 1: Click on the code to be removed from the Active Symbologies List on
the right-hand of the screen.

Step 2: Click Remove. The highlighted code will no longer appear on the active
symbologies list.

Min Length/Max Length Fields

Once a symbology is selected from the drop-down menu, the min/max lengths
must be set.

Min/Max Length Field

Min Length is the minimum length of a bar code that the camera will read. The
length is measured in the number of man-readable characters within the bar code.
For example an 11-character Code 128 symbology is in the active list shown
above.

Max Length is the maximum length of a bar code that the camera will read. The
length is measured in the number of man-readable characters within the bar code.
For example the same Code 128 symbology in the active list shown above has
been set for a max length of 18-characters.



ACCU-SETUP FOR ACCUVISION SOFTWARE MANUAL   VERSION 4.0 3-7

Solutions with vision.

To enter the Min or Max Length:
Step 1: Place the cursor in either the Min or Max Length box and click.
Step 2: Type in the required minimum or maximum length of the code.

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

NOTE: To read any bar code within a given symbology, set the Min Length as
one (1) and the Max Length as 100. To read a specific code length, set the Min
Length and Max Length for the same number of characters (e.g.: the Interleaved
2 of 5 code in our screen example for the Symbologies Tab is set for both a
minimum and maximum length of 32). You cannot set a maximum length that is
less than a minimum length.

Options

Options vary with the bar code types selected. The options menu will be different
depending on which code name is displayed in the Symbology field. For more
information about available options per code type, see the Bar Code Options
List.

Example Options Drop-down Menu (for Code 39)

To view the options drop-down menu and choose an option:

Step 1: Click the down arrow to the right of the option displayed.

Step 2: Scroll up and down the list until the required option is highlighted.

Step 3: Release the mouse button to select the highlighted option.
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The Bar Code Options table lists the options associated with each of the
symbologies that can be read by your AccuVision System.

Aztec Normal
Reverse
Normal and Reverse

Codabar No options

Code 128 No options

Code 39 None
Mod 43

Code 93 No options

Data Matrix Normal
Reverse
Normal and Reverse

Interleaved 2 of 5 None
Mod 10

Maxicode Mode 0
Mode 1
Mode 2
Mode 3
Mode 4
Mode 5
Mode 6
Any Mode

PDF 417 No options

POSTNET/PLANET USA POSTNET
USA POSTNET Extension
Japan POSTNET
Australian POSTNET
USA PLANET

QR Code Normal
Reverse
Normal and Reverse

RSS Any Mode
Regular & Truncated
Limited
Expanded

UPC/EAN UPC A - 0 char ext
UPC A - 2 char ext
UPC A - 5 char ext
UPC E0 - 0 char ext
UPC E0 - 2 char ext
UPC E0 - 5 char ext
UPC E1 - 0 char ext
UPC E1 - 2 char ext
UPC E1 - 5 char ext
EAN/JAN8 - 0 char ext
EAN/JAN8 - 2 char ext
EAN/JAN8 - 5 char ext
EAN/JAN13 - 0 char ext
EAN/JAN13 - 2 char ext
EAN/JAN13 - 5 char ext

Bar Code Options List
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POSTAL SYMBOLOGY OPTIONS

Postal symbology options are available for POSTNET and PLANET codes that
are selected in the symbology field.

Postal Symbology Options

Symbol Orientation

Symbol orientation describes the presentation of the postal code to the camera.
There are four options for presenting a code to the camera: horizontal, vertical,
horizontal and vertical, and omnidirectional.

Example of Different Orientations

To view the Symbol Orientation list and choose an orientation:
Step 1: Click the down arrow to the right of the orientation displayed.

Symbol Orientation Field

Step 2: Scroll up and down the list until the required orientation is highlighted.
Step 3: Release the mouse button to select the highlighted orientation.

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

NOTE: Omnidirectional orientation requires more system resources and
processing time. Use this orientation only in applications where it is necessary to
do so.
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Minimum Bar Count

Minimum bar count is the minimum number of bars that the postal code presents
to the camera. Preset minimum bar count values are programmed into Accu-
Setup and are selectable from the Minimum Bar Count drop-down menu.

Minimum Bar Count Field

To view and select a Minimum Bar Count:
Step 1: Click the down arrow to the right of the minimum bar count displayed.
Step 2: Scroll up and down the list until the required minimum bar count is
highlighted.
Step 3: Release the mouse button to select the highlighted count.

Maximum Bar Count

Maximum bar count is the maximum number of bars that the bar code presents to
the camera. Preset maximum bar count values are programmed into Accu-Setup
and are selectable from the Maximum Bar Count drop-down menu.

Maximum Bar Count Field

To view and select a Maximum Bar Count:
Step 1: Click the down arrow to the right of the maximum bar count displayed.
Step 2: Scroll up and down the list until the required maximum bar count is
highlighted.
Step 3: Release the mouse button to select the highlighted count.
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POSTNET Merge X Tolerance

POSTNET symbologies often contain only the single five-digit zip code, to
which the Postal Service may add a four-digit extension code (there may be
added an additional two-digit delivery point code, also). The result of this
additional code is a nine-digit symbology (or eleven-digit symbology if the
delivery point code is added) created from two separate bar codes.

The value for the POSTNET Merge X Tolerance specifies the maximum
distance between the nearest edges of two POSTNET symbologies as they are
aligned along the X-axis (horizontal, parallel to envelope length) orientation on a
package.

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

NOTE: If the symbologies are within the range as specified in both the POSTNET
Merge X and Y Tolerance fields, the two symbologies are merged and read as a
single symbology.

POSTNET Merge Y Tolerance

Similar to the POSTNET Merge X Tolerance, the value for the POSTNET
Merge Y Tolerance specifies the maximum distance between the nearest edges
of two POSTNET symbologies as they are aligned along the Y-axis (vertical,
perpendicular to envelope length) orientation on a package.

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

NOTE: If the symbologies are within the range as specified in both the POSTNET
Merge X and Y Tolerance fields, the two symbologies are merged and read as a
single symbology.
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ADVANCED DECODER OPTIONS

To use the Advance Decoder Options, click on the button on the Symbologies
tab window. This displays a separate window of advanced decoder options for
the camera. These options are: Image Processing Mode, Active Image Width,
Active Image Start Pixel, Maximum 1-D Code Length, Minimum 1-D Code
Height, and Low Aspect Code Location.

Advanced Decoder Options Window

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

NOTE: Properly setting these options will speed up bar code data processing by
reducing decoder processing requirements. These options are particularly critical
to high-speed conveyor applications.

Image Processing Mode

This drop-down menu offers two options: Normal and Mirrored. When Normal
is selected, the first pixel starts from the left side of the image. When Mirrored is
used, the first pixel starts at the far right of the image and the last pixel is at the
left of the image, in effect creating a mirrored or reversed image. Mirror image
results from the camera mounting sensor clocking from left to right. The proper
mode must be set for 2-D codes.

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

NOTE: Using this option does not affect how the video image is displayed, but
only how the Decoder processes the image. The Image Processing Mode
selected should match how the image is processed. To determine how the image
is processed, view the display of a scanned package in the Diagnostics and
Utilities / Decoder Monitor Tab. (See Chapter 4.)
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Active Image Width (pixels)

Sets the anticipated active image width by defining the remaining active pixels in
an array based on the active image start pixel setting. (See Active Image Start
Pixel.) Active Image Width is used, along with the Active Image Start Pixel, to
define the narrowest possible active image width by reducing the overall area the
camera will scan for valid bar codes. For example, in applications where bar
codes always appear in one location on a package, the entire package does not
need to be scanned, so the active image width can be set smaller, thus reducing
decoding time and demand on processing resources. In high-speed tilt-tray
applications where smaller packages are to be scanned (e.g.: cassettes and CDs),
effectively narrowing the active image width to be scanned will speed system
performance.

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

NOTE: When the Active Image Width and Active Image Start Pixel are both set
to zero (0), the decoder will default to using the entire scan line.

Active Image Start Pixel

Defines the start pixel on the array from which the decoder begins to collect and
process data received from the camera. Active Image Start Pixel is used, along
with Active Image Width, to define the narrowest possible active image width by
reducing the overall area the camera will scan for valid bar codes. (See Active
Image Width.)

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

NOTE: When the Active Image Width and Active Image Start Pixel are both set
to zero (0), the decoder will default to using the entire scan line.

Maximum 1-D Code Length (in.)

This is used together with Minimum 1-D Code Height to reduce the demand on
processing time by defining tighter decoding parameters.

CAUTION: While entering a value in this field may reduce decoder processing
time, if the value is set too low, this will also adversely affect performance. Unless
your camera was preset with a maximum code length, do not enter a value in this
field unless instructed to do so by an Accu-Sort trained and authorized technician.

Click on this field and enter the required maximum code length dimension. The
example screen shows that 7.9 inches was entered as the maximum code length.
(Enter fractions of an inch in decimal.) When a value other than zero is entered in
this field, the system will search for bar codes that fall within the maximum code
length.
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Minimum 1-D Code Height (in.)

This is used together with Maximum 1-D Code Length to reduce the demand on
processing time by defining tighter decoding parameters. Click on this field and
enter the required minimum code height dimension. The example screen shows
that 1.0 inch was entered as the minimum code height. (Enter fractions of an inch
in decimal.) When a value other than zero is entered in this field, the system will
search for bar codes that fall within the minimum code height.

CAUTION: To avoid adversely affecting system performance, do not set the
minimum code height below 0.5 inches (1.3 centimeters), unless instructed to
do so by an Accu-Sort trained and authorized technician.

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

NOTE: If the Maximum Code Length and Minimum Code Height settings are
being used by your system, keep in mind that all codes in the active symbology
list (as defined in Modify Setup / Symbologies tab) will still be processed, even if
they fall outside the maximum length or minimum height limits.

Low Aspect Code Location

This function should only be enabled when all bar codes to be decoded by the
system will have a low aspect ratio (e.g.: if code height is under 0.5 inches).
When enabled, this function reduces decoder processing requirements.

CAUTION: When enabled, Low Aspect Code Location may adversely
affecting system performance. Do not enable this function unless instructed to
do so by an Accu-Sort trained and authorized technician.
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COMMUNICATIONS TAB

The Communications Tab lets you set all AccuVision System communications
port parameters and message formats for the following:

• camera (SMIO Ports – Illum, Host, and Com),
• decoder (Com Port Settings and Decoder Ports), and
• host computer or peripheral (Host Port Settings and Host Message).

Modify Setup – Communication Tab

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

NOTE: You can Send Test Messages to the camera’s SMIO ports (Host, Com, or
Illum) using the Diagnostics and Utilities / SMIO Com Tab as outlined in
Chapter 4.
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SMIO PORTS

The SMIO Ports segment of the Communication tab contains three areas for
port settings: Illum, Host, and Com. Each of these areas display the current
communication settings for that port. The settings are shown in the following
order: baud rate, number of data bits, parity setting, and stop bits. Each port can
be set independently based on the device connected to it.

SMIO Ports Window Segment

Illum Port Setting

Defines the parameters used to communicate with the illumination module
connected to the camera’s ILLUM port. This is not applicable to cameras that
use self-contained illumination. To modify the port settings, follow the Changing
SMIO Ports Settings procedure outlined on page 3-17.

Host Port Setting

Defines the parameters used to communicate with the host computer or
peripheral connected to the camera’s HOST port. To modify the port settings,
follow the Changing SMIO Ports Settings procedure outlined on page 3-17.

Enable 422

When this box is checked, the RS422 communications format is used for
communications with the host computer or peripheral.

Com Port Setting

Defines the parameters used to communicate with the decoder connected to the
camera’s COM port. (See also Decoder Ports / Com 1 on page 3-19.) To modify
the port settings, follow the Changing SMIO Ports Settings procedure outlined
on page 3-17.

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

NOTE: In systems using an Accu-Sort Decoder, the Communications tab
settings must be the same for the SMIO Ports / Com Port and the Decoder
Ports / Com 1. The Enable Com 1 box should also have a check in it. If these
settings are different, the system will not work properly.

Com Initialization String

The Com Initialization String is used with the Com Port Settings only.
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Changing SMIO Ports Settings

To change the communication setting for any of the ports (e.g.: Illum, Host, and
Com Port Settings):

Step 1: Locate the title of the port to change (e.g.: Host Port Settings).

Step 2: Click the arrow to the right of the current settings.

Step 3: When you click the arrow, a Port Settings window appears. This
window contains the settings for each communication parameter. Upon opening,
all values displayed in these fields are the current camera settings.

Port Settings Window

Step 4: Click the down arrow to the right of each current setting to display the
choices available.

Step 5: Change the settings for any or all of the options as necessary. The options
for any port’s communication settings are as follows:

Settings Available Options
Baud Rate 1200, 2400, 4800, 9600, 19200, 38400, 57600, 115200
Stop Bits 1 or 2
Parity None, Even, Odd
Data Bits 7 or 8

Step 6: Click OK to enable the new settings or Cancel to return to the previous
settings.

HOST MESSAGE

This segment of the Communications tab is used to define the format for all
messages that will be transmitted to the host for each package scanned by the
AccuVision System.

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

NOTE: Before setting or changing the host message parameters, be sure to
consult with your system administrator to assure that the messages sent to the
host will comply with all system requirements.
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Host Message Window Segment

The messages you send to the host may include the following:

Host Message Elements Description
Header Identifies the beginning of the message (e.g.: <STX>). The

header may include up to 10 characters.
Trailer Identifies the end of the message (e.g.: <ETX>). The trailer may

include up to 10 characters.
No Read Message Indicate a package was present but either did not contain a bar

code or was not properly decoded, thus resulting in a no read
condition.

NOTE: If you enter a tilde (~) and a single character, the
character will be repeated to fill the entire field in the host
message; otherwise, the literal character entered will be used.

Multiple Message Indicates when more than one of the same type of symbology
was read, but the system does not know which one to decode.

NOTE: If you enter a tilde (~) and a single character, the
character will be repeated to fill the entire field in the host
message; otherwise, the literal character entered will be used.

Delimiter Between Codes The separator used between multiple bar codes decoded and
transmitted in the same message. The delimiter between codes
may include up to 10 characters.

Data Verification There are three selections in this drop-down menu: None, BCC
(Block Check Character), CRC (cyclic redundancy check).

Add Sequence Number A sequence number is added to all messages sent to the host
when the box is checked. If this function is not checked, no
sequence number is included in host messages. When enabled,
the sequence numbering starts at one. If this function is disabled
then enabled again later, the sequence numbering will begin
again starting with the next number in the sequence since the
function was previously disabled. Sequence numbering continues
until the camera is shutdown. When restarted, numbering starts
at one.

Unprintable Characters Unprintable characters may also be entered in the Header,
Trailer, No Read Message, Multiple Message, and Delimiter
Between Codes fields. To enter unprintable characters, use one
of the following methods:
1) Enclose ASCII descriptors in left and right brackets (e.g.:  

enter <SOH> for the Start of Header character).
2) Type in the literal characters (e.g.: type Ctrl + A to enter  

the Start of Header character).
3) Enclose the hexidecimal value of the character in left and  

right brackets (e.g.: <0x01> for the Start of Header
character).

                 NOTE: The elements within the host message are constructed using ASCII characters.
                 See Appendix C: ASCII Character Chart in Chapter 6 of this manual.
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DECODER PORTS

This segment of the Communications tab is used to set the communications
parameters for your Accu-Sort decoder.

IMPORTANT: In systems using a decoder, the Decoder Ports / Com 1 settings
must match the SMIO Ports / Com Port settings and Enable Com 1 should be
enabled in order for the system to operate properly. These settings are factory-
configured, so there should be no need to change it unless instructed to do so by
an Accu-Sort trained and authorized technician.

Decoder Ports Window Segment

To set the parameters for the communications ports:
Step 1: Locate the title of the port to change (either Com 1 or Com 2).
Step 2: Click the arrow to the right of the current settings.
Step 3: When you click the arrow, a Port Settings window appears. This
window contains the settings for each communication parameter.

Port Settings Window

Step 4: Use the down arrow to the right of each current setting to display the
choices available. The options are as follows:

Settings Available Options
Baud Rate 1200, 2400, 4800, 9600, 19200, 38400, 57600, 115200
Stop Bits 1 or 2
Parity None, Even, Odd
Data Bits 7 or 8

Step 5: Change the settings for any or all of the options.
Step 6: Click OK to enable new settings or Cancel to return to previous settings.
Step 7: To use the communications ports, make sure that the enable check boxes
are checked.
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ADVANCED COMMUNICATIONS

If the AccuVision System needs to communicate with a network, use the
Advanced Communications to set your network parameters. Click the
Advanced>> button on the Communication tab window to display the
Advanced Communications window.

Advanced Communications Window

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

NOTE: The following options apply only when connecting the decoder to a
network. Consult your network administrator / MIS for details on how to set these
parameters to meet your network’s requirements.

Selections Network Options Description
IP Address An IP address specifies a unique host ID for the

Decoder on a particular TCP/IP network. Consult your
network administrator for a valid IP address for the
camera.

Gateway A gateway allows the Decoder to reach other systems
not on the local network and remote systems to reach
the camera. If the camera requires external connectivity,
consult your network administrator for a valid gateway
address for the camera.

Decoder Network
Adapter

Net Mask A netmask modifies a standard IP address into subnets.
Consult your network administrator to see if the network
requires a net mask and, if needed, the value of the net
mask. A default class C net mask should be valid in
most cases (either 255.255.255.0 or 255.255.240.0).

Computer Name Use this field to name the Decoder for the camera
currently connected to Accu-Setup.

Network
Identification

Workgroup Use this field to identify the group or area where the
Decoder is located.

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

NOTE: You may need to shutdown and restart the Decoder (Windows operating
system) to assure that any changes to the Advanced Communications take effect.
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TRIGGER TAB

The Trigger tab contains all of the parameters needed to set up the trigger device
for the AccuVision System. The device used as a trigger provides a signal to the
system indicating that it should begin scanning.

Modify Setup – Trigger Tab

TRIGGER MODE

The trigger mode setting determines what device triggers the camera to read a bar
code. There are four Trigger Modes available from the drop-down menu:
Photoeye, Light Curtain, Light Curtain and Photoeye, and Serial.

Trigger Mode Drop-down Menu

To select a trigger mode:
Step 1: Use the down arrow to the right of the current trigger mode.
Step 2: Scroll up and down the list until the required trigger mode is highlighted.
Step 3: Release the mouse button to select the highlighted trigger mode.
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Photoeye Trigger Mode

This mode should be selected for detecting package presence when it is not
necessary to adjust the camera focus. A photoeye (connected to the TRIG port of
the camera) is used as the trigger. When this mode is selected, the Photoeye
Settings segment of the Modify Setup / Trigger Tab must also be set. (See page
3-23.)

Light Curtain Trigger Mode

This mode should be selected for detecting package presence when it is also
necessary to adjust the camera focus over a larger depth of field. When this is
true, a light curtain (connected to the FOCUS port of the camera) is used as the
trigger. When this mode is selected, the Light Curtain Settings segment of the
Modify Setup / Trigger Tab must also be set. (See page 3-23.)

Light Curtain and Photoeye

When this trigger mode is selected, the photoeye (connected to the camera’s
TRIG port) is used to detect the presence of packages within the scanning area.
Simultaneously, the light curtain (connected to the camera’s FOCUS port)
provides package height information so the camera can correctly adjust its
focusing mechanism to variations in product height.

Serial Trigger Mode

(***Addition to options. Use of this mode to be defined.***)

MAXIMUM PACKAGE LENGTH (IN.)

Sets the maximum package length that the system will process without indicating
an error.

To set the maximum package length:
Use the slider bar or the arrows to set the value from 4.0 to 60.0 inches.

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

NOTE: Use the Package Errors / Too Long Counter located on the
Diagnostics and Utilities / Trigger Tab to check for errors in maximum package
length. (See Chapter 4.)

DEBOUNCE

Determines the distance the trigger signal must be active to be considered a valid
trigger cycle.

To set the debounce:
Use the slider bar or the arrows to set the value from 0.0 to 2.0 inches.
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PHOTOEYE SETTINGS

This section of the Trigger tab sets the photoeye parameters.

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

NOTE: If you choose Photoeye as the Trigger Mode, the options for light curtain
settings are not available.

Active Low

Photoeyes are either active when the signal is low or active when the signal is
high. This setting determines when the photoeyes are active (i.e.: “low” if the
check box is selected, “high” if not selected).

Distance to Scan Line

Defines the distance from the photoeye to the scan line of the camera. (Reference
the AccuVision Scanning Area Diagram in Chapter 1. On this illustration,
trigger device identifies the location of the light curtain.)

To set the Distance to Scan Line:
Use the slider bar or the arrows to set the value from 0.0 to 200.0 inches.

LIGHT CURTAIN SETTINGS

This section of the Trigger tab sets the light curtain parameters.

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

NOTE: If you choose Light Curtain as the Trigger Mode, the options for photoeye
settings are not available.

Light Curtain Offset

Defines the distance from the light curtain to the top of the conveyor belt.

To set the light curtain offset:
Use the slider bar or the arrows to set the value from –5.00 to 5.00.

A negative light curtain offset is used when the curtain is mounted below the
belt. A positive light curtain offset is when the curtain is mounted above the belt.
This distance is added to the package height reported from the light curtain to
calculate the actual package height.

Minimum Package Height

Defines the shortest package the system will detect. The camera will not scan
packages that are less than the minimum package height defined by this setting.

To set the minimum package height:
Use the slider bar or the arrows to set the value from 0.50 to 36.0.
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Distance to Scan Line

Defines the distance from the light curtain to the scan line of the camera.
(Reference the AccuVision Scanning Area Diagram in Chapter 1. On this
illustration, trigger device identifies the location of the light curtain.)

To set the Distance to Scan Line:
Use the slider bar or the arrows to set the value from 1.0 to 200.0.

Advanced Button

The advanced light curtain settings are for adjusting the light curtain resolution
and focus port settings. (See Advanced Light Curtain Settings for details.)

ADVANCED LIGHT CURTAIN SETTINGS

Use this screen to set the light curtain resolution and focus port settings.

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

IMPORTANT: There is no reason to modify these settings unless instructed to do
so by an Accu-Sort trained and authorized technician.

To set advanced light curtain settings:
Click the Advanced>> button in the light curtain settings area of the Trigger tab.
The Advanced Light Curtain Settings screen is displayed.

Advanced Light Curtain Settings

Light Curtain Resolution

Click in the field and enter the distance between the detection LEDs on the light
curtain (in increments of 0.25 inch).
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Focus Port Settings

To set the communications parameters for the focus port:
Step 1: Click the arrow to the right of the current settings.
Step 2: When you click the arrow, a Port Settings window appears. This
window contains the settings for each communication parameter.

Port Settings Window

Step 3: Use the down arrow to the right of each current setting to display the
choices available. The options are as follows:

Settings Available Options
Baud Rate 1200, 2400, 4800, 9600, 19200, 38400, 57600, 115200
Stop Bits 1 or 2
Parity None, Even, Odd
Data Bits 7 or 8

Step 4: Change the settings for any or all of the options.
Step 5: Click OK to enable the new settings or Cancel to return to the previous
settings.

EXTEND EDGE

In high-speed applications or in applications where the codes are close to the
front or back of the boxes, extending the leading or trailing edge of box allows
for more time to focus the camera and capture the image. For example:
Extending the leading or trailing edge may be used in tray systems where the
duration of the trigger signal must be different from the actual physical length of
the tray to accommodate packages that are physically larger than the trays.

Leading Edge (in.)

 To set the leading edge:
Use the slider bar or the arrows to set the value from -30.0 to 30.0.

Trailing Edge (in.)

To set the trailing edge:
Use the slider bar or the arrows to set the value from -30.0 to 30.0.
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TRACKING TAB

The Tracking Tab contains all of the parameters associated with monitoring
package travel on the conveyor.

Modify Setup – Tracking Tab
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TRACKING MODE

There are four tracking modes: none, leading, trailing, and immediate. For
camera systems, use either leading or trailing tracking.

Tracking Mode Window Segment

To select a tracking mode:
Step 1: Click the arrow to the right of the current tracking mode.
Step 2: Scroll up and down the list until the required tracking mode is
highlighted.
Step 3: Release the mouse button to select the highlighted tracking mode.

Tracking Mode – None

When this mode is selected, no tracking mode is enabled.

Leading Tracking Mode

When this mode is used, package tracking is timed through the scanning area
based on when the front edge (leading edge) of a package is detected.

Trailing Tracking Mode

When this mode is used, package tracking is timed through the scanning area
based on when the back edge (trailing edge) of a package is detected.

Immediate Tracking Mode

When this mode is selected, tracking is immediate.

Distance to Transmit Point

This function defines the distance from the trigger device (photoeye or light
curtain) to the message transmit point determined by the tracking mode (i.e.:
none, leading, trailing, or immediate). This feature maximizes available
processing time by defining the best time to transmit tracking data.

To select a distance to transmit point:
Use the slider bar or arrows to select a value between 1.0 and 200 inches.
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BELT SPEED SETTINGS

Belt Speed Source

There are two possible belt speed sources: It can either be internally generated or
provided by an external device (e.g.: a tachometer).

The internal source gauges belt speed by the distance of belt travel per specific
unit of time and therefore requires a very consistent/constant speed.

The external source gauges belt speed by counting the number of tach pulses
(usually from a tachometer) per specific distance of belt travel.

To change the belt speed source:
Step 1: Click the arrow to the right of the current Belt Speed Source.
Step 2: Highlight the source (either Internal or External).
Step 3: Release the mouse button to select the highlighted source.

If Internal is selected, see Auto Generated Belt Speed.
If External is selected, see External Encoder Resolution.

Auto Generated Belt Speed

This option is active only when the belt speed source is internal.

To set the auto generated belt speed:
Step 1: Make sure that the belt speed source is set to internal.
Step 2: Use the slider bar or the arrows to set the value from zero to 600 FPM.

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

NOTE: You must use the slider bar or arrows to set the Auto Generated Belt
Speed. You cannot type a value into this field. The slider bar/arrows are disabled
when an external tach encoder is being used. See External Encoder Resolution.

External Encoder Resolution

This option is active only when the belt speed source is external.

To set the External Encoder Resolution:
Step 1: Make sure that the belt speed source is set to external.
Step 2: Use the slider bar or arrows to set the value from 1.0 to 200.0 PPI (tach
pulses per inch).

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

NOTE: You must use the slider bar/arrows to set External Encoder Resolution.
You cannot type a value into this field. The slider bar/arrows are disabled when
the internal belt speed setting is used. (See Auto Generated Belt Speed.)
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CAMERA MOUNTING

Relative Camera Angle (deg.)

Defines the relative camera angle (in degrees) as it relates to the package
transport system (e.g.: conveyor belt, tilt-tray, etc.) and the direction of package
travel. When a positive angle is used, the scan line is downstream from the
camera lens facing in the direction of package travel. When a negative angle is
used, the scan line is upstream from the camera lens facing the opposite direction
of package travel. (See Relative Camera Angle Illustrated for an example of
positive angle.)

Relative Camera Angle Illustrated

To set the relative camera angle:
Use the slider bar or arrows to set the value from - 60.0 to 60.0 degrees.

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

NOTE: You must use the slider bar or arrows to set the Relative Camera Angle.
You cannot type a value into this field. Although this can be set for +/- 60 degrees,
it is recommended to keep the camera angle between +/- 45 degrees.

The relative camera angle setting determines whether the camera is a top, front,
or back read camera as shown in the Active Tunnel Configuration screen
segment of the Modify Setup / Tunnel Tab. (See page 3-56 for details.)
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Far Working Distance

The far working distance is the maximum distance at which optimal resolution of
the camera may be retained. In applications with variable package height, far
working distance is typically set to the belt. In applications with fixed package
height, the far working distance typically is set to the actual package height.

To set the far working distance:
Use the slider bar or arrows to set the value from 10 to 200 inches.

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

NOTE: You must use the slider bar or arrows to set the Far Working Distance.
You cannot type a value into this field.
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IMAGING TAB

The Imaging Tab contains the fields to set the scanning parameters for the
camera. The window is divided into three areas: Focus, Gain, and Scan Line
Clock.

Modify Setup – Imaging Tab
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FOCUS MODE

There are three camera focus modes: Leading Edge, Profile or Fixed.

Focus Mode Window Segment

To select a focus mode:
Step 1: Click the down arrow to the right of the Focus Mode displayed.
Step 2: Scroll up and down the list until the required mode is highlighted.
Step 3: Release the mouse button to select the highlighted focus mode.

Leading Edge Focus Mode

This mode uses the leading edge of the package as the focus height for the entire
length of the package, minimizing the time needed for focusing adjustments. This
mode is most appropriate for square/rectangular shaped packages travelling at
high belt speeds with tight spacing between packages. However, if this mode is
selected, it will not allow effective focusing on irregularly shaped packages. To
set the focus for irregularly shaped packages, see Profile Mode.

Profile Focus Mode

This mode enables the focusing to track the changing heights of packages. The
Profile focus mode is used for irregular shaped packages so all portions of the
package are kept in focus. The Profile focus mode is the standard for front read
or top read applications.

Fixed Focus Mode

This focus mode always uses the same height for all packages, regardless of the
actual package height.  The Fixed mode is appropriate for bottom read or
justified side read applications or when all packages are always the same shape
and height. This focus mode may also be used for troubleshooting. When this
focus mode is used, the Fixed Focus Height must also be set.

Fixed Focus Height Slider Bar

When using the Fixed Focus Mode, the fixed focus height must be set. Use the
Fixed Focus Height slider bar or arrows to set the value. Values are between
0.00 to 51.00 inches.

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

NOTE: You must use the slider bar or arrows to set the Fixed Focus Height
value. You cannot type a value into the field. The slider bar/arrows are disabled if
Fixed Focus Height is not used.
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GAIN MODE

Gain is the amount of light reflected off of a package surface. Too little or too
much gain can result in faded or saturated images that decrease contrast between
positive spaces (range of 200-220 on the gray scale) and negative spaces (range
of 40-80 on the gray scale). These reduced quality images can affect the decoding
process, resulting in higher no read rates.

There are two types of gain: Compensated and Fixed.

Gain Mode Window Segment

To select a gain mode:
Step 1: Click the down arrow to the right of the Gain Mode displayed.
Step 2: Scroll up and down the list until the required mode is highlighted.
Step 3: Release the mouse button to select the highlighted gain mode.

Compensated

The Compensated gain mode is used for normal system operation. This mode
automatically adjusts the image gain to compensate for package height and belt
speed using the values calculated from the gain table resident in the camera.

Fixed

Fixed gain mode always uses the same gain for all package heights and belt
speeds. This is only appropriate for camera systems that do not focus and have a
constant, fixed belt speed. It can also be used for troubleshooting camera
operation. When fixed gain mode is used, the Fixed Gain Slider Bar must also
be set.

Fixed Gain Slider Bar

When using the Fixed Gain Mode, the fixed gain must be set. Use the Fixed
Gain slider bar or arrows to set the value. Values are between 0 to 255 in
increments of one. The current value displays in the text box. The arrows change
the value by one per click. What this does is sets a fixed gain for all packages,
regardless of height.

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

NOTE: You must use the slider bar or arrows to set the Fixed Gain value.
You cannot type a value into the field. The slider bar/arrows are disabled if Fixed
Gain is not used.
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SCAN LINE CLOCK

Scan Line Clock controls the frequency at which the camera clocks the CCD
sensor. The rate at which one line of the image is taken is proportional to the belt
speed and DPI. There are four types of scan line clocks: Speed Compensated,
Height Compensated, Direct Tach, and Fixed Frequency.

Scan Line Clock Window Segment

To select a Scan Line Clock Mode:
Step 1: Click the down arrow to the right of the mode displayed.
Step 2: Scroll up and down the list until the required mode is highlighted.
Step 3: Release the mouse button to select the highlighted mode.

Speed Compensated

This mode adjusts the scan line clock to compensate for the belt speed, to ensure
that the DPI in the direction of travel is consistent with the belt movement. This
mode is usually used in camera systems with fixed focus or with decoding
software that is unaffected by distorted images. AccuVisions systems using an
Accu-Sort decoder are usually set to use the speed compensated mode.

Height Compensated

This mode is used in OCR applications. This mode adjusts the scan line clock to
compensate for both belt speed and package height, so that the DPI in the
direction of travel always matches the image resolution DPI. This produces
square pixels necessary for OCR applications.

Direct Tach

This mode lets the belt encoder directly drive the scan line clock. The scan line is
strobed directly for each incremental move of the belt. This mode should only be
used if the encoder is of the proper resolution. This mode is only used in custom
applications or if instructed by Accu-Sort engineers.

Fixed Frequency

This mode sets the scan line clock at a fixed frequency regardless of the belt
speed. This mode is appropriate for certain non-typical applications that need to
define the DPI based on specific belt speed and camera optics. This mode may
also be used for troubleshooting. When this mode is used, the Fixed Frequency
Slider Bar must also be set.
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Fixed Frequency Slider Bar

When using the Fixed Frequency Scan Line Clock Mode, the fixed frequency
must be set. Use the Fixed Frequency slider bar or arrows to set the value.
Values are between zero and 16,384.

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

NOTE: You must use the slider bar or arrows to set the Fixed Frequency value.
You cannot type a value into the field. The slider bar/arrows are disabled if Fixed
Frequency is not used.

Scan Lines Per Inch Slider Bar

Use the Scan Lines Per Inch slider bar or the arrows to set the value.
Values are between 80 and 500.

Hardware Pixel Correction

This box enables the camera’s pixel correction circuitry. The image pixels are
modified by calibration values learned at the factory to produce a more uniform
image. This mode is enabled for normal use. Disabling it can result in poor image
quality (individual pixel noise and non-uniform brightness). Disabling may be
appropriate for troubleshooting to isolate image corruption problems or to have
access to the raw pixel data that has not been modified in any way by the camera.

To enable or disable Hardware Pixel Correction:
Step 1: Click in the check box to activate Hardware Pixel Correction. A check
mark appears in the box, indicating the function is enabled.
Step 2: If it is necessary to deactivate pixel correction and there is a check mark
in the box, click the box to disable this mode.

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

NOTE: There is no reason to disable hardware pixel correction except in trouble-
shooting situations. Leave this function enabled for normal system operation.
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DECODER DIAG TAB

The Decoder Diag Tab provides settings for enabling and disabling decoder
diagnostics based on unrestricted or conditional decoder actions.

WARNING: The Decoder Diag Tab functions are intended for use by Accu-Sort
trained and authorized technicians only. These actions should be enabled for
diagnostic purposes only. They should not be left enabled after diagnostics are
completed because they will dramatically affect decoder performance.

Modify Setup – Decoder Diag Tab

To view the diagnostic information and images that are enabled from the Modify
Setup / Decoder Diag Tab, reference the Diagnostics and Utilities / Decoder
Monitor Tab in Chapter 4.
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UNRESTRICTED DECODER ACTION

If enabled, these unrestricted decoder actions will occur regardless of the
conditions set in Decoder Condition.

Display Decode Messages on Decoder

Use this checkbox to enable or disable the systems ability to display all decoder
messages. When enabled, these messages will appear in the Rolling Text
window of the Diagnostics and Utilities / Decoder Monitor Tab.

Display Decode Images on Decoder

Use this checkbox to enable or disable the systems ability to display all decode
images. When enabled, these package images will appear in the Image Edit
window of the Diagnostics and Utilities / Decoder Monitor Tab.

DECODER CONDITION

Do Action when Decode String Found in List

When a bar code is decoded, the decoder compares the decode string with the
strings entered in this list. If the decode string matches any string in this list, it
will perform the enabled Conditional Decoder Actions located in the lower
portion of the window.

To enable or disable Do Action when Decode String Found in List:

Step 1: Click in the check box to enable the action. A check mark will appear in
the check box.

Step 2: If there is a check mark in the box, click the mark to disable the decoder
condition.

To add strings to the list:

Step 1: Type the string into the field above the Add and Remove buttons.

Step 2: Click the Add button. The string will appear in the field below the Add
button.

Step 3: To check the accuracy of the string you just entered, you can use the
slider bar to view the entire string if it exceeds the width of the field.
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To remove a string from the list:

Step 1: Click on the string to highlight it.

Step 2: Click the Remove button. The string will disappear from the field below
the Remove button.

Do Action when Symbology Found in List

When a decode occurs, the decoder will compare the bar code data with the
symbologies in this list. If the decoded bar code matches any symbology in this
list, it will perform the enabled Conditional Decoder Actions located in the
lower portion of the window.

To enable or disable Do Action when Symbology Found in List:

Step 1: Click in the check box to enable the action. A check mark will appear in
the check box.

Step 2: If there is a check mark in the box, click the mark to disable the decoder
condition.

To add symbologies to the list:

Step 1: Use the down arrow to display the drop-down menu of available
symbologies.

Step 2: Highlight a symbology on the drop-down menu.

Step 3: Click the Add button. The selected symbology will appear in the field
below the Add button.

To remove a symbology from the list:

Step 1: Click on the symbology to highlight it.

Step 2: Click the Remove button. The symbology will disappear from the field
below the Remove button.
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CONDITIONAL DECODER ACTION

WARNING: These actions should be enabled for diagnostic purposes only. They
should not be left enabled after diagnostics are completed because they will
dramatically affect decoder performance.

The enabled Conditional Decoder Actions occur if any of the conditions set in
the Decoder Conditions are true.

To enable or disable Conditional Decoder Actions:

Step 1: Click in the check box to enable the action. A check mark will appear in
the check box.

Step 2: If there is a check mark in the box, click the mark to disable the
conditional decoder action.

Display Decode Image on Decoder

Use this checkbox to enable or disable the systems ability to display conditional
decode images. When enabled, if any defined Decoder Condition is true (i.e.:
found in list), these package images will appear in the Image Edit window of the
Diagnostics and Utilities / Decoder Monitor Tab.

Save Decode Image on Decoder

CAUTION: If Save Decode Image on Decoder is enabled, this will create rather
large files which will consume decoder resources and eventually affect
performance. This function should not remain enabled during normal operation.

If any defined Decoder Condition is true (i.e.: found in list), the decoder will
save the decode image to a sequential file name. The file name will be in the
following format:

SeqNum<SeqNum:10>_<CodeNum:2>.Bmp

where <SeqNum:10> is the 10 digit sequence number for the package and
<CodeNum:2> is the code number for this decode. This first code number will be
1, the second will be 2, and so on.

For example: 0000000003_1.bmp is the file name for sequence number three, the
first code read.
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PKG MGMT DIAG TAB

The Pkg Mgmt Diag Tab provides settings for enabling and disabling
diagnostics that can be used to monitor the tracking system. These diagnostics
are used to determine whether or not the system is tracking packages correctly.

WARNING: The Pkg Mgmt Diag Tab functions are intended for use by Accu-
Sort trained and authorized technicians only. These actions should be enabled
for diagnostic purposes only. They should not be left enabled after diagnostics
are completed because they will dramatically affect decoder performance.

Modify Setup – Pkg Mgmt Diag Tab

To view the diagnostic information and images that are enabled from the Modify
Setup / Pkg Mgmt Tab, reference the Diagnostics and Utilities / Decoder
Monitor Tab in Chapter 4.
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UNRESTRICTED TRACKING ACTION

If enabled, these unrestricted tracking actions will occur regardless of the
conditions set in Tracking Condition. (See page 3-44 for details.)

Display Box Image On Decoder

Use this checkbox to enable or disable the systems ability to display all box
images. When enabled, these package images will appear in the Image Edit
window of the Diagnostics and Utilities / Decoder Monitor Tab. (These images
are also displayed in the Decode View window located on the AVCore System
Inspector Main Window.)

Display Transmit Point Image On Decoder

Use this checkbox to enable or disable the systems ability to display all transmit
point images. When enabled, these images will appear in the Image Edit window
of the Diagnostics and Utilities / Decoder Monitor Tab. (These images are
also displayed in the Tracker View window located on the AVCore System
Inspector Main Window.)

Save Box Image On Decoder

CAUTION: If Save Box Image On Decoder is enabled, this will create rather
large files which will consume decoder resources and eventually affect
performance. This function should not remain enabled during normal operation.

When enabled, the Tracking Service saves the Box Image to a local sequential
file name in the following bitmap format:

\Bmps\SeqNum<SeqNum:10>.Bmp

The bitmaps directory (Bmps) will be created as a subdirectory of the AVCore
applications location.
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PACKAGE DATABASE MODE

There are three Package Database Modes: Disabled, Transmit Point Image, and
Box Image. The package database is a collection of package images stored in
memory by AVCore. You can view the package database images by using the
Diagnostics and Utilities / Package History Tab, View Packages feature. (See
Chapter 4.)

(***add Package Database Mode drop-down menu here***)

Package Database Mode Window Segment

WARNING: A significant amount of processing resources (CPU time and memory)
are used when a package database mode is used to save images. For this
reason, the Disabled package database mode should be used during normal
operations. Other modes should only be used for diagnostic purposes. To
limit resource usage, only the most recent 16 package images are stored in the
package database.

Disabled

When this mode is selected, the Package Database Mode is disabled. This mode
should be selected during normal operation of your system.

Transmit Point Image

Select this mode for Transmit Point Images. When this mode is selected, AVCore
copies Transmit Point Images from the Decode Engine’s image buffer into the
Package Database. A Transmit Point Image consists of the bounding edges of a
package including the Start Box line (green) End Box line (red), Decode Issue
line (blue), Transmit Point line (white) and Decode dots (blue for decoded bar
code, red for bar codes not decoded). This image only includes valid image data
within the bounding edges of a package, and excludes data before the Start Box
line, after the End Box line and beyond the left and right edges of the package.
The size of the image is determined by the Image Compression Mode selection.
(See page 3-48.)

Box Image

Select this mode for Box Images. When selected, AVCore copies Box Images
from the Decode Engine’s image buffer into the Package Database. A Box Image
consists of the entire width of the sensor, which is usually the width of the
conveyor belt for the length (duration) of the package. This image includes the
Start Box line (green) and the End Box line (red). The size of the image is
determined by the Image Compression Mode selection. (See page 3-48.)



ACCU-SETUP FOR ACCUVISION SOFTWARE MANUAL   VERSION 4.0 3-43

Solutions with vision.

TRACKING CONDITION

The actions checked in this section occur as part of the tracking mechanism in the
system. If enabled, these actions occur at the transmit point.

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

USEFUL TIP: When setting up a Do Action list, remember that as long as the Do
Action box is not checked, no action is taken. To retain a list of actions, you may
find it useful to simply disable the action by clicking on the checkbox rather than
adding then removing an action from the list.

Do Action When Decode String Found In List

When transmit point occurs, the tracking service compares the decoded data
strings in the current package’s host message to the strings in this list. If any
decode string matches any string in this list, it will perform the enabled
Conditional Tracking Actions located in the lower portion of the window.

To enable or disable Do Action when Decode String Found in List:

Step 1: Click in the check box to enable the action. A check mark will appear in
the check box.

Step 2: If there is a check mark in the box, click the mark to disable the decoder
condition.

To add strings to the list:

Step 1: Type the string into the field above the Add and Remove buttons.

Step 2: Click the Add button. The string will appear in the field below the Add
button.

Step 3: To check the accuracy of the string you just entered, you can use the
slider bar to view the entire string if it exceeds the width of the field.

To remove a string from the list:

Step 1: Click on the string to highlight it.

Step 2: Click the Remove button. The string will disappear from the field below
the Remove button.
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Do Action When Symbology Found In List

When transmit point occurs, the tracking service will compare the decoded
symbologies in the current package’s host message to the symbologies in this list.
If any symbology in the host message matches any symbology in this list, it will
perform the enabled Conditional Tracking Actions listed in the lower portion of
the window. (For details, see page 3-47.)

To enable or disable Do Action when Symbology Found in List:

Step 1: Click in the check box to enable the action. A check mark will appear in
the check box.

Step 2: If there is a check mark in the box, click the mark to disable the tracking
condition.

To add symbologies to the list:

Step 1: Use the down arrow to display the drop-down menu of available
symbologies.

Step 2: Highlight a symbology on the drop-down menu.

Step 3: Click the Add button. The selected symbology will appear in the field
below the Add button.

To remove a symbology from the list:

Step 1: Click on the symbology to highlight it.

Step 2: Click the Remove button. The symbology will disappear from the field
below the Remove button.
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Do Action When Number of Codes Found In List

When the transmit point occurs, the tracking service will compare the number of
decodes in the current package’s host message with the counts in this list. If the
number of decodes in the host message matches any count in this list, it will
perform the enabled actions listed in the lower portion of the window.

To enable or disable Do Action When Number of Codes Found In List:

Step 1: Click in the check box to enable the action. A check mark will appear in
the check box.

Step 2: If there is a check mark in the box, click the mark to disable the tracking
condition.

To add a count to the list:

Step 1: Use the down arrow to display the drop-down menu of numbers.

Step 2: Highlight a number on the drop-down menu.

Step 3: Click the Add button. The selected number will appear in the field below
the Add button.

To remove a count from the list:

Step 1: Click on the number to highlight it.

Step 2: Click the Remove button. The number will disappear from the field
below the Remove button.
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CONDITIONAL TRACKING ACTION

The enabled Conditional Tracking Actions occur if any of the conditions set in
the Tracking Conditions are true.

To enable or disable Conditional Tracking Actions:

Step 1: Click in the check box to enable the action. A check mark will appear in
the check box.

Step 2: If there is a check mark in the box, click the mark to disable the
conditional tracking action.

Display Transmit Point Image On Decoder

Use this checkbox to enable or disable the systems ability to display conditional
transmit point images. When enabled, if any defined Tracking Condition is true
(i.e.: found in list), these transmit point images will appear in the Image Edit
window of the Diagnostics and Utilities / Decoder Monitor Tab.

Save Transmit Point Image On Decoder

CAUTION: If Save Transmit Point Image on Decoder is enabled, this will create
rather large files which will consume decoder resources and eventually affect
performance. This function should not remain enabled during normal operation.

If any defined Tracking Condition is true (i.e.: found in list), the Tracking
Service will save the Transmit Point Image to a local sequentially named file in
the following bitmap format:

\Bmps\SeqNum<SeqNum:10>.Bmp

The bitmaps directory (Bmps) will be created as a subdirectory of the AVCore
applications location.
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IMAGE COMPRESSION MODES

This feature enables you to select the type of image file compression used
by the system. The more compressed a file is, the less disk space and
resources used. The less compressed a file is, the more detailed the image,
resulting in larger data files. Use the image compression modes in
conjunction with the Diagnostics and Utilities / Decoder Monitor and
Package History Tabs for monitoring and diagnosing decode
performance. (See Chapter 4.)

ASI Compression

This image compression mode automatically uses an algorithm to
compress the image file. This algorithmic computation is based on
averaging the range of pixel variation in an image. Thus, the resulting file
size is determined by the variation within the captured image. The more
uniformity in an image, the greater the compression, which reduces the
image file size. The less uniformity in an image (i.e..: the greater the
variation), the lesser the compression, which increases the image file size.

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

NOTE: When ASI Compression mode is selected, the Down Sampled Image
Divisor slider bar cannot be used.

Down Sampling

This image compression mode enables you to determine the amount of
file compression by down sampling the image. When an image is down
sampled, only a selected number of pixels remain in the final image file,
resulting in a reduced file size. The actual down sample number
represents the number of pixels omitted in both the X and Y directions of
the original image for the pixel-to-pixel display in the resulting image.
The resulting image size will be determined by the following formula:

Original image size ÷ n
2

(Where “n” is your down sampled number.)

For example, with a down sample of eight every eighth pixel in both
directions will be used for displaying or saving an image. Therefore, an
image that is 10Mb in size will be displayed or saved as a 156K image.

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

NOTE: When Down Sampling compression mode is selected, the Down
Sampled Image Divisor slider bar can be used to define the amount of image
down sampling (from zero to 16).
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Down Sampled Image Divisor

CAUTION: While Accu-Setup provides the ability to save images in real-time by
enabling functions such as Save Box Image On Decoder and Save Transmit
Point Image On Decoder, these functions should only be used for diagnostic
purposes since they seriously affect decoder performance. DO NOT leave these
functions enabled during normal operation.

This feature is used to reduce the processing time and storage size of
images that are saved or displayed when certain functions of the Modify
Setup / Pkg Mgmt Diag tab and the associated Diagnostic and Utilities
/ Decoder Monitor tab have been enabled.

The larger the Down Sampled Image Divisor (between one and 16) the
lower the image resolution. Since images can be as much as 5MB to
32MB, higher settings (eight or above) are recommended.

The lower the Down Sampled Image Divisor (especially when below
five), the more storage and processing time is used, which will affect
system performance.

To set the Down Sampled Image Divisor:
Use the scroll bar or the arrows to set the value from one to 16.
(The recommended setting is eight or higher. The default setting is
eight.)

Since the down sampling setting can result in the storage of rather large
files, an alert message, such as the one shown below, is displayed to
warn you that you may be adversely affecting system performance,
especially if setting down sampling lower than eight.

Alert Message – Down Sampling

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

NOTE: The Down Sampled Image Divisor setting will only affect displayed or
saved images. It does not affect images being processed by the decoder.
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LOGGING TAB

The Logging Tab contains the names of all of the logs available through
Accu-Setup. Enabling the logs can affect system performance so, be
careful which logs are enabled. Log data is sent out the Host port on the
SMIO. There are four categories of logs: SMIO, Decoder, Alarm Mask,
and Message Mask.

WARNING: The Logging Tab functions are intended for use by Accu-Sort
trained and authorized technicians only. These logs are for diagnostic purposes
only. While these features can be enabled through Accu-Setup, some of them
cannot be viewed via Accu-Setup. No changes should be made to this tab
unless otherwise authorized by an Accu-Sort trained and authorized technician.

Modify Setup – Logging Tab

To view the SMIO and decoder logs enabled from the Modify Setup /
Logging Tab, reference the Diagnostics and Utilities / Logging
Diagnostics Tab in Chapter 4.
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SMIO LOGGING

The SMIO automatically stores certain user-selectable events occurring
on the SMIO board when these logs are enabled. Data can be collected on
trigger, tracking, imaging, communication, and system status events. The
SMIO log contains the last 30 events.

To enable or disable a log:

Step 1: Click in the box next to the SMIO log that the system should
automatically maintain. A check will appear in the box.

Step 2: If a check appears in the box next to a log, the system is saving that item.

Step 3: To disable a log, clear the box by clicking the check mark. A log is
disabled when the box is empty.

SMIO Logs Description
Trigger Log
Tracking Log
Imaging Log
Communications Log
System Status Log

Details on the SMIO Logs are provided to Accu-Sort trained and
authorized technicians only.

DECODER LOGGING

The system will automatically store certain user-selectable decoder data
when these logs are enabled. Data can be collected on decoder, tracking,
configuration, and system status. Each time a log is enabled, it overwrites
the previous log information. All log files are stored (saved) in the
application root directory of the AVCore executable.

CAUTION: Use these logs for diagnostics purposes only. The Decoder Logging
is not limited in size. Collecting data in this log during normal system operation will
impact system performance and will expend hard drive space.

To enable or disable a log:

Step 1: Click in the box next to the decoder log that the system should
automatically maintain. A check will appear in the box.

Step 2: If a check appears in the box next to a log, the system is saving that item.

Step 3: To disable a log, clear the box by clicking the check mark. A log is
disabled when the box is empty.

Decoder Logs Description
Decoder Log
Tracking Log
Configuration Log
System Status Log

Details on the Decoder Logs are provided to Accu-Sort trained and
authorized technicians only.
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ALARM MASK

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

NOTE: The Alarm Masks are diagnostic messaging tools. They are factory
preset. These should not be changed unless instructed to do so by an Accu-Sort
trained and authorized technician. While the alarm masks are enabled through
Accu-Setup, they cannot be viewed through Accu-Setup.

Alarm Mask Description
Focus Fault
Illumination Fault
Under Temperature
Over Temperature
Right Lamp
Left Lamp
Main Temperature
Display Status

Details on the Alarm Masks are provided to Accu-Sort trained and
authorized technicians only.

MESSAGE MASK

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

NOTE: The Message Masks are diagnostic messaging tools. They are factory
preset. These should not be changed unless instructed to do so by an Accu-Sort
trained and authorized technician. While the message masks are enabled
through Accu-Setup, they cannot be viewed through Accu-Setup.

Message Mask Description
Start / End Package
Carton Length
Carton Height
Conveyor / Errors
Alarms / Faults
Image Valid Reset
Power-up / Reboot

Details on the Message Masks are provided to Accu-Sort trained and
authorized technicians only.
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OUTPUTS TAB

The Outputs Tab is used to define the active time, output signal, and condition
that causes activation of up to four optional digital outputs. These outputs can be
used to operate various external mechanisms including package diverters,
warning lights, and visual and/or audible alarms.

Modify Setup – Outputs Tab

Typically, when these outputs are used, it is through an Accu-Sort Quad Relay
box that connects to the camera’s I/O port. As an interface with the camera,
Accu-Setup enables you to determine how the devices connected to these digital
outputs will operate.

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

NOTE: For details on the Accu-Sort Quad Relay box that can be used in
conjunction with the Modify Setup / Outputs Tab to activate up to four external
devices, contact your Accu-Sort representative. (Also see the Diagnostics and
Utilities / Output Tab in Chapter 4.)

There are four window segments on the Outputs Tab, one for each of the four
digital outputs (i.e.: Digital Out 1 through Digital Out 4). While each output may
be assigned to manage individual tasks, setting the parameters for each is handled
the same for all four digital outputs.
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CONDITION TO ACTIVATE

Setting the Condition To Activate is dependent on what function the external
device (to which the digital output is connected to) will be performing. There are
six options available from the Conditions To Activate drop-down menu as
defined below.

Condition to Activate Drop-down Menu

Conditions to Activate Description
Not Used The digital output is not used.

Life Activates when SMIO powers up and initializes.

No read Activates at transmit point if any field in the host message is
a no read.

Read Activates if all the fields in the host message are read data.

Multiple Activates if more than one bar code of the type enabled is
decoded.

Image Valid Activates for the duration an image is valid or for a set
period of time, whichever is shorter.

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

NOTE: The Read, No read, and Multiple conditions are based on what bar codes
your system is set-up to decode. See the Modify Setup / Symbologies Tab for
details on how to define the symbologies your system will read.

Active Time

The active time defines the length of time the digital output signal is active. This
time is dependent on your specific application. You need to determine the
amount of time (in milliseconds) that the digital output signal should remain
activated, then set the active time.

To set the active time:
Use the slider bar or the arrows to set the value in the window. Values in the
window are between zero to 2000.

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

NOTE: You must use the slider bar or arrows to set this value. You cannot type a
value into the window. The slider bar/arrows are disabled if the digital output is not
being used.
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Output Signal

The output signal can be set for either Active High or Active Low.

Output Signal Drop-down Menu

To select the Output Signal:

Step 1: Use the down arrow to display the drop-down window.

Step 2: Highlight either active high or low. The highlighted selection appears in
the field under Output Signal.

Example Output Set-up

Set Digital Output 1 to trigger an alarm for about 1000 milliseconds when a no
read occurs with a high output signal when activated:

Step 1: In the Digital Output 1 window segment of the Outputs Tab, use the
Condition To Activate down arrow to display the drop-down menu.

Step 2: Highlight Noread on the drop-down menu. Noread will appear in the
field under Condition To Activate.

Step 3: Go to the Active Time (msec) slider bar and use the slider bar or arrows
to set the time for 1000. This time will appear in the field to the right of the
words Active Time (msec).

Step 4: Use the Output Signal down arrow to display the drop-down menu.

Step 5: Highlight Active High on the drop-down menu. Active High will appear
in the field under Output Signal.
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TUNNEL TAB

The Tunnel Tab provides settings for applications where camera(s) are used to
read bar codes on multiple sides of packages. The Tunnel Tab is used to enable
or disable multi-sided imaging mode, tunnel focus mode for applications using an
Accu-Sort DM-3000 dimensioning unit, and also identifies the active tunnel
configuration for the camera currently connected with Accu-Setup.

Modify Setup – Tunnel Tab
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MULTI-SIDE IMAGING GAIN COMPENSATION

This function is used when a camera is mounted to read more than one surface of
packages (e.g: codes are located on the front and top or top and back of packages
passing through the scanning area). In multi-sided imaging applications, it is
necessary to make adjustments to the bright surface gain percentage and edge
transition to assure optimal system performance.

Multi-Side Image Gain Compensation Window Segment

Enable Multi-Side Imaging Mode

If the camera reads codes on more than one surface of a package, be sure this
function is enabled. A checkmark should appear in the checkbox. When enabled,
both the Bright Surface Gain % and Edge Transition Adjustment (in.) will
also be activated.

Bright Surface Gain %

This slider bar is used to adjust the gain values to compensate for variations in
light reflected back into the camera from the different surfaces of the packages.

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

IMPORTANT TIP: To adjust for the brightest surface, it is recommended that
packages be run through the scanning area while making this adjustment.

To set the bright surface gain percentage:
Use the slider bar or arrows to set the value from zero to 150.

Edge Transition Adjustment (in.)

This slider bar is used to compensate for any slight offset from where the camera
detects the package edge (or transition line) between two surfaces and where the
edge physically is on the package.

To set the edge transition adjustment:
Use the slider bar or arrows to set the value from - 9.9 to 9.9.
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DM-3000 FOCUS DATA SETUP

This Tunnel Tab window segment is used to identify the camera tunnel focus
mode and set the DM-3000 scan window length for applications that are using
the Accu-Sort DM-3000 dimensioning unit.

DM-3000 Focus Data Setup Window Segment

Tunnel Focus Mode

There are four options provided in the Tunnel Focus Mode drop-down menu:
Off (No DM-3000), Front/Top/Back Read, Left Side Read, and Right Side Read.

DM-3000 Scan Window Length (in.)

This value needs to match the parameter set in the Accu-Sort DM-3000
dimensioning unit.

To set the DM-3000 scan window length:
Use the slider bar or the arrows to set the value from 20 to 60.

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

NOTE: For details on the Accu-Sort DM-3000 dimension unit, refer to the product
manual provided with the equipment, or contact your Accu-Sort representative or
Customer Service.
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ACTIVE TUNNEL CONFIGURATION

This window segment identifies the type of camera mounting being used by the
camera to which Accu-Setup is connected. This is determined by the Tunnel
Focus Mode and Relative Camera Angle.

Active Tunnel Configuration Window Segment

There are five boxes displayed in this area: Top, Front, Back, Left, and Right.
The white box indicates the type of configuration being used by the camera
currently connected to Accu-Setup. In the example window segment, the Top
configuration is being used.

The Active Tunnel Configuration is associated with the Relative Camera
Angle that is set using the Modify Setup / Tracking Tab / Camera Mounting
window segment.  (For details, see page 3-29.)

Relative Camera Angle (deg.) Active Tunnel Configuration
Between  -45 and -16 Front
Between  -15 and +15 Top
Between +16 and +45 Back
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DECODER DISPLAY/POWER MGMT TAB

The Decoder Display/Power Mgmt Tab is provided for AccuVision Systems
that utilize the Accu-Sort APC100 as the Decoder. Use this tab to enable the
APC100 remote display and to protect the decoder in the event of a power failure
or system shutdown.

WARNING: These settings are factory-preset. They should not be changed
unless you are instructed to do so by an Accu-Sort trained and authorized
technician.

If you physically switch the COM port of either the power monitor or UPS monitor
and it is different than what is indicated in Accu-Setup, the system initiates a safe
shutdown.

Modify Setup – Decoder Display/Power Mgmt Tab

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

NOTE: These functions are only intended for use with an APC100 Decoder
because of the specific internal hardware required. They are not intended for use
on systems using a desktop PC.



3-60 CHAPTER 3: MODIFY SETUP

Accu-Sort System, inc.

REMOTE DISPLAY

When an APC100 Decoder is used, this feature is used to enable/disable
communications with the APC100 and its two-line LCD display. This function
should be disabled for applications not using an APC100. (For details on
messages displayed on the APC100, go to the Appendix D in Chapter 6.)

Enable Remote Display

When checked, the remote display is enabled. To disable the remote display,
click in the checkbox to remove the checkmark.

Com Port

The Com Port drop-down menu enables the selection of Com Port 1 through
Com Port 4. The default for this setting is Com Port 2.

To change the Com Port setting:
Step 1: Use the Com Port down arrow to display the drop-down menu.
Step 2: Highlight the desired port setting on the drop-down menu. The selected
port will appear in the field under Com Port.

Remote Display Port Settings

This field identifies the communications settings for the APC100.

To change the communication setting for the port:

Step 1: Click the arrow to the right of the current settings.

Step 2: When you click the arrow, a Port Settings window appears. This
window contains the settings for each communication parameter. Upon opening,
all values displayed in these fields are the current settings.

Port Settings Window

Step 3: Click the down arrow to the right of each current setting to display the
choices available.
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Step 4: Change the settings for any or all of the options as necessary. The options
are as follows:

Settings Available Options
Baud Rate 1200, 2400, 4800, 9600, 19200, 38400, 57600, 115200
Stop Bits 1 or 2
Parity None, Even, Odd
Data Bits 7 or 8

Step 5: Click OK to enable new settings or Cancel to return to previous settings.

POWER MONITOR

Enable Power Switch Monitor

Use this feature to enable the APC100 to monitor the power switch so that if the
switch is set to the OFF position, the system will perform a “safe” shutdown.
This is useful in applications where the entire system is shutdown from a single
location. When enabled, the APC100 will perform a structured shutdown (i.e.:
AVCore will shutdown and then perform a proper Windows shutdown).

True Level of a Soft Power Switch (power is on)

Logic Zero (Low at Connector)
Logic One (High at Connector)

Enable UPS Monitor

This feature enables the APC100 to perform a “safe” shutdown when the system
uses an uninterruptable power supply for backup. If the UPS runs out of power,
the APC100 will perform a structured shutdown (i.e.: AVCore will shutdown and
then perform a proper Windows shutdown).

True Level of a Power Failure Notification
Logic Zero (Low at Connector)
Logic One (High at Connector)
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DIMENSIONING TAB

The Dimensioning Tab is used with camera systems that incorporate the
optional VisionCube dimensioning software. The VisionCube dimensioning
software provides the AccuVision system with more complete product
dimensioning information than available through the use of a light curtain
without requiring the addition of a DM-3000 Dimensioning Unit.

Modify Setup – Dimensioning Tab

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

IMPORTANT: For all VisionCube dimensioning functions, the APC100 must have
a valid license that allows for the reception of dimensioning parameters. If the
parameters are set in Accu-Setup, but there is no valid license on the Decoder,
then the following message appears in the Details window of AVCore:

Dimensioning not allowed

For additional information on VisionCube Dimensioning Software, contact
Accu-Sort Customer Service at 1-800-BAR-CODE.

If your system is capable of dimensioning, you will be able to access and modify
the dimensioning parameters. In order to use dimensioning features, the
Dimensioning Enabled checkbox should be checked.
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DIMENSIONING PARAMETERS

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

NOTE: Typically, the only values that will change based on your application are:
Camera Tilt Angle, Average Black Level, Minimum Package Dimension,
Reference Heights, and Reference X Densities. Both the Reference Heights
and Densities are very important. Dimensioning will not work accurately unless
these values are set correctly.

Left X

Use this field to set the number of pixels of the left bound (distance from the left
side of package) in package dimensioning. The minimum value that can be
entered in this field is 0; the maximum value is 20,000 pixels.

To reset the field to the default value of 0, click the Default All button.

Right X

Use this field to set the number of pixels of the right bound (distance from the
right side of package) in package dimensioning. If this is set to 0, then the right
bound is set to the farthest right pixel of the image. The minimum value that can
be entered in this field is 0; the maximum value is 20,000 pixels.

To reset the field to the default value of 0, click the Default All button.

Vertex Offset

The value of this key is an offset, in inches (millimeters), which is used in
computing the vertex element. The minimum value that can be entered in this
field is 0; the maximum value is 20,000 inches.

To reset the field to the default value of 0, click the Default All button.

Optical Center X

Use this field to set pixel position of the optical centerline for dimensioning. This
value should be set accurately for optimum dimensioning performance, and it is
especially important when compensating package dimensioning for distortion
due to perspective. The minimum value that can be entered in this field is -1; the
maximum value is 20,000 pixels. If the Optical Center X is set to -1, then this
value sets the position so the center pixel of the captured frame is used as the
optical centerline.

To reset the field to the default value of -1, click the Default All button.
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Reference Height 1

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

IMPORTANT:  Both the Reference Heights and Reference X Densities are very
important. Dimensioning will not work accurately unless these values are set
correctly. The decoder requires density samples at two heights in order to
correctly dimension packages.

Use this field to set the height for specifying sampling density Reference X
Density 1. The minimum value that can be entered in this field is 0; the
maximum value is 200 inches (millimeters).

To reset the field to the default value of 0, click the Default All button.

Reference Height 2

Use this field to set the height for specifying sampling density Reference X
Density 2. The minimum value that can be entered in this field is 0; the
maximum value is 200 inches (millimeters).

To reset the field to the default value of 0, click the Default All button.

Reference X Density 1

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

IMPORTANT:  Both the Reference Heights and Reference X Densities are very
important. Dimensioning will not work accurately unless these values are set
correctly. The decoder requires density samples at two heights in order to
correctly dimension packages.

Use this field to set the X-axis sampling density at Reference Height 1. This
value together with the Reference Density 2, Reference X Height 1 and
Reference X Height 2 are used to determine the sampling density in the X-axis
direction as a function of package height, which is important when compensating
package dimensioning for distortion due to perspective. Linear interpolation is
used to determine sampling density at heights other than the reference heights.
For greater accuracy, the values for Reference Height 1 and Reference Height 2
should be selected so they are as far apart as is practical for the application.

The minimum value that can be entered in this field is 0; the maximum value is
20,000 pixels/inch (pixels/meter).

To reset the field to the default value of 4000, click the Default All button.

Reference X Density 2

Use this field to set the X-axis sampling density at Reference Height 2. This
value together with the Reference Density 1, Reference X Height 1 and
Reference X Height 2 are used to determine the sampling density in the X-axis
direction as a function of package height, which is important when compensating
package dimensioning for distortion due to perspective.

The minimum value that can be entered in this field is 0; the maximum value is
20,000 pixels/inch (pixels/meter).

To reset the field to the default value of 4000, click the Default All button.
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Minimum Package Dimension

Use this field to set the minimum height limit of a package that is to be detected
by the object-sensing device. The minimum value that can be entered in this field
is 0; the maximum value is 500 inches (millimeters).

To reset the field to the default value of 51, click the Default All button.

Expand Y

Adjust to the top (distance from the top side of package) and bottom (distance
from the bottom side of package) bounds for dimensioning when the Top Y
and/or Bottom Y parameters are defaulted as -1. Although normally this value
will not be negative, a negative value may be used to contract the top and bottom
dimensioning bounds. The unit of adjustment is millimeters. The minimum value
that can be entered in this field is -500; the maximum value is 500 inches
(millimeters).

To reset the field to the default value of 0, click the Default All button.

Average Black Level

Use this field to manually set the average black level of the background on which
scanned objects travel (e.g., the value of the transport’s black level). The
application presumes that the level is basically uniform throughout the
background, so the Average Black Level value is extrapolated for the entire
background. The minimum value that can be entered in this field is 0 (solid
black); the maximum value is 255 (solid white) as a RGB (red, green and blue
color mode) pixel.

To reset the field to the default value of 20, click the Default All button.

Camera Tilt Angle

Use this field to set the tilt angle of the camera’s imaging plane with respect to
the standard plane that is relative to the transport’s fixed plane. Positive angles
indicate forward tilt (i.e., tilt in the direction of transport motion). Negative
angles indicate backward tilt. When the tilt is accurately set, it improves the
results of the dimensioning, especially for taller objects. The minimum value that
can be entered in this field is -60; the maximum value is 60 degrees.

To reset the field to the default value of 8, click the Default All button.

Dimensioning Enabled

Use this checkbox to enable or disable the dimensioning function. To enable
dimensioning, place a check in the Dimensioning Enabled field checkbox.
Dimensioning will not be performed unless this field is enabled, even if your
system includes dimensioning capabilities. To disable the dimensioning function,
uncheck the Dimensioning Enabled checkbox.
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Adjustment 1

WARNING: Modify this parameter only when instructed to do so instructed by an
Accu-Sort trained and authorized technician.

This field is for fine-tuning dimensioning and is customized to each specific
application. The minimum value that can be entered in this field is 0; the
maximum value is 200.

To reset the field to the default value of 8, click the Default All button.

Default All  

When you click this button, all dimensioning parameters are returned to the
original factory-preset default parameters for dimensioning.
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CHAPTER 4: DIAGNOSTICS AND UTILITIES

The Diagnostics and Utilities window provides access to a series of tools used
for monitoring system performance and diagnosing and troubleshooting various
operating conditions. These tools are organized into functional groupings
identified by eight tabs across the top of the Diagnostics and Utilities screen.

Diagnostics and Utilities Tab Selections

To access this screen, click the Diagnostics and Utilities button on the Accu-
Setup Main Window button menu.

Diagnostics and Utilities Button

NOTE: The Diagnostics and Utilities tabs may also be accessed through the
Utilities drop-down menu located at the top of the Accu-Setup Main Window.
Note that when Diagnostics and Utilities is selected, the System Status tab is
automatically displayed.

The diagnostics and utilities features enable the user to check how changes made
using the Modify Setup functions affect system performance or evaluate current
system performance to see where improvements can be made.

CAUTION: Many of the features available through the Diagnostics and Utilities
tabs are intended for diagnostic and troubleshooting purposes only. In
many cases, it is recommended that these functions be used only by Accu-Sort
trained and authorized service technicians. Since some of these diagnostic and
utilities can significantly affect system performance, it is also recommended that
these function should not remain enabled during normal system operations.

Note: The Modify Setup tabs may also be selected from the Edit drop-down menu
located at the top of the Accu-Setup Main Window. Note that when Modify Setup is
selected, the Symbologies tab is automatically displayed.

USEFUL TIP: The Accu-Setup tab screens provide a Help button at the bottom
right-hand of each screen. By clicking the Help button, you can access topics
related to that screen in Accu-Setup: AccuVision Module Help. (If there is no
information for that specific screen, an error message is displayed.) The online
help Contents and Search features can also be accessed from the Help drop-
down menu. (See Chapter 5 for details.)
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SYSTEM STATUS TAB

When the Diagnostic and Utilities function is selected (either from the button
menu or Utilities drop-down menu), the first screen displayed is the System
Status tab. This tab is the primary system status window containing all current
system statistics. Accu-Setup updates these statistics approximately once per
second. The window is divided into two parts: SMIO Status and Decoder
Status.

Diagnostics and Utilities – System Status Tab
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SMIO STATUS

The SMIO Status window segment of the System Status tab provides
operational diagnostic information that may be used to evaluate the camera’s
performance. The information shown in this window segment is current (to
within one second) and provides the data for the last package scanned by the
camera.

SMIO Status Window Segment

Belt Speed (fpm)

Defines the current belt speed in feet per minute. The belt speed is used to adjust
the camera scan line rate to produce the least amount of distortion and yield the
highest scan rate. When an external tach encoder is used, the belt speed shown is
provided by the device. If the system has been set to use an internal tach, this
setting is displayed, regardless of the actual belt speed.

Focus Height

Indicates the current camera far distance focus height dimension (i.e.: the height
of the box currently being imaged). The focus height should be set as closely as
possible to the actual height of packages being scanned by the camera so that the
camera will need to make little or no adjustment of its focus mechanism between
packages. Fine-tuning the height adjustment can yield more accurate read rates
during normal operation.

Gain Value

Displays the current analog-to-digital gain for the last package. The gain defines
the intensity of light reflected from the package to the camera sensors. This value
is defined by the Gain Table, which is uploaded to the camera’s sensors, causing
them to adjust the gain based on package height and belt speed. If either too
much or too little light is received by the camera’s sensors, it is possible that bar
codes will not be decoded.

NOTE: For further details on the gain table, see the Modify Gain Table selection
located in the Utilities drop-down menu. (See Chapter 5.) Do not make changes
to the gain table unless under the supervision of an Accu-Sort authorized and
trained technician.
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DPI

Displays the DPI (dots per inch) at the focus height of the last package scanned.

Temperature

Indicates the current internal temperature of the camera. The temperature
indicator is either green or red. Green indicates that the temperature is within
acceptable ranges. Red indicates that the temperature is out of range and the
system should be shut down to cool.

Tach Count

Defines the total tach count (i.e.: the number of pulses received from the
tachometer per minute). It is used to indicate that the belt is moving. The tach
count shown in this field continues until either the counter rolls over or the
system is restarted, at which point the count begins from zero. Because both the
tach count and camera resolution are closely associated with each other, if you
notice a change in camera performance, it may be as a result of changes in the
tachometer.

Elapsed Time (sec)

Indicates the total elapsed time (in seconds), that the camera has been running.
Compare this elapsed time with the elapsed time of the decoder (in the Decoder
Status window segment) to determine if there was any time during which the
camera was operational that the decoder was not or vice versa.

Lamp (No Status)

The lamp status indicator is not on this version of Accu-Setup. (For details on
the Smart Illumination Setup and Diagnostic function available from the
Utilities drop-down menu, see Chapter 5.)

NOTE: SMIO Status / Lamp indicator on previous Accu-Setup versions - These
indicators show that the SI20 sodium illumination (lamps) are lit and operating
within a normal range. Green indicates the lamp is operating normally. Red
indicates a fault. Single illumination systems have only one indicator and the on-
screen text reads Main Lamp rather than Left and Right.

Total Package Count

Shows the total number of packages detected since the values were last cleared.
To clear all counts, click on Reset SMIO Counts button. The counts are also
cleared whenever the system is restarted.
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Total Error Count

The total of all of the errors that have occurred since the SMIO was last cleared.
If an excessive number of errors appears in this field, it indicates a problem with
system performance. To clear all counts, click on Reset SMIO Counts button.
The counts are also cleared whenever the system is restarted.

Decode Too Late

Defines the number of times the SMIO did not have the decode results at the
transmit point. This is a valid value only in decoder systems. To clear all counts,
click on Reset SMIO Counts button. The counts are also cleared whenever the
system is restarted.

Current Package ID

Identifies the current package being detected. The system keeps data on the last
16 packages processed. ID numbers are between zero and 15.

Reset SMIO Counts Button

Click this button to reset the following fields to zero: Total Package Count, Total
Error Count, and Decode Too Late. These fields will continue to count until
either the reset button is used or the system is restarted.

NOTE: The Package ID is a sequence number assigned to the package by the
SMIO. This is an option that is activated when setting the host message. For
details, see the Modify Setup / Communications tab in Chapter 3.
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DECODER STATUS

This segment of the System Status tab is used to monitor the status of the
decoder.

Decoder Status Window Segment

Belt Speed (fpm)

The decoder belt speed should be nearly equal to the camera belt speed shown in
SMIO Status. The decoder belt speed is defined by the decoder’s sampling
density (i.e.: the number of scan lines per inch of belt travel and the scan line
frequency). If the SMIO and Decoder belt speeds are not comparable, it may
require an adjustment to the belt speed from the SMIO.

Line Rate

Shows the number of scan lines the decoder collects each second.

Read Rate (%)

Defines the percentage of total packages that had all valid read fields transmitted
in host message. This is calculated when the No Read Count is subtracted from
the Total Package Count.

NOTE: In an image-only application where a decoder is not used, the Decoder
Status segment of the System Status tab will not be active.

NOTE: A belt should be continuously moving during normal operations, preferably
at the correct speed, to assure optimal system performance. It is recommended
that a belt never be stopped when packages are present in the scan area.
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Decoder Mode

Defines the decoder is functioning in either Framed, Standby or SDFS Error
mode.

Decoder Mode Description
Framed This is the normal tracking mode. The decoder is looking at

sections of the conveyor where packages exist.
Standby Identifies when the decoder is stopped externally through a

software command or through AVCore’s interface.
SDFS Error Identifies when the decoder is not running due to an error condition.

The decoder needs to be restarted.

SMIO Link

This SMIO status indicator is used to identify the following conditions.

Status Indicator Description
Green Connections are correct and operating properly (GO or OK

status).
Yellow A connection problem is causing an interruption of power or

communications.
Red Connection between Accu-Setup and the camera has been lost

(No Go, disconnected, or error status).

Decoder Running

This decoder status indicator is used to identify the following conditions.

Status Indicator Description
Green Connections are correct and operating properly (GO or OK

status).
Yellow A connection problem is causing an interruption of power or

communications.
Red Connection between Accu-Setup and the camera has been lost

(No Go, disconnected, or error status).

Mult Read

Identifies the number of packages that had at least one multiple field in the host
message. This number cannot be higher than the total number of packages.

Elapsed Time

Shows number of milliseconds since AVCore initialized. Under normal
operation, this should be close to the SMIO elapsed time.

No Read Count

Shows the number of packages that had all no-read fields in the host message.
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Total Package Count

This count is the total number of packages detected since the values were last
cleared. To clear all counts, click on Reset Decoder Counts button. The counts
are also cleared whenever the system is restarted.

Total Error Count

This count is the total number of tracking errors since the last time the system
was either initialized or reset. Tracking errors could be caused by:

•  The decoder service cannot start a new decode frame, possibly
because the previous frame was not ended.

•  The tracker service cannot add the new package to the package table
•  The decode service cannot end a frame, possibly because it was never

started.

Current Scan Line

Displays the absolute scan line count (via 64-bit counter) since the system
initialized.

Current Package ID

Identifies the current package being detected. The system keeps data on the last
16 packages processed. ID numbers are between zero and 15.

Reset Decoder Counts

Click the Reset Decoder Counts button to reset the following counts to zero:
Read Rate, Mult Read, No Read Count, Total Package Count, Total Error Count,
and Current Package ID.

NOTE: The Package ID is a sequence number assigned to the package by the
SMIO. This is an option that is activated when setting the host message. For
details, see the Modify Setup / Communications tab in Chapter 3.
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SMIO COM TAB

The SMIO Com Tab is used to test all system communication to assure
everything is working correctly. The SMIO Com tab also displays a running
count of various messages received and transmitted by the host, decoder, and
illumination devices.

Diagnostics and Utilities – SMIO Com Tab
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SEND TEST MESSAGE

This feature is used to send test messages to the selected communication ports.
The ports available are the Host, Com, and Illum.

Send Test Message Window Segment

To send a test message:

Step 1: Select the port to which you want to send the test message. A checkmark
appears in the box when this function has been enabled.

Step 2: Type the desired test message in the message field. You may enter only
printable ASCII characters in the message field.

Step 3: Click the Send button to send the test message out of all of the enabled
ports.

The message is sent only when the Send button is clicked and only to those ports
that are selected as indicated by a checkmark in the box.

The test messages you send are restricted to printable ASCII characters. Non-
printable ASCII characters will not be sent. The field only accepts printable
characters. Also, the message is framed using the protocol of that port.

For example if you enter the characters ABCDEFG and select to send it out the
Host port, and the Header and Trailer have been set to <STX> and <ETX> in
Modify Setup / Communications tab, the output is going to be
<STX>ABCDEFG<ETX>.

NOTE: See Appendix C: ASCII Character Chart in Chapter 6 of this manual.
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COUNTERS

Counters run for the three SMIO com ports: Host, Com, and Illum.

Counters Window Segment

The counts shown are raw counts for the port regardless of the connection and
regardless of the type of system.

Counters run up to 9999 and then stop incrementing until reset using the Reset
Counts button.

Rx Messages

Counts the number of messages with valid header and trailer data received on the
port.

Tx Messages

Counts the number of messages transmitted on the port.

Framing Errors

Counts the number of messages received with an invalid header and/or trailer.

Rx Overflow Errors

Displays the number of times the receive buffer overflowed. If this occurs, data
could be lost.

Tx Overflow Errors

Shows the number of times the transmit buffer could not be emptied fast enough.

Reset Counts Button

Click this button to reset all of the counters for the Host, Com, and Illum ports.
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DECODER MONITOR TAB

The Decoder Monitor tab is used to view the various images and messages
based on unrestricted or conditional actions as defined and enabled in the Modify
Setup / Decoder Diag and Pkg Mgt Diag tabs.

WARNING: The Decoder Monitor Tab functions are intended for use by Accu-
Sort trained and authorized technicians only. These actions should be enabled for
diagnostic purposes only. They should not be left enabled after diagnostics are
completed because they will dramatically affect decoder performance.

Diagnostics and Utilities – Decoder Monitor Tab
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UNRESTRICTED ACTION

Display Tracker Messages In Accu-Setup

When this unrestricted action is enabled, the Tracking Service sends tracking
messages to Accu-Setup’s Rolling Text window. If AVCore is not successful
sending data to Accu-Setup three consecutive times, it will no longer attempt to
do so until the next time AVCore reads the registry.

Display Box Image In Accu-Setup

When this unrestricted action is enabled, the Tracking Service will send a box
image to Accu-Setup’s Image Edit window. If AVCore is not successful sending
data to Accu-Setup three consecutive times, it will no longer attempt to do so
until the next time AVCore reads the registry.

Display Decode Messages In Accu-Setup

When this unrestricted action is enabled, the decoder will send all decoded
messages to Accu-Setup’s Rolling Text window. If AVCore is not successful
sending data to this address three consecutive times, it will no longer attempt to
do so until the next time AVCore reads the registry.
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CONDITIONAL ACTION

Display Decode Image in Accu-Setup

When this conditional action is enabled, the decoder will display any decode
image in the Image Edit window based on the Decoder Conditions in the
Modify Setup / Decoder Diag tab. Below is an example Image Edit window
when Display Decode Image is enabled.

Example Image Edit Window – Display Decode Image

Display Transmit Point Image In Accu-Setup

When this conditional action is enabled, the decoder will display any transmit
point image in the Image Edit window based on the Tracking Conditions in the
Modify Setup / Pkg Mgmt Diag tab. Below is an example Image Edit window
when Display Transmit Point Image is enabled.

Example Image Edit Window – Display Transmit Point Image
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Display Conditions Button

When you click the Display Conditions button, the Decoder / Tracking
Conditions window is displayed.

Decoder / Tracking Conditions Window

All of the conditions shown in the fields of this window determine when a
Decode Image or Transmit Point Image will be displayed in the Image Edit
window of the Decoder Monitor.

NOTE: Conditions may only be viewed in the Decoder / Tracking Conditions
window. To make any changes to the Do Action list, use the appropriate Modify
Setup tab. See the Modify Setup / Decoder Diag tab for details on setting
Decoder Conditions. See Modify Setup / Pkg Mgmt Diag tab for details on
setting Tracking Conditions. (For details, reference Chapter 3.)

Apply Actions Button

Any unrestricted actions or conditional actions that are enabled will take affect
when the Apply Action button is clicked. The Apply Actions button is disabled
if no action checkboxes are checked. Once a checkbox is checked, the Apply
Actions button is enabled.

ROLLING TEXT WINDOW

The Rolling Text window displays the decode messages and tracker messages
received from AVCore based on the unrestricted and/or conditional actions that
have been enabled.
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Example Rolling Text Window

The Decode Messages that appear in the Rolling Text window include the
individual bar codes that are found on the package. These decode messages
contain the type of bar code and the bar code data.

The Tracker Messages that appear in the Rolling Text window include the
decode message sent to the SMIO. The SMIO passes this message through to the
customer’s proprietary bar code system. The decode message can be a string of
bar code data or an informative message such as NOREAD. For instance, if there
were two bar codes on a box and only one was read the string might look
something like: 21349873450128463829292333,NOREAD.

IMAGE EDIT WINDOW

The Image Edit window on the Decoder Monitor tab displays the box images
and transmit point images based on the unrestricted and/or conditional actions
that have been enabled.

Example Image Edit Window
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TRIGGER DIAGNOSTICS TAB

The Trigger Diagnostics Tab shows the current settings and activity of the
system trigger devices.

Diagnostics and Utilities – Trigger Tab
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LIGHT CURTAIN

This section of the Trigger Tab diagnostics is used to monitor the operation of the
light curtain being used as the trigger device.

Current Char (hex)

Displays the raw light curtain ASCII character as received from the camera’s
FOCUS port.

Current Height (in)

Provides the converted height (in either inches/metric) of the light curtain
character shown in the Current Char (hex) field. The current height accounts
for the light curtain resolution and offset parameters as set via the Modify Setup
/ Trigger tab. (See Chapter 3.)

Package Present

This is a status indicator with two conditions: green or white.

Indicator Package Present Condition Status
Green SMIO believes there is a package present (i.e.: the signal from the light

curtain is active for the minimum time limit).
White No package is present.

Glitches

Displays the number of times that a height received from the light curtain
fluctuated too greatly. For example, three consecutive light curtain samples of
five inches, 29 inches, and five inches are considered a glitch because the middle
sample varied greatly from the first and last.

Rcv Timeout Errors

Indicates the number of times an error occurred because there was a 100
millisecond period when no characters were received from the light curtain.

NOTE: If the Photoeye Trigger Mode is used, the Light Curtain trigger
diagnostics will not be active. The Trigger Mode is set using the Modify Setup /
Trigger tab. (For details, see Chapter 3.)

NOTE: See Appendix C: ASCII Character Chart provided in Chapter 6 of this
manual.
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PHOTOEYE

This section of the Trigger Tab diagnostics is used to monitor the operation of
the photoeye being used as the trigger device.

Input State at Connector

Reports if the incoming photoeye signal is LOW or HIGH.

Input State Indicates
LOW
HIGH

Indicates whether or not the photoeye is active (i.e.: blocked by the
presence of a package) based on the Modify Setup / Trigger tab photoeye
settings. If the Active Low checkbox is enabled, the photoeye is active
when the input state is LOW.

Package Present

This is a status indicator with two conditions: Green or white.

Indicator Package Present Condition Status
Green SMIO believes there is a package present (i.e.: the signal from the

phototeye is active for the minimum time limit).
White No package is present.

Glitches

Displays the number of times the photoeye changed to a new state and stays in
that state for less than the debounce period and then returns to the previous state.
The debounce period is set using the Modify Setup / Trigger Tab. (See
Chapter 3 for details.)

TACH ENCODER

This section of the Trigger Tab diagnostics is used to monitor the operation of the
tach encoder being used to define the speed of package travel.

Tach Count

Defines the total tach count (i.e.: the number of pulses received from the
tachometer per minute). It is used to indicate that the belt is moving. The tach
count shown in this field continues until either the counter rolls over or the
system is restarted, at which point the count begins from zero. Because the tach
count and camera resolution are closely associated with each other, if you notice
a change in camera performance, it may be as a result of changes in the
tachometer. (The Tach Count on the Diagnostics and Utilities / Trigger and
System Status windows should be the same or very close.)

NOTE: If the Light Curtain Trigger Mode is used, the Photoeye trigger
diagnostics will not be active. The Trigger Mode is set using the Modify Setup /
Trigger tab. (For details, see Chapter 3.)
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Belt Speed (fpm)

Displays the current belt speed.

NOTE: All of the belt speed information shown in the Tach Encoder segment of
the Diagnostics and Utilities / Trigger Tab is in either feet per minute or the
metric equivalent depending on the setting selected in the Options drop-down
menu. (Reference Options Menu in Chapter 5 for details.)

Min Belt Speed (fpm)

Displays the slowest belt speed in the last 30 seconds or since the last time the
Reset Counts button was used.

Max Belt Speed (fpm)

Displays the fastest belt speed in the last 30 seconds or since the last time the
Reset Counts button was used.

Deviation

Displays the averaged change in belt speed per second over a 30 second interval.
Large deviation values could indicate inconsistent belt speed or a faulty
tachometer.

PACKAGE ERRORS

Too Long

Displays the number of times a package greater than the maximum package
length setting was detected. This value is defined on the Modify Setup / Trigger
tab. (See Chapter 3 for details.)

Too Short

Displays the number of times a package less than 4.0 inches long was detected.

Too Close

Displays the number of times the distance between packages was less than 2.0
inches.

Reset Counts Button

Click this button to reset all of the error counters for the Diagnostics and
Utilities / Trigger tab.
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IMAGING DIAGNOSTICS TAB

The Imaging Diagnostics Tab is used to manually adjust camera parameters.
This makes it possible to temporarily test the effects of changes to camera
imaging before making them and putting them to use during normal operations.
Changes made in this window are only temporary: The camera is returned to the
previously stored settings when you select another tab or exit this window.

Diagnostics and Utilities – Imaging Diagnostics Tab

NOTE: If Accu-Setup is not connected to a camera, the following message is
displayed when any of the checkbox fields are enabled:
               There is no communication link. Cannot send command.
Use the Establish Connection button to connect to a camera before attempting
to use the Manual Controls.

To make changes to camera imaging for use during normal operation, use the
Modify Setup / Imaging Tab.
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MANUAL CONTROL

Allows the user to manually set some of the camera parameters. These manual
changes are for diagnostic purposes only and do not change the configuration of
the camera. To change the configuration of the camera, see the Modify Setup /
Imaging Tab.

Manual Control Window Segment

Manual Focus

To set this value, click in the box to activate the parameter. Use the slider bar or
arrows to set the Focus Height value from 0.00 to 36.00. The value for a
camera’s focus is referenced from its far working distance and represents the
package height.

Manual Gain

To set this value, click in the box to activate the parameter. Use the slider bar or
arrows to set the Gain Value from zero to 255. The value for gain is an increase
or decrease in the amount of light reflected off a package surface.

Manual Frequency

To set this value, click in the box to activate the parameter. Use the slider bar or
arrows to set the Scan Line Frequency value from zero to 20,000.  The value for
this frequency represents the scan line frequency.

NOTE: If you set this above the Scan Line Frequency defined for the camera, it
will default to the frequency shown at the About Camera Head window. (See the
About Camera Head selection in the Help Drop-down Menu located at the top
of the Accu-Setup Main Window. Reference Chapter 5 for details.)
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AV Scope

Click the AV Scope button to display the Scope view window. By monitoring
the scope view while making manual adjustments to focus, gain, and frequency,
you can check the effect these adjustments have on camera performance.

NOTE: Based on the information gathered while using AVScope, camera imaging
can then be setup for optimal performance when operational adjustments are
made in the Modify Setup / Imaging Tab. (Reference Chapter 3 for details.)

In the following example screen of the AV Scope view window:

•  The X-axis shows all of the pixels the camera offers. This axis changes
depending on the camera model used in the system.

•  The Y-axis shows the brightness of each pixel.
•  This also shows a graphic representation of the image at the scan line.

Scope View

Data

The Data drop-down menu on the Scope View window allows the user to: Save
Data to Disk, Load Data from Disk, or Copy Image to the Windows Clipboard.

Data Menu Selection Description
Save Data to Disk Saves a scalable .wmf file to a user-designated location.

Load Data from Disk Retrieves a scalable .wmf file from a user-designated
location.

Copy Image to Clipboard Copies the image displayed in the scope view to the
Windows OS clipboard for use in another application.

To clear the image and reset the AVScope, simply close the AVScope window.
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View

The View drop-down menu on the Scope View window allows the user to:
Change Start of Display, Change End of Display, Display All, and Show Current
Pixel Value.

View Menu Selection Description
Change Start of Display Enables you to narrow the scope view to a discrete set

of camera pixels. Used in combination with Change End
of Display.

Change End of Display Enables you to narrow the scope view to a discrete set
of camera pixels. Used in combination with Change
Start of Display.

Display All Resets the scope view to show all of the available
camera pixels.

Show Current Pixel Value This function places data on the window in the format
(pixel #, value).

To Change Start of Display and Change End of Display

These two selections from the View drop-down menu work together to narrow
the scope view. To change the start and end of display:

Step 1: Choose Start of Display from the View drop-down menu.
Step 2: Use the mouse to position the cursor where you would like to set the start
of display, then double-click the left mouse button to place the line.
Step 3: You may double-click the right mouse button to turn the start of display
line off and not set the line.
Step 4: Choose End of Display from the View drop-down menu.
Step 5: Use the mouse to position the cursor where you would like to set the end
of display, then double-click the left mouse button to place the line.
Step 6: You may double-click the right mouse button to turn the end of display
line off and not set the line.
Step 7: Once the start of display and end of display lines are placed, the Scope
View window will adjust accordingly.

Display All

When this function of the View drop-down menu is selected, any adjustment of
the Start of Display and End of Display to narrow the scope view is eliminated
and the entire scope view is displayed.

To Show Current Pixel Value

As you move the mouse around the Scope View, the pixel values change
accordingly. It provides additional, precise data of the pixel values. This is a
toggle setting. Select it once to turn it on, select it again to turn it off.

ERROR COUNTS

There are four error counters associated with the camera imaging manual
controls. As you test the manual adjustment of the focus, gain, and scan line
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frequency, monitoring these counts will assist you in the diagnostic process to
fine-tune any adjustments before making any changes.

Error Counts Window Segment

Focus Faults

Identifies the number of times the camera did not focus properly.

Clipped Focus

Shows the number of times the focus height exceeded the bounds set in the focus
table (or fixed focus in the Modify Setup / Imaging Tab).

NOTE: If fixed focus is used, problems with clipped focus may be tested with the
Manual Control in the Diagnostics and Utilities / Imaging Tab and then
corrected in the Modify Setup / Imaging Tab. (See Chapter 3.) You can Modify
Focus Table from the Utilities drop-down menu. (See Chapter 5.)

Clipped Gain

Displays the number of times the gain setting exceeded the bounds set in the gain
table (or fixed gain in the Modify Setup / Imaging Tab).

NOTE: If fixed gain is used, problems with clipped gain may be tested with the
Manual Control in the Diagnostics and Utilities / Imaging Tab and then
corrected in the Modify Setup / Imaging Tab. (See Chapter 3.) You can Modify
Gain Table from the Utilities drop-down menu. (See Chapter 5.)

Clipped Scan Line Clk

Counts the number of times the required scan line clock frequency exceeded the
limits of the CCD sensor. (To adjust the Scan Line Clock, select the Imaging
Tab found in Modify Setup. See Chapter 3.)

Reset Counts

Click this button to reset all error count fields to zero.
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LOGGING DIAGNOSTICS TAB

The Logging Diagnostics Tab enables you to view the various SMIO and
decoder log files that have been enabled using the Modify Setup / Logging Tab.
(See Chapter 3.)

WARNING: The Logging Tab functions are intended for use by Accu-Sort
trained and authorized technicians only. These logs are for diagnostic purposes
only. They should not be left enabled after diagnostics are completed because
they will dramatically affect decoder performance.

Diagnostics and Utilities – Logging Diagnostics Tab

Displaying log files can degrade system performance. If you chose to view a log
file, the following warning message appears before any log files are displayed.
The user has the opportunity to not display the log and maintain system
performance.

Log Display Warning Message

Click No to clear the screen and maintain system performance.
Click Yes to display the selected log file or no to clear the screen.
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SMIO LOGGING

View SMIO Log File

Click the View SMIO Log File button to view the SMIO log file. Before the log
file is displayed the warning (shown on the previous page) is displayed. The
SMIO log file is limited to the last 32 events.

Example SMIO Log File Screen

NOTE: If Accu-Setup is not connected to a camera, the following message is
displayed (after the warning message shown on the previous page):
               There is no communication link. Cannot send command.
The smiotemp.log displays the text: Error: Could not get data from the SMIO.
Use the Establish Connection button to connect to a camera before attempting
to View SMIO Log FIle.

DECODER LOGGING

Decoder Log Files

There are four types of decoder log files: Decoder, Tracking, Configuration, and
System. To view a selected log file, the file must first be enabled by placing a
checkmark in the checkbox. Click on the View Selected Log Files button to
view the files.

WARNING: The Decoder Log File can become rather large and will therefore
affect system performance. This file is intended for diagnostic purposes only and
should be disabled during normal system operation.
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PACKAGE HISTORY TAB

The Package History Tab is used to view the details about the last 16 packages.
The Package History information is defined and enabled via the Modify Setup /
Pkg Mgmt Diag Tab. (See Chapter 3.)

Diagnostics and Utilities – Package History Tab

VIEW PACKAGE

The view package list displays the ID numbers of the last 16 packages the system
has processed. The top of the list is the most recent package.

•  Click on a package ID number in the View Package field to display SMIO
Package Data.

•  Double-click the package ID to view the captured image for the package in
the Package Image Screen.

•  Enable specific details about the package data in the check boxes on the
bottom right-hand of the window (e.g.: Box Height, Focus Height, Gain, and
DPI).
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CHANGE IMAGE CAPTURE MODE

Click the Change Image Capture Mode button to begin capturing images from
the camera. The camera will not capture images until this button is clicked and an
Image Capture Mode is enabled (e.g.: either Start of Box to Tx Point or Start of
Box to End of Box).

SMIO PACKAGE DATA

Use the series of four check boxes in the lower right corner of the Package
History Tab to display data about a selected package. The colored lines next to
the check boxes indicate the color of the line shown in the corresponding SMIO
Package Data graph.

Line Color Description
Blue Box Height – The height measurement of the package being scanned.
Green Focus Height – Where the camera is focusing as it scans the package.
Orange Gain – The gain value of the package surface.
Yellow DPI – The resolution (Dots Per Inch) of the scanned image.

SMIO Package Data – Only Box Height Enabled

In the first example of the SMIO Package Data graph (shown above), only the
box height is enabled. From the graph, it can be determined that the box height
was approximately 10 inches and the length was 14 inches.

NOTE: If all of the boxes are checked and one of the lines does not appear to be
visible, it is most likely hidden behind another. Try turning some of the data off to
see if the line appears.
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SMIO Package Data – Box Height and Focus Height Enabled

In the next example, the box height and focus height are enabled. From the
graph, it can be determined that the box height was approximately 10 inches and
the length was 14 inches.

SMIO Package Data – Box Height and Gain Enabled

In another example, the box height and gain are enabled. From the graph, it can
be determined that the box height was approximately 10 inches and the length
was 14 inches. The gain value of the package surface was a consistent 67.0.
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SMIO Package Data – Box Height and DPI Enabled

In this example above, the box height and DPI are enabled. From the graph, it
can be determined that the box height was approximately 10 inches and the
length was 14 inches. The DPI line shows as 203.3 at 36 inches.

SMIO Package Data – Box Height, Focus Height, Gain and DPI Enabled

In the next example, the box height, focus height, gain, and DPI are enabled.
From the graph, it can be determined that the box height was approximately 10
inches and the length was four inches. The focus height and gain are hidden
behind the DPI line that shows as 203.3.



ACCU-SETUP FOR ACCUVISION SOFTWARE MANUAL   VERSION 4.0 4-33

Solutions with vision.

SMIO Package Data – Box Height, Focus Height, Gain and DPI Enabled

In the final example above, the box height, focus height, gain, and DPI are
enabled. From the graph, it can be determined that the box height was
approximately 10 inches and the length was under 13 inches. The focus height
shows at about 34 inches, and the gain and DPI line (which shows as 203.3)
practically overlap.

Image Capture Mode

This feature can be Disabled, or set to capture images from Start of Box to Tx
Point, or Start of Box to End of Box. The capture mode determines the size of the
image the system will collect.

Image Capture Mode Description
Disabled No images will be captured. Image Capture Mode

should be left disabled during normal system
operations.

Start of Box to Tx Point This image is typically a smaller image than Start of
Box to End of Box.

Start of Box to End of Box This image is typically a larger image than Start of Box
to Tx Point.

(***example screen shot here***)

Example Image Capture – Start of Box to Tx Point
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(***screen shot here***)

Example Image Capture – Start of Box to End of Box

The system then applies four color-coded lines to the image as shown in the
Package Image Screen.

Line Color Description
Green Identifies the start of package.
Red Identifies the end of package.
Blue Indicates a request from AVCore to the decoder for decode results
White Indicates transmit point of data from AVCore to the host.

See Package Image Screen for more details. (The Package Image screen and
Image Edit window found in Diagnostics and Utilities / Decoder Monitor
provide the same image data.

Package ID

Displays the package identification number for the package selected from the
View Package part of the window.

Belt Speed

Shows the average belt speed for the selected package ID.
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PACKAGE IMAGE SCREEN

To see an image of a particular package captured by the camera, double-click the
package ID number in View Package list. If an Image Capture Mode was
enabled, the Package Image Screen opens and the package image is displayed.

Package Image Screen

The system then applies four colored lines to the image:

Line Color Description
Green Start Box - Identifies the start of package.
Red End Box - Identifies the end of package.
Blue Decode Issue - Indicates a request from AVCore to the decoder for decode

results.
White Transmit Point - Indicates transmit point of data from AVCore to the host.
Blue Dot Decoded – Indicates that the bar code identified by the dot has been decoded.
Red Dot Not Decoded – Indicates that the bar code identified by the dot has not been

decoded.
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OUTPUTS DIAGNOSTICS TAB

The Outputs Diagnostics Tab is used to monitor the activity of the optional
digital outputs. Their parameters are set using the Modify Setup / Outputs Tab.
(See Chapter 3 for details.)

Diagnostics and Utilities – Outputs Diagnostics Tab

The system digital outputs are polled every 200 milliseconds and their activity is
shown on this window. If an output is gray on this window, it was disabled in
Modify Setup. (See the Modify Setup / Outputs Tab section of this manual.)
The status indicators have three possible states:

Status Indicator Description
White Output is not being used.
Green Output is not enabled (open).
Red Output is enabled (closed).

When a digital output is enabled, it is activated for the time period set in the
Modify Setup / Outputs Tab: This can be tested by clicking on the appropriate
Activate Digital Output button. If a digital output is not used, the indicator is
white, and the activate button for that output indicates Out # Not Active.
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CHAPTER 5: DROP-DOWN MENUS

The Drop-down Menus located across the top of the Accu-Setup Main
Window provide you with access to all of the button menu functions and a
number of additional features.

Accu-Setup Drop-down Menu Selections

Drop-down Menus Description

File Offers a series of options including: Compare, Retrieve From
Camera, Retrieve From Disk, Save To Camera, Save To Disk,
and Exit. Most of these functions are also available from the
Button Menu.

Edit Provides the option to save or restore a backup of the
parameters by using either Create Backup File or Recover
From Backup File. The Modify Setup functions (also available
from the Button Menu) can also be accessed from the Edit
Menu.

Options Offers four options: Auto Backup, Auto Retrieve, Display
Values in US Format, and Display Values in Metric Format.

Utilities Offers eight utilities: Recover from Backup File, View Changes,
Diagnostics and Utilities, Modify Gain Table, Modify Focus
Table, Modify Camera Name and Serial Number, Smart
Illumination Setup and Diagnostics, Reboot Decoder. The
Diagnostics and Utilities are also available from the Button
Menu.

Help This menu provides access to Accu-Setup online help through
the Contents and Search functions. In addition, four functions
enable you to get additional information: About Accu-Setup,
About Camera, About Camera Head, and a Compatibility List.

USEFUL TIP: You will note that the names of every drop-down menu and menu
option contain one underlined character. You can use these characters to access
the menus and menu options. For example: Pressing the <Alt><F> keys will open
the File Drop-down Menu.
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FILE MENU

The File drop-down menu offers the following options:

File Drop-down Menu

(The Retrieve, Save, and Exit functions can also be accessed using the Accu-
Setup Main Window / Button Menu.)

File Menu Selections Description
Compare Use to compare two sets of parameters, either camera-with-

file or file-to-file.
Retrieve from Camera Retrieves the parameters from a camera.
Retrieve from Disk Retrieves a file of parameters stored on disk.
Save to Camera Use to upload parameters to a camera.
Save to Disk Use to save parameters to a file on disk.
Exit After saving any needed changes to camera and/or disk and

releasing the connection to camera, use this selection to
exit Accu-Setup.

USEFUL TIP: The File drop-down menu options are only accessible if
communications have been established with a camera. The Communication Log
in the Accu-Setup Main Window shows the condition of the communication link.

COMPARE

This function enables you to compare two different sets of parameters in order to
determine which set offers optimal system performance or to make changes to
improve system performance, if necessary.

Comparison can be made between two files saved to disk (File to File) or
between a file saved to disk and the camera parameters running on a camera
connected to Accu-Setup (Camera with File). The parameters are compared in
the View Differences window.
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Compare Camera with File

To compare camera parameters to a file:

Step 1: Be sure a connection has been established with the camera.

NOTE: If you attempt to use this function before a camera connection is
established, Accu-Setup will display the message:
Connect to a camera before comparing parameter values.
Use the Establish Connection button on the Button Menu of Accu-Setup.

Step 2: Select Compare from the File Drop-down Menu, then choose the
Camera with File option, or press <Alt><F> and <Alt><C> and <Alt><C>.
The File 1 window opens. (This window automatically opens to the Values
folder.)

NOTE: If you have stored the .VAL file in a location other than the Values folder,
you will need to go to that directory to open the desired .VAL file. However, since
the system automatically opens to the Values folder, it is recommended that you
save any .VAL files in that folder so they may be easily found.

Compare Camera with File – File 1 Window, Defaults to Values Folder

Step 3: Select a .VAL file by highlighting it and then click Open to display the
file in the View Differences window.

In the following examples of the View Differences window, notice how the
various parameter names are listed along the left side of the window, followed by
the .VAL file settings. Note that the camera settings are on the right side and can
easily be compared to the .VAL file that was opened.

Since all of the parameters cannot be displayed on a single screen, use the
vertical scroll bar to view the remaining parameters as illustrated by Compare
Camera with File – View Differences, Part 1 and Compare Camera with File –
View Differences, Part 2.
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The horizontal scroll bar at the bottom of the screen can be used to view the
camera parameters that cannot be fully displayed on the screen.

Compare Camera with File – View Differences, Part 1

Compare Camera with File – View Differences, Part 2

Step 4: When you are finished comparing the camera to file parameters, click the
OK button to close the View Differences window.
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Compare File to File

To compare a setup parameters file to another file:
Step 1: Select Compare from the File Drop-down Menu, then choose the File
to File option, or press <Alt><F> and <Alt><C> and <Alt><F>. The File 1
window opens. (This window automatically opens to the Values folder.)

NOTE: If you have stored the .VAL file in a location other than the Values folder,
you will need to go to that directory to open the desired .VAL file. However, since
the system automatically opens to the Values folder, it is recommended that you
save any .VAL files in that folder so they may be easily found.

Compare File to File – File 1 Window

Step 2: Select a .VAL file by highlighting it and then click Open to display the
File 2 window.

Compare File to File – File 2 Window

Step 3: When the File 2 window opens, select another .VAL file and then click
Open to display the View Differences window.
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In the following examples of the View Differences window, notice how the
various parameter names are listed along the left side of the window, followed by
the .VAL file settings. Note that the second .VAL file settings are on the right
side and can easily be compared to the first .VAL file that was opened.

Since all of the parameters cannot be displayed on a single screen, use the
vertical scroll bar to view the remaining parameters as illustrated by Compare
File to File – View Differences, Part 1 and Compare File to File – View
Differences, Part 2.

Compare File to File – View Differences, Part 1

Compare File to File – View Differences, Part 2

Step 4: When you are finished comparing the parameters of the two .VAL files,
click the OK button to close the View Differences window.
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RETRIEVE FROM CAMERA

Selecting the Retrieve from Camera function retrieves current parameters from
the camera with which Accu-Setup has established communications. (This
function also found in the Button menu.)

IMPORTANT: The Retrieve from Camera option is only accessible if a
communication link has been established with the camera. The Communication
Log field shows the condition of the communication link.

To retrieve setup parameters from the camera:

Step 1: Select Retrieve from Camera from the File drop-down menu or press
<Alt><F> and <Alt><R>.

Step 2: Accu-Setup sends a message requesting the camera’s current settings.
While the parameters are being retrieved from the camera, the following
messages are displayed along with the percentage of the parameters retrieved:

Retrieve SMIO Parameters
Retrieve Decoder Parameters

Step 3: Once all parameters are retrieved from the camera, the Retrieve
Parameters window is opened and a message is displayed indicating Accu-Setup
has been automatically updated to match the camera settings.

Retrieve Parameters Window

It is recommended that both the original settings and any changes be stored to a
disk file in case you need to return the camera to a previous configuration. (See
Save to Disk on page 5-11.)
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RETRIEVE FROM DISK

Selecting the Retrieve from Disk function enables you to restore camera settings
from a disk file that contains a copy of previously stored camera parameters.
(This function also found in the Button menu.)

To retrieve setup parameters from disk:

Step 1: Select the Retrieve from Disk function from the File drop-down menu
or press <Alt><F> and <Alt><E>. This opens a standard Windows Open file
window.

Open File Window

Step 2: Locate the Values folder where the parameters are stored. (The Open file
window should automatically default to the Values folder.)

Step 3: Click on the appropriate *.VAL file name.

Step 4: Click Open or press the <Alt><O> key.

Once parameters are retrieved, Accu-Setup is automatically updated to match the
retrieved settings. To update the camera with the file you have retrieved, use the
Save to Camera button. (See Save to Camera on page 5-10 for details.)

Parameters can be retrieved from disk only after they have been saved to disk. It
is recommended that any changes be stored to a disk file, in case you need to
return a camera to a previous configuration. (See Save to Disk for details.) The
parameters are stored in files with a *.VAL extension.

IMPORTANT TIP: It is good practice to store any *.VAL files in the Values folder
of the Accu-Setup directory so that they can be easily located.
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SAVE TO CAMERA

Select the Save to Camera option of the File Drop-down menu when you need
to:

•  send all Modify Setup parameters to the camera,
•  send only the changes you have made to the parameters, or to
•  send parameters to the camera that you have retrieved using the Retrieve

from Disk function.

(This function is also found in the Button Menu of Accu-Setup.)

NOTE: This option is only accessible if a communication link has been
established with the camera. The Communication Log in the Accu-Setup Main
Window shows the condition of the communication link.

To save setup parameters to the camera:
Step 1: Select Save to Camera from the File drop-down menu or press
<Alt><F> and <Alt><S>. The Send Parameters screen is displayed.

Send Parameters Window

Send Functions Description
Send Setup Parameters Sends all of the current settings and any changes to the camera,

unless Send Changes Only is enabled. Once saved to camera, the
settings will not be lost if the camera loses power.

Send Changes Only When a check appears in this box, only the parameters that have been
changed will be sent to the camera.

Close Use to close the Send Parameters screen.

Step 2: Determine whether you wish to send all parameters or only the changes
to the camera. If you wish to send only changes, then be sure that the Send
Changes Only box is checked, otherwise leave the box empty to send all
parameters to the camera.
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Step 3: Click on the Send Setup Parameters button. Once the parameters are
received successfully by the camera, the following message appears in the
Communication Log:

All Parameters were successfully sent.

Step 4: Click on the Close button to close the Send Parameters window.

NOTE: To close Send Parameters window without sending the parameters,
simply click on the Close button without using the Send Setup Parameters
button.

SAVE TO DISK

To specify a file name and location to store the current settings contained in
Accu-Setup, select the Save to Disk option of the File Drop-down menu. (This
function is also found on the Button Menu of Accu-Setup.)

To save setup parameters to disk:
Step 1: Selecting the Save to Disk function from the File drop-down menu or
press <Alt><F> and <Alt><A>. This opens a standard Windows Save As file
window.

Save to Disk Window

Step 2: Locate the Values folder where the parameters are stored. (The Save As
window should automatically default to the Values folder.)

Step 3: Enter a name for the file in the File name field. The .VAL extension will
be added to the name when you save the file to disk.

Step 4: Click Save or press the <Alt><S> keys. When this operation is
successfully completed, the following message appears in the Communications
Log:

Parameters saved to disk.
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If you have not already done so, be sure to update the camera with the file you
have saved, using the Save to Camera button. (See Save to Camera on page 5-
10 for details.)

It is recommended that the previous settings and any changes be stored in
separate files, in case it becomes necessary to return the camera to a previous
configuration. The default file extension for these files, as well as the default
folder and directory, is *.VAL.

IMPORTANT TIP: Parameters can be retrieved from disk only after they have
been saved to disk. It is recommended that any changes be stored to a disk file in
case you need to return a camera to a previous configuration. It is also a good
practice to store any *.VAL files in a Values folder of the Accu-Setup directory so
that they can easily be located.

EXIT

IMPORTANT TIP: It is recommended that you release the connection to camera
(by using the Release Connection button) before using the Exit function.

Use this option to exit Accu-Setup by going to the Exit selection in the File
Drop-down Menu or pressing <Alt><E>. If any changes made during the use of
Accu-Setup were not saved, the following window appears.

Click Yes or press <Alt><Y> to leave without saving changes.
Click No or press <Alt><N> to remain in Accu-Setup. You will still be able to
save changes before exiting Accu-Setup if you click No.

USEFUL TIP: Before you exit Accu-Setup, did you remember to:
1. Save any necessary changes to camera
2. Save a backup file of changes to disk
3. Release the connection to the camera
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EDIT MENU

The Edit drop-down menu provides the options for creating and recovering a
backup file of parameters and for modifying the parameters currently being used
by your AccuVision System.

Edit Drop-down Menu

Edit Menu Selections Description
Create Backup File Use to save parameters from a camera directly to a

backup file.

Recover From Backup File Restores a set of parameters from an existing backup
file.

Modify Setup Accesses the Modify Setup window providing 12 tabs
for setting or modifying the operating parameters. Also
available from the Button Menu. (See Chapter 3 of this
manual for details.)

CREATE BACKUP FILE

Select the Create Backup File option to save the parameters from the scanner
directly to a backup file. The fields in Accu-Setup will not change. The files are
automatically stored in the Accu-Setup Backup directory.

NOTE: Using the Create Backup File option will not overwrite any existing
backup file in the directory.

To create a backup file:
Step 1: Select Create Backup File from the Edit Drop-down Menu, or press
<Alt><E> and <Alt><C>.
Step 2: Accu-Setup creates a backup file and automatically names the file using a
numerical sequence: The eight-digit serial number of the camera, followed by a
three-digit extension that is a sequential number. For example: 12345678.001,
12345678.002, etc. where 12345678 is the camera serial number and 001 and
002 are the backup file sequence numbers.
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RECOVER FROM BACKUP FILE

Changes made to the parameters in Accu-Setup can be reset or recovered from an
existing backup file that was created using either the Edit Menu / Create
Backup File option or the Options Menu / Auto Backup option.

CAUTION: When parameters from a backup file are loaded into Accu-Setup, the
values update automatically to match the settings from that backup file. Be sure
you are recovering from the correct backup file to assure proper system operation.

To recover parameters from a backup file:
Step 1: Select Recover from Backup File from the Edit Drop-down Menu, or
press <Alt><E> and <Alt><R>. (This function is also available in the Utilities
Menu.) This causes the Recover from Backup File window to open.

Recover from Backup File Window

Step 2: Select a backup file that matches the camera serial number for which you
intend to recover the backup file. Click Open to load the parameters into Accu-
Setup.

NOTE: To recover from the most recent backup file for a particular camera, be
sure to refer to the date, time, serial number and sequence number of the most
recently saved file.

Step 3: Establish a connection with the appropriate camera. In applications using
more than one camera, match the camera serial number to the serial number used
in the name of the backup file.

Step 4: Use the Save to Camera function (found in the File Menu or on the
Button Menu) to send the backup file parameters to the camera. (See page 5-10.)
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MODIFY SETUP

This selection enables the user to edit all Accu-Setup parameters by opening the
Modify Setup Window. (The same functions can be accessed using the Modify
Setup button from the Accu-Setup Main Window Button Menu.) (For details,
reference the Modify Setup section of this manual in Chapter 3.)

Modify Setup Tabs Tab Descriptions
Symbologies Provides all settable bar code parameters including: the types of bar

codes your system will decode, the sequence in which they are sent to
the host, the minimum/maximum length, symbology options, postal
symbology options, and advanced decoder options.

Communications Used to define all communications parameters with the camera,
decoder, and host including the baud rate, parity, data bits, stop bits,
and format of messages sent to the host. Also provides settings for
advanced network communications (i.e.: IP address, gateway, and
netmask).

Trigger Defines all settings for the light curtain and/or photoeyes used to trigger
package detection including distance to scan line, maximum package
length, minimum package height, debounce, and advanced light curtain
settings. (See the Diagnostic and Utilities / Trigger tab in Chapter 4.)

Tracking Contains all settable parameters for monitoring package travel through
the system including tracking mode (leading, trailing, or immediate),
distance to transmit point, belt speed settings, and camera mounting.

Imaging Defines scanning parameters for the camera including focus, gain, and
scan line clock mode. (See the Diagnostic and Utilities / Imaging tab
in Chapter 4.)

Decoder Diag Used to enable or disable diagnostics related to the decoder including
unrestricted and conditional decoder action. (See the Diagnostic and
Utilities / Decoder Monitor tab in Chapter 4.)

Pkg Mgmt Diag Used to enable or disable diagnostics related to the management of
packages as they are tracked through the system including unrestricted
and conditional tracking action. (See the Diagnostic and Utilities /
Decoder Monitor tab in Chapter 4.)

Logging Used to enable or disable diagnostics logs related to the camera,
decoder, and other system components and functions. (See the
Diagnostic and Utilities / Logging tab in Chapter 4.)

Outputs Defines the condition to activate, the active time (msec), and output
signal of up to four optional digital outputs that may be used to control
external devices (e.g.: alarms, package diverters, etc.). (See the
Diagnostic and Utilities / Outputs tab in Chapter 4.)

Tunnel Provides settings for applications where camera(s) are used to read bar
codes on multiple sides of packages. The Tunnel tab is used to enable
or disable multi-sided imaging mode, tunnel focus mode, and also
identifies the active tunnel configuration.

Decoder
Display/Power Mgmt

Used to enable or disable the remote display of the APC100 decoder
and to protect the decoder in the event of a power failure or system
shutdown.

Dimensioning Provides access to the various dimensioning parameters that must be
defined for the optional VisionCube dimensioning software. The
Dimensioning Tab is disabled unless the VisionCube software is used
by your system.
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OPTIONS MENU

The Options drop-down menu offers the options for automatically backing up or
retrieving parameters as well as defining the measurement standard for your
AccuVision System.

Options Drop-down Menu

NOTE: Any of the selections available in the Option Menu that are preceded by a
checkmark have been enabled.

Options Menu Selections Descriptions
Auto Backup Use to automatically save a backup settings file every time

Accu-Setup is connected to a camera.

Auto Retrieve Use to automatically download settings from a camera
every time a camera is connected to Accu-Setup.

Display Values in US Format Use to show all Accu-Setup dimensional values in US
measurements (inches/feet).

Display Values in Metric Format Use to show all Accu-Setup dimensional values in metric
measurements (centimeters).
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AUTO BACKUP

Use Auto Backup function to automatically save a backup file of settings every
time Accu-Setup is connected to a camera. When this function is enabled, a
checkmark appears on the menu next to Auto Backup. The fields in Accu-Setup
will not change when Auto Backup is enabled. The files are automatically stored
in the Accu-Setup Backup directory.

NOTE: Using the Auto Backup function will not overwrite any existing backup file
in the Backup directory.

To enable the Auto Backup function:

Step 1: Select Auto Backup from the Options Drop-down Menu, or press
<Alt><O> and <Alt><B>. When enabled, a checkmark appears.

Step 2: When a camera connection is established, Accu-Setup automatically
creates a backup file. The file is named using a numerical sequence: The eight-
digit serial number of the camera, followed by a three-digit extension that is a
sequential number. For example: 12345678.001, 12345678.002, etc. where
12345678 is the camera serial number and 001 and 002 are the backup file
sequence numbers.

Step 3: To deactivate Auto Backup, click on the option to turn it off. The
checkmark is removed to indicate the function is disabled.

AUTO RETRIEVE

When the Auto Retrieve function is enabled, Accu-Setup automatically retrieves
a backup file of settings from the camera once a connection to a camera is
established.

NOTE: The retrieved parameters will be automatically backed up if the Auto
Backup function is also enabled.

To automatically retrieve parameters from a camera:

Step 1: Select Auto Retrieve from the Options Drop-down Menu, or press
<Alt><O> and <Alt><R>. When enabled, a checkmark appears.

Step 2: When a connection is established with a camera, Accu-Setup
automatically downloads the parameters of the camera.

Step 3: To deactivate Auto Retrieve, click on the option to turn it off. The
checkmark is removed to indicate the function is disabled.

NOTE: Both Auto Backup and Auto Retrieve are set as enabled when Accu-
Setup is initially installed. You can change these settings at any time. Once
changed, the revised settings remain in effect regardless of the number of times
you enter and exit Accu-Setup, until such time as the settings are changed again.
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DISPLAY VALUES IN US FORMAT

Use this function to display all dimensional camera settings in inches (US
format).

To Display Values in US Format:

Step 1: Select Display Values in US Format from the Options Drop-down
Menu. When enabled, a checkmark appears.

Step 2: All values in Accu-Setup will be shown in US Format. If the Display
Values in Metric Format is selected, the US Format is disabled and all values will
be converted automatically to their metric equivalent.

DISPLAY VALUES IN METRIC FORMAT

Use this function to display all dimensional camera settings in centimeters/meters
(Metric format).

To Display Values in Metric Format:

Step 1: Select Display Values in Metric Format from the Options Drop-down
Menu. When enabled, a checkmark appears.

Step 2: All values in Accu-Setup will be shown in Metric Format. If the Display
Values in US Format is selected, the Metric Format is disabled and all values will
be converted automatically to their US equivalent.

NOTE ON DIMENSIONAL REFERENCES: While this manual discusses all
dimensional values in US format, Accu-Setup can display these values in either
US or metric formats. A table that shows the settable parameters in both their US
and metric values is also provided in Chapter 6 / Appendix B.
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UTILITIES MENU

The Utilities drop-down menu provides several options for recovering camera
settings, modifying tables, diagnosing system operations, and monitoring the
status of the system.

Utilities Drop-down Menu

Utilities Menu Selections Descriptions
Recover from Backup File Use to restore parameters from a backup file.

View Changes Enables you to view the set of parameters currently in
Accu-Setup before you save any changes to either the
camera or disk.

Diagnostics and Utilities Accesses the Diagnostics and Utilities window
providing eight tabs for monitoring system performance
and troubleshooting various operating conditions. Also
available from the Button Menu. (See Chapter 4 of this
manual for details.)

Modify Gain Table Use to adjust the table that defines the gain levels of a
camera in order to achieve peak imaging performance.
(For ASI trained and authorized technician use only.)

Modify Focus Table Use to adjust the table that defines the camera focusing
in order to achieve peak imaging performance. (For ASI
trained and authorized technician use only.)

Modify Camera Name and
Serial Number

Enables you to display or modify the name and serial
number of the camera currently connected to Accu-
Setup.

Smart Illumination Setup
and Diagnostics

Enables you to check the setup and status of the
systems sodium illumination module(s) as well as
diagnose whether or not the illumination module is
operating properly. (Disabled for systems using LED
illumination modules.)

Reboot Decoder Use this function to reboot the APC100 Decoder.
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RECOVER FROM BACKUP FILE

The Recover from Backup File menu selection reads a computer file of all
parameters saved via Auto Backup (in the Options Menu) or Create Backup
File (in the Edit Menu.

CAUTION: When parameters from a backup file are loaded into Accu-Setup, the
values update automatically to match the settings from that backup file. Be sure
you are recovering from the correct backup file to assure proper system operation.

To recover parameters from a backup file:

Step 1: Select Recover from Backup File from the Utilities Drop-down Menu,
or press <Alt><U> and <Alt><R>. (This function is also available in the Edit
Menu.) This causes the Recover from Backup File window to open.

Recover from Backup File Window

Step 2: Select a backup file that matches the camera serial number for which you
intend to recover the backup file. Click Open to load the parameters into Accu-
Setup.

NOTE: To recover from the most recent backup file for a particular camera, be
sure to refer to the date, time, serial number and sequence number of the most
recently saved file.

Step 3: Establish a connection with the appropriate camera. In applications using
more than one camera, match the camera serial number to the serial number used
in the name of the backup file.

Step 4: Use the Save to Camera function (found in the File Menu or on the
Button Menu) to send the backup file parameters to the camera. (See page 5-10.)
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VIEW CHANGES

The View Changes menu selection displays any changes made to the copy of
parameters held by Accu-Setup that have not been saved to the camera or have
not been saved to a disk file, since the last retrieval. Any parameters that have
been modified are temporarily reserved when OK is clicked from within Modify
Setup. These reserved parameters can be viewed and compared with the original
parameters by using the View Changes utility. This feature enables you to
review any modifications before saving them to the camera or a disk.

To view parameter changes made while using Modify Setup:

Step 1: While in Modify Setup (available from the Button Menu or Edit Drop-
down Menu), make any necessary changes and click OK. Once this is done, you
are returned to the Accu-Setup Main window.

NOTE: If you click Cancel while in Modify Setup, changes are not reserved and
all parameters revert to the previous settings. If you retrieve settings from a
camera before you save the new settings, Accu-Setup clears any changes that
were made and temporarily reserved within Modify Setup.

Step 2: Select View Changes from the Utilities drop-down menu, or press
<Alt><U> and <Alt><V>.  The View Changes window will be opened.

View Changes Window

Step 3: The View Changes window enables you to compare the Original Value
and New Value associated with each Accu-Setup parameter.

Step 4: Click OK to close the View Changes window.

Step 5: If you want to use the changes shown as New Values on the View
Changes window, then save the new settings to the camera and save a backup to
disk. (See Save to Camera on page 5-10 or Save to Disk on page 5-11.)
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DIAGNOSTICS AND UTILITIES

The Diagnostics and Utilities menu selection enables the user to access a series
of eight tabs for monitoring system performance and troubleshooting various
operating conditions.

NOTE: The same functions can be accessed using the Diagnostics and Utilities
Button from the Accu-Setup Main Window. For details, reference the
Diagnostics and Utilities section of this manual, Chapter 4.

Diagnostics Descriptions

System Status Useful for checking performance of decoder, camera, and other
system components. Enables user to monitor belt speed, tach,
package count, error count, late decodes, and illumination.

SMIO Com Used to send test messages to check if all system communications
are functioning properly as well as provides a running count of
various messages (Rx, Tx, framing, Rx overflow, Tx overflow) by
communications port (host, com, and illum).

Decoder Monitor Used to monitor the decoder and package tracking conditions that
have been enabled using the Modify Setup / Decoder Diag and
Pkg Mgt Diag tabs. Any enabled conditional or unrestricted action
messages are displayed in the Rolling Text window. Any enabled
conditional or unrestricted action images are displayed in the Image
Edit window.

Trigger Monitors the operation of all devices used to trigger package
detection including light curtain, photoeye, and tach encoder and
counts various errors (package too long, too short, too close). (See
the Modify Setup / Trigger tab.)

Imaging Provides AVScope and manual control for testing the camera
scanning parameters including focus, gain, and scan line frequency.
Also includes error counts for focus faults, clipped focus, clipped
gain, and clipped scan line clock. (See the Modify Setup / Imaging
tab.)

Logging Used to view diagnostics logs related to the camera, decoder, and
other system components and functions. (See the Modify Setup /
Logging tab.)

Package History Used to view a detailed history of the last 16 packages that have
been tracked through the system.

Outputs Defines the condition to activate, the active time (msec), and output
signal of up to four optional digital outputs that may be used to
control external devices (e.g.: alarms, package diverters, etc.). (See
the Modify Setup / Outputs tab.)

WARNING: A number of the diagnostic and utilities features, especially the log
files,  will affect system performance. These functions are intended for diagnostic
purposes only and should be disabled during normal system operation.
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MODIFY GAIN TABLE

The Modify Gain Table menu selection is used to adjust the image brightness
relative to package height and belt speed in order to optimize image quality. The
camera gain mode is defined using the Imaging tab available from the Modify
Setup window. If the Compensated Gain Mode is selected, the Modify Gain
Table function is also enabled. When Fixed Gain Mode is used, Modify Gain
Table is not available. (Reference the Modify Setup section of this manual for
details.)

WARNING: Since changes made to this table can dramatically affect camera
performance, it is strongly recommended that you do not make modifications to
this table unless directed to do so by an ASI trained and authorized technician.

To make changes to the gain table:

Step 1: Select Modify Gain Table from the Utilities drop-down menu. This
opens the Modify Gain Table window. The message “GAIN TABLE NOT
LOADED” is shown on the Modify Gain Table screen and the gain values are
not displayed until one of the retrieve functions is used.

Modify Gain Table, Before Retrieve from Camera or Disk

Step 2: Use the Retrieve From Camera button to retrieve the gain table from a
camera. Be sure to establish communications with the camera prior to using
Retrieve from Camera. (To Retrieve from Disk, see Step 3.)

Step 3: Use the Retrieve From Disk button to open the Gain Table File window.
From this window, select a *.GAN file, and click Open to retrieve the gain table.
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Gain Table Files Window

Once the gain table is retrieved (from either camera or disk), the complete table
is displayed as shown in the example below.

Modify Gain Table, After Retrieve from Camera or Disk

Step 4: Gain table values can be modified by changing individual values
manually (typing in a new value) or through the use of the four arrow buttons
(+10, +1, –1, and –10).

To manually change a value, double-click on the Height/Frequency box you
wish to change. Once the value is highlighted, type in the new value.

When using the arrow buttons, place the cursor in the Height/Frequency box to
be changed and press/hold the <Ctrl> key. Use the arrow buttons to
increase/decrease the gain (incrementally by one or ten) either increasing (+10,
+1) or decreasing (–1, –10) the gain value as required.
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To change multiple values simultaneously, hold the <Ctrl> key as you click on
several the Height/Frequency boxes. Then use the arrow buttons to change the
highlighted gain values by the same amount.

To change the entire gain table by the same amount, first place the cursor in one
of the Height/Frequency boxes and press/hold the <Ctrl> and <A> keys. The
entire table will be highlighted and you can incrementally change all of the
values using the four arrow buttons.

Whenever changes are made to the gain values, a warning message is displayed.
Click Yes to continue to save to camera or disk.

Step 5: To test the camera using the value changes you just made, click on the
Save To Camera button. The new gain table values are then sent to the camera.

Step 6: After testing the gain table changes to assure improved system
performance, be sure to save the gain table changes. Use the Save To Disk
button to open the Gain Table Files window and type in a new file name. When
you click on Save, the file is automatically stored in Accu-Setup’s gain folder
with the *.GAN extension added to the file name.

Step 7: To exit the Modify Gain Table window, click the Close button.

NOTE: The gain table data is only retrieved or saved from within the Modify Gain
Table window and cannot be retrieved or saved by using the buttons in the Accu-
Setup Main Window.

Modify Gain Table File Menu

The File Drop-down Menu located on the Modify Gain Table window offers
the retrieve and save functions also available as buttons on the Modify Gain
Table window. In addition, the Reload Default Gain Table option is also
included in the File Menu.

Reload Default Gain Table

When the Reload Default Gain Table option is used, it returns the camera to the
factory settings.

WARNING: Use caution if using Reload Default Gain Table. It resets the camera
to factory defaults. The gain table will need to be reconfigured if this setting is
invoked. (See Modify Gain Table in the Utilities menu of Accu-Setup.)
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MODIFY FOCUS TABLE

The camera focus mode is defined using the Imaging tab available from the
Modify Setup window. If either Leading Edge Focus Mode or Profile Focus
Mode is selected, the Modify Focus Table function is also enabled. When Fixed
Focus Mode is used, Modify Focus Table is not available. (Reference the
Modify Setup / Imaging Tab section in Chapter 3 for details.)

WARNING: Since changes made to this table can dramatically affect camera
performance, it is strongly recommended that you do not make modifications to
this table unless directed to do so by an ASI trained and authorized technician.

To change the values stored in the Focus Table:

Step 1: Select Modify Focus Table from the Utilities drop-down menu. This
opens the Modify Focus Table window. Values are not displayed until one of the
retrieve functions is used.

Modify Focus Table, Before Retrieve from Camera or Disk

Step 2: Use the Retrieve From Camera button to retrieve the focus table from a
camera. Be sure to establish communications with the camera prior to using
Retrieve from Camera. (To Retrieve from Disk, see Step 3.)

Step 3: Use the Retrieve From Disk button to open the Focus Table File
window. From this window, select a *.FOC file, and click Open to retrieve the
focus table.
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Focus Table Files Window

After a successful retrieve function is performed (from either camera or disk), the
Modify Focus Table screen appears, as shown in the example below, with the
complete table data listing. Use the slider bar to scroll through and view the table
data.

Modify Focus Table, After Retrieve from Camera or Disk

Step 4: Focus table values can be modified through the use of the two arrow
buttons (+1 and –1).

To change a value using the arrow buttons, place the cursor on the focus value to
be changed and press/hold the <Ctrl> key. Use the arrow buttons to
increase/decrease the focus incrementally by one, either increasing (+1) or
decreasing (–1) the focus value as required.
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To change multiple values simultaneously, hold the <Ctrl> key as you click to
highlight the values to be changed. Then use the arrow buttons to change the
highlighted focus values by the same amount. Use the <Shft> key to select a
range of focus values you want to modify.

To change the entire focus table by the same amount, first place the cursor on a
focus value, then press/hold the <Ctrl> and <A> keys. The entire table will be
highlighted and you can incrementally change all of the values using the arrow
buttons.

Whenever changes are made to the focus values, a warning message is displayed.
Click Yes to continue to save to camera or disk.

Step 5: To test the camera using the value changes you just made, use the Test
Focus Value button (formerly Focus to DAC Value button). This button is used
for diagnostic purposes to temporarily use a changed focus value to see how it
performs.

Step 6: After testing the focus table changes to assure improved system
performance, be sure to save the focus table changes. Click on the Save To
Camera button to send the new focus table values to the camera. Use the Save
To Disk button to open the Focus Table Files window and type in a new file
name. When you click on Save, the file is automatically stored in Accu-Setup’s
focus folder with the *.FOC extension added to the file name.

Step 7: To exit the Modify Focus Table window, click the Close button.

NOTE: The focus table data is only retrieved or saved from within the Modify
Focus Table window and cannot be retrieved or saved by using the buttons in the
Accu-Setup Main Window.
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Modify Focus Table File Menu

The File Drop-down Menu located on the Modify Focus Table window offers
the retrieve and save functions also available as buttons on the Modify Focus
Table window. In addition, the Reload Default Focus Table option is also
included in the File Menu.

Reload Default Focus Table

When the Reload Default Focus Table option is used, it returns the camera to
the factory settings.

WARNING: Use caution if using Save Default Table to Camera. It resets the
camera to factory defaults. The focus table will need to be reconfigured if this
setting is invoked. (See Modify Focus Table in the Utilities menu of Accu-
Setup.)
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MODIFY CAMERA NAME AND SERIAL NUMBER

The Modify Camera Name and Serial Number option, when selected, opens a
screen that enables you to view or modify the camera’s factory-assigned serial
number and user-defined name.

Modify Camera Name

In the event of a system default or power loss, the camera serial number is filled
with zeros and must be re-entered in order for the system to operate properly.
The serial number is located on the outside of the camera SMIO panel.

The user-defined camera name, which may be up to 15 characters, is especially
useful when it is necessary to identify multiple cameras used within the same
building or application.

USEFUL TIP: It is recommended that your camera have a descriptive name
entered for the System Name. This is especially important in systems where
multiple cameras are used (e.g.: tunnel applications). Use a concise yet
descriptive System Name, for example: Camera1/Lane1 or Camera1/TopRead.

If a connection between Accu-Setup and the camera is not established before
attempting to modify the camera name or serial number, a warning message is
displayed.

Warning: Establish Link Before Modifying Camera Name and Serial Number

Once you are finished with the Modify Camera Name and Serial Number
screen, Click OK to save the change or Cancel to exit without making a change.
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SMART ILLUMINATION CONTROL AND STATUS

NOTE: This feature is for AccuVision Camera Systems using the SI-20 sodium
illumination modules. It is not available to camera systems using either the self-
contained sodium illumination or LED illumination (LIS or Coplanar).

Selecting Smart Illumination Setup and Diagnostics from the Utilities drop-
down menu causes the Smart Illumination Control and Status screen to be
displayed.

Smart Illumination Control and Status

Lamp Settings

Lamp ID

There are a total of eight Lamp ID boxes. Each contains the following:

Light Bulb indicates whether or not the bulbs of the SI20 illumination module
are lit. (The light bulb graphic is yellow when lit.)

Polling of the SI20 illumination module is enabled when there is a checkmark in
the Poll checkbox.
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Lamp Status

The Lamp 1 through Lamp 8 buttons are used to activate the Lamp Status
indicators for the selected lamp by clicking on the button associated with the
lamp you wish to monitor.

Status Indicator Description
Ballast Temperature The ballast temperature is shown in the field to the right of

the status indicator (either F or C). The status indicator
defines the following:
Green – Ballast is within acceptable temperature range.
Red – Ballast temperature is too hot.

Communications to SMIO Green – Pass
Red – Fail, check connection with camera (ILLUM
connector on camera’s SMIO panel)

Standby Mode Green – Pass
Red – Fail

Lamp in Regulation Green – Pass
Red – Fail, determine why lamp is not in regulation

Power Supply Green – Pass
Red – Fail, replace power supply

Cooling Fan Green – Pass
Red – Fail, replace cooling fan

Bulb Green – Pass
Red – Fail, replace bulb

Ballast Green – Pass
Red – Fail, replace ballast

Lamp Driver Module Green – Pass
Red – Fail, replace lamp driver module

Lamp Feedback Module Green – Pass
Red – Fail, replace lamp feedback module

NOTE: If any of the status indicators are white in color, this indicates that the function is
either not available or has not been selected.
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REBOOT DECODER

The Reboot Decoder option, when selected, initiates the restarting of the
APC100 Decoder.

NOTE: You must first establish a connection to a camera before you can reboot
the APC100 Decoder. See Establish Connection in Chapter 2.

If there is no connection to a camera, then the following message appears:

If the above message is displayed, click OK, and then establish the connection to
the camera for the APC100 Decoder you want to reboot. Once a connection is
established, select the Reboot Decoder option. Upon selection (and after
establishing a camera connection), the following alert message appears:

Select OK to reboot the decoder, otherwise click the Cancel button. When you
reboot the decoder, Accu-Setup automatically releases the camera connection,
since SMIO Talk, which is used to make the camera connection, has also be
interrupted by the reboot function.
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HELP MENU

The Help Drop-down Menu offers the following options for accessing Accu-
Setup: AccuVision Module Help and other important information about your
AccuVision System:

Help Drop-down Menu

Help Menu Descriptions
Content Use to access the content of Accu-Setup online help (Accu-

Setup: AccuVision Module Help).
Search Use to find a particular topic within Accu-Setup online help.
About Accu-Setup Displays the Accu-Setup version and copyright information.
About Camera Displays information about the camera that will be requested

whenever you contact Accu-Sort Customer Service.
About Camera Head Displays details on the camera head optics, sensor, DPI, etc. of

the camera currently connected to Accu-Setup.
Compatibility List Displays a list of camera models that are compatible with the

version of Accu-Setup you are currently running.

CONTENTS

While the software manual provides comprehensive information on Accu-Setup,
you may find it easier to search for and find the information you require by using
Accu-Setup: AccuVision Module Help.

To start using online help, use the Contents selection to view the contents of the
Accu-Setup online help file.

To access the content of online help:
Select Contents from the Help Drop-down Menu
or press <Alt><H> and <Alt><C>.

When Content is selected from the Help menu, the Accu-Setup Online Help
Welcome screen is displayed.

Accu-Setup: AccuVision Module Help has been developed similarly to other
Windows-based online documentation. It contains context-sensitive topics that
appear when you press <F1> or click Help on the current window of the Accu-
Setup application. (If there is no Help info for that specific Accu-Setup screen,
an error message is displayed.)
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Accu-Setup Online Help Welcome Screen (***screen updated***)

Accu-Setup: AccuVision Module Help contains links that direct you to related
topics. These links are words highlighted in green and underlined. To return to
the main topic click on the link captioned by Back to and located at the bottom of
the topic. Related topics are captioned by See also and also appear at the bottom
of the topic.

Some of the graphics in this online help have links to pop-ups that contain
descriptions of the graphic elements. Click on an element in a graphic to view its
description. Additionally, there are topics that contain a special graphic button.
This button is a link to the procedure for that topic. Click on the button to view
the topic’s procedure.

Accu-Setup Online Help Contents Tab (***screen updated***)
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SEARCH

Use the Search selection to view the contents index of the Accu-Setup online
help file.

To access the content of online help:
Select Search from the Help Drop-down Menu
or press <Alt><H> and <Alt><S>.

When Search is selected from the Help menu, the Accu-Setup Online Help
Index screen is displayed.

Accu-Setup Online Help Index Tab, Search Function (***screen updated***)

You can search through the index using one of two methods:
.

•  Typing the first few letters of the word you’re looking for or
•  Scrolling through and double-clicking on index entry you want.

Once the index entry is selected, click on the Display button. A Topics Found
window is opened listing all of the topics that match the index entry. Scroll
through, select a topic, and then click on the Display button in the Topics Found
window to view the information on that topic.

USEFUL TIP: More advanced and comprehensive searching features are
available from the Find tab available from the Index button of online help.
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The following drop-down menus are provided at the top of the help screen:

Menus Online Help Drop-down Menu Selection Descriptions
Open – Provides a standard Windows Open screen displaying other files on the hard
drive.
Print Topic – Opens a print window so you can printout a hardcopy of the currently
display topic. (Requires that you be connected to a printer.)

File

Exit – Exits Accu-Setup online help.

Copy (Ctrl + C) – Enables you to copy blocks of information from within the help file.Edit
Annotate – Enables you to attach notes to specific help topics. You can save, delete,
copy, and paste notes to any and all topics within online help.

Bookmark Define – Use to set-up and define names for multiple bookmarks within online help. A
list of bookmarks is maintained so you can return to those topics by double-clicking on
the bookmarks you have defined.

Default – Sets the Help window to the default setting.
On Top – Places and keeps Windows Help on top of all open
windows. Even when clicking on other windows, the Help window
remains on top.

Keep Help
on Top

Not on Top – Places Windows Help so that it is not kept on top of all
other open windows.

Display History Window – Opens the Windows Help History providing a list of topics
you looked at while using help. Double-clicking on a topic will return you to the topic.

Small – Reduces the size of the font to include more info on screen.
Normal – Returns the display font to its normal size.

Font

Large – Increases the size of the display font for easier reading.

Options

Use System Colors – Enables you to use the system colors. Requires that Windows
Help be closed and restarted to take effect.

Help Version – Displays version information for Microsoft Windows Help used with Accu-
Setup Online Help.

There are several buttons at the top of the online help welcome screen that
provide the following functions:

Buttons Online Help Button Selection Descriptions
Contents Opens the online help Contents tab.
Index Opens the online help Index tab.
Back Returns screen to the previously displayed information. Clicking this button

several times allows you to page backwards through the help information you
have reviewed.

Print Prints the current topic being viewed on screen.
<< Returns screen to the previously displayed information within a given topic. If

you have returned to the beginning of the topic, this button wi
>> Advances screen forward within a given topic.
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ABOUT ACCU-SETUP

Select About Accu-Setup to display version and copyright information for the
software you are currently running.

To view About Accu-Setup:
Select About Accu-Setup from the Help Drop-down Menu
or press <Alt><H> and <Alt><A>.

The About Accu-Setup information screen is displayed.

About Accu-Setup Information Screen (***Update for V4.0***)

ABOUT CAMERA

Select About Camera to display the camera type when a connection to a camera
has been established.  If a connection has not been established, the fields in the
About Camera window will be blank.

To view the About Camera information screen:
Select About Camera from the Help Drop-down Menu
or press <Alt><H> and <Alt><M>.

The About Camera information screen is displayed.

About Camera Information Screen

NOTE: This information is needed whenever you contact Accu-Sort Customer
Service regarding your AccuVision camera.
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ABOUT CAMERA HEAD

Select to display useful information about the camera connected to Accu-Setup.

About Camera Head

COMPATIBILITY LIST

Select to display a list of AccuVision cameras that can be configured using the
Accu-Setup program.

Compatibility List (***updated***)
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CHAPTER 6: APPENDICES

This chapter provides several appendices of supplemental information that will
assist you in using Accu-Setup for AccuVision. The appendices are described in
the table below.

Appendices Description

Appendix A:
Accu-Setup At-A-Glance

Provides a series of tables that identify the various
functions available in Accu-Setup in a simple, at-a-glance
format. A table is provided for the Accu-Setup Main
Window, Button menu, Drop-down Menus, Modify Setup
Tabs, and Diagnostic and Utilities Tabs.  The appendix
includes cross-referencing to related topics within the
manual.

Appendix B:
Min/Max Values Table

This table lists the minimum and maximum settable
parameter values that may be selected in the various
Modify Setup and Diagnostic and Utilities tabs
discussed in Chapters 3 and 4. These values can be
displayed in either the US Format or Metric Format. (See
Options drop-down menu in Chapter 5.)

Appendix C:
ASCII Characters Table

This table is provided for use with the Modify Setup /
Communications Tab, Host Message construction.
(See Chapter 3.)

Appendix D:
APC100 Messages

This table lists the possible AVCore status messages that
may appear on the APC100 Decoder’s 2-line LCD display.
This display is called the Remote Display on the Modify
Setup / Decoder Display/Power Tab. It must be enabled
via this tab. (See Chapter 3.)

Appendix E:
Glossary of Terms

An alphabetic listing of the various terms used in this
manual. The glossary includes cross-referencing to related
topics within the manual.

Appendix F:
Revision History

This table lists the revision history for this manual as it
relates to the Accu-Setup software versions. To assure that
this manual is applicable to the software you are using,
compare the software version number to the document
revision history.
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APPENDIX A: ACCU-SETUP AT-A-GLANCE

ACCU-SETUP FOR ACCUVISION MAIN WINDOW (AVM4.0)

BUTTON  MENU
NOTE: Reference Chapter 2 for additional details on the various Button menu functions.

Establish Connection A toggle button that is used to establish and release connections to your camera(s).
Retrieve From
Camera

Used to retrieve the current set of parameters being used by the camera connected to Accu-Setup.

Retrieve From Disk Used to retrieve a set of parameters that have been stored to disk.
Modify Setup Provides access to a series of 12 tabs that enables you to setup or modify these parameters:

Symbologies, Communications, Trigger, Tracking, Imaging, Decoder Diagnostics, Package
Management Diagnostics, Logging, Outputs, Tunnel, Decoder Display / Power Mgmt, and
Dimensioning. (See Chapter 3.)

Save To Camera Used to save a set of parameters to the camera connected to Accu-Setup, enabling the camera to
operate using these parameters.

Save To Disk Used to save a set of parameters to disk as a backup copy of the parameters that have been saved
to camera.

Diagnostics and
Utilities

Provides access to a series of eight diagnostic and utilities tabs including: System Status, SMIO
Com, Decoder Monitor, Trigger, Imaging, Logging, Package History, and Outputs. (See Chapter 4.)

Exit Accu-Setup Used to exit the Accu-Setup program after releasing a connection to a camera.
DROP-DOWN MENUS
NOTE: See the Drop-down Menus At-A-Glance table in Appendix A.
Reference Chapter 5 for additional details on the various Drop-down menus.
File Offers a series of options including: Compare, Retrieve From Camera, Retrieve From Disk, Save To

Camera, Save To Disk, and Exit. Most of these functions are also available from the Button Menu.
Edit Provides the option to save or restore a backup of the parameters by using either Create Backup File

or Recover From Backup File. The Modify Setup functions (also available from the Button Menu)
can also be accessed from the Edit Menu.

Options Offers four options: Auto Backup, Auto Retrieve, Display Values in US Format, and Display Values in
Metric Format.

Utilities Offers eight utilities: Recover from Backup File, View Changes, Diagnostics and Utilities, Modify Gain
Table, Modify Focus Table, and Modify Camera Name and Serial Number, Smart Illumination Setup
and Diagnostics, and Reboot Decoder. The Diagnostics and Utilities are also available from the
Button Menu.

Help This menu provides access to Accu-Setup online help through the Contents and Search functions. In
addition, four functions enable you to get additional information: About Accu-Setup, About Camera,
About Camera Head, and a Compatibility List.

CAMERA TYPE INFORMATION WINDOW
Software Name Version of SMIO software the system is currently running.
Command Version Version of Accu-Setup SMIO command file.
System Name Shows the user-definable system name.

SMIO Tab

Serial Number Displays the factory-set camera serial number.
Software Name Version of AVCore software the system is currently running.
Command Version Version of AVCore software command file currently running.

AVCore Tab

Network Information about the camera IP address, Gateway address, and
Netmask options if your system is connected to a network. (For
additional details on these settings, see Modify Setup /
Communication Tab / Advanced in Chapter 3.)

Software Name Name and version of the decoder software the system is using.Decoder Tab
Command Version Version of the decoder command file the system is currently using to

communicate with the camera.
COMMUNICATION LOG INFORMATION WINDOW
The Communication Log shows a real-time scrolling list of messages about the status of the AccuVision current operations.
Additionally, any Accu-Setup functions performed by the user are displayed along with any related responses from the
AccuVision system.
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DROP-DOWN
MENUS Functions Description

NOTE: Reference Chapter 5 for additional details on the various drop-down menus.
Compare Use to compare two sets of parameters, either camera-with-file or file-to-file.
Retrieve from Camera * Retrieves the parameters from a camera.

Retrieve from Disk * Retrieves a file of parameters stored on disk.

Save to Camera * Use to upload parameters to a camera.

Save to Disk * Use to save parameters to a file on disk.
Exit * After saving any needed changes to camera and/or disk and releasing the

connection to camera, use this selection to exit Accu-Setup.

File

NOTE: File functions marked by an asterisk are also available from the Button Menu.

Create Backup File Use to save parameters from a camera directly to a backup file.

Recover From Backup File Restores a set of parameters from an existing backup file.

Edit

Modify Setup Provides 12 tabs for setting or modifying the operating parameters. Also
available from the Button Menu.  (See the Modify Setup Tabs At-A-Glance
table in Appendix A. For details, see Chapter 3.)

Auto Backup Use to automatically save a backup settings file every time Accu-Setup is
connected to a camera.

Auto Retrieve Use to automatically download settings from a camera every time a camera is
connected to Accu-Setup.

Display Values in US Format Use to show all Accu-Setup dimensional values in US measurements
(inches/feet).

Options

Display Values in Metric
Format

Use to show all Accu-Setup dimensional values in metric measurements
(centimeters).

Recover from Backup File Use to restore parameters from a backup file.
View Changes Enables you to view the set of parameters currently in Accu-Setup before you

save any changes to either the camera or disk.
Diagnostics and Utilities Provides eight tabs for monitoring system performance and troubleshooting

various operating conditions. Also available from the Button Menu. (See the
Diagnostics and Utilities Tabs At-A-Glance table in Appendix A. For
details, see Chapter 4.)

Modify Gain Table Use to adjust the table that defines the gain levels of a camera in order to
achieve peak imaging performance. (For ASI trained and authorized technician
use only.)

Modify Focus Table Use to adjust the table that defines the camera focusing in order to achieve
peak imaging performance. (For ASI trained and authorized technician use
only.)

Modify Camera Name and
Serial Number

Enables you to display or modify the name and serial number of the camera
currently connected to Accu-Setup.

Smart Illumination Setup and
Diagnostics

Enables you to check the setup and status of the systems sodium illumination
module(s) as well as diagnose whether or not the illumination module is
operating properly. (Disabled for systems using LED illumination modules.)

Utilities

Reboot Decoder Used to reboot/restart the APC100 Decoder Module.
Content Use to access the content of Accu-Setup online help (Accu-Setup:

AccuVision Module Help).
Search Use to find a particular topic within Accu-Setup online help.
About Accu-Setup Displays the Accu-Setup version and copyright information.
About Camera Displays information about the camera that will be requested whenever you

contact Accu-Sort Customer Service.
About Camera Head Displays details on the camera head optics, sensor, DPI, etc. of the camera

currently connected to Accu-Setup.

Help

Compatibility List Displays a list of camera models that are compatible with the version of Accu-
Setup you are currently running.
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MODIFY SETUP
TABS Tab Screen Segments Functions

NOTE: Reference Chapter 3 for additional details on the various Modify Setup tabs.
Symbologies to Read Add/Remove symbols from drop-down menus of code types and options

(using Add or Remove (BT)). Active Symbologies List shows the enabled
code types, min/max lengths, and options.

Postal Symbology Options Symbol Orientation (DD), Min. Bar Count (DD), Max. Bar Count (DD),
POSTNET Merge X Tolerance (SB), POSTNET Merge Y Tolerance (SB)

Symbologies

Advanced Decoder Options
(BT)

Image Processing Mode (DD), Active Image Width, Active Image Start
Pixel, Max 1D Code Length, Max 1D Code Height, Low Aspect Code
Location (CB)

SMIO Ports * Illum Port Settings, Host Port Settings, Enable 422 (CB) for Host, Com
Port Settings; Com Initialization String.

Host Message Header, Trailer, Delimiter, Data Verification, No Read Message, Multiple
Message, Add Sequence Number (CB)

Decoder Ports * Com 1 and Com 2 ports, Enable Com 1 (CB), Enable Com 2 (CB)
Advanced (BT) Advanced Communications: Decoder Network Adapter, Network Ident.

Communications

* NOTE: Port Settings window offers drop-down menu for Baud Rate, Parity, Stop Bits, and Data Bits.
Trigger Mode Modes: Light Curtain, Photoeye, Light Curtain & Photoeye, Serial (DD);

Max. Package Length (SB); Debounce (SB)
Light Curtain Settings Light Curtain Offset (SB); Minimum Package Height (SB); Distance to

Scan Line (SB); Advanced (BT)
Photoeye Settings Active Low (CB); Distance to Scan Line (SB)

Trigger

Extend Edge Leading Edge (SB), Trailing Edge (SB)
Tracking (DD) Modes: None, Leading, Trailing, Immediate; Distance to Xmit Point (SB)
Belt Speed Settings Belt Speed Source: Internal or External (DD); Auto Generated Belt

Speed (SB); External Encoder Resolution (SB)

Tracking

Camera Mounting Relative Camera Angle (SB); Far Working Distance (SB)
Focus Modes: Leading Edge, Profile, Fixed (DD); Fixed Focus Height (SB)
Gain Modes: Fixed, Compensated (DD); Fixed Gain (SB)
Scan Line Clock Modes: Speed Compensated, Height Compensated, Direct Tach, Fixed

Frequency (DD); Fixed Frequency (SB); Scan Lines Per Inch (SB)

Imaging

Hardware Pixel Correction Enables camera’s pixel correction circuitry (CB)
Unrestricted Decoder Action Display Decode Messages on Decoder (CB)

Display Decode Images on Decoder (CB)
Decode Condition Do Action When Decode String Found in List (CB), Do Action When

Symbol Found in List (CB), each has an entry field, Add/Remove (BT)

Decoder Diag

Conditional Decoder Action Display Decode Image on Decoder (CB)
Save Decode Image on Decoder (CB)

Unrestricted Tracking Action Display Box Image on Decoder (CB); Display Transmit Point Image on
Decoder (CB); Save Box Image on Decoder (CB)

Package Database Modes Modes: Disabled, Transmit Point Image, Box Image (DD)
Tracking Condition Do Action When Decode String Found in List (CB); Do Action When

Symbology Found in List (CB); Do Action When Number of Codes Found
in List (CB); each has an entry field, Add/Remove (BT)

Conditional Tracking Action Display Transmit Point Image on Decoder (CB)
Save Transmit Point Image on Decoder (CB)

Pkg Mgt Diag

Image Compression Modes: ASI Compression, Down Sampling (DD);
Down Sampled Image Divisor (SB)

SMIO Logging Enables selected logs of events occurring on the SMIO (CB)
Decoder Logging Enables selected logs for the decoder (CB)
Alarm Mask Enables selected Alarm Masks (CB)

Logging

Message Mask Enables selected Message Masks (CB)
Outputs Digital Out 1 – Digital Out 4 Condition to Activate: Not Used, Life, Noread, Read, Multiple, Image

Valid (DD); Active Time (SB); Output Signal: Active High or Low  (DD)
Multi-Side Imaging Gain
Compensation

Enable Multi-Side Imaging Mode (CB); Bright Surface Gain % (SB);
Edge Transition Adjustment (SB)

DM-3000 Focus Data Setup Tunnel Focus Mode: Off (No DM3000), Front/Top/Back Read, Left Side
Read, Right Side Read (DD); DM-3000 Scan Window Length (SB)

Tunnel

Active Tunnel Configuration Front, Left, Top, Right, Back (white box indicates configuration in use)
Remote Display Enable Remote Display (CB); Com Port (DD); Remote Display Port Set.

Enable Power Switch Monitor (CB)
Decoder

Display/Power
Mgmt

Power Monitor
Enable UPS Monitor (CB)

Dimensioning Dimensioning Parameters Left X, Right X, Vertex Offset, Optical Center X, Expand Y, Camera Tilt
Angle, Reference Height 1, Reference X Density 1, Reference Height 2,
Reference X Density 2, Average Black Level, Minimum Package
Dimension, Adjustment 1, Dimensioning Enabled (CB), Default All (BT)

NOTE: The following abbreviations are used in this table. BT = Button, CB = Check Box, DD = Drop-down menu, SB = Slider Bar
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DIAGNOSTICS
TABS Tab Screen Segments Functions

NOTE: Reference Chapter 4 for additional details on the various Diagnostic and Utilities tabs.
SMIO Status Displays current SMIO status or counter info for: Belt Speed, Focus Height,

Gain Value, DPI, Temperature (with SI), Current Tach, Elapse Time, Total
Package Count, Total Error Count, Decode to Late, Current Package ID;
Reset SMIO Counts (BT)

System
Status

Decoder Status Displays current Decoder status or counter info for: Belt Speed, Line Rate,
Read Rate (%), Decoder Mode, Multi Read, Elapse Time, No Read Count,
Total Package Count, Total Error Count, Current Scan Line, Current Package
ID; Reset Decoder Counts (BT); SMIO Link (SI) Decoder Running (SI)

Send Test Message Enables the user to send a test message. User enters the test message in the
entry field and then clicks on Send (BT). Test message is sent to any device
for which the checkbox is enabled (e.g.:  Host, Com or Illum (CB)).

SMIO Com

Counters There are five counters for each device: Host, Com (Decoder) and Illum. The
counters are: Rx Messages, Tx Messages, Framing Errors, Rx Overflow
Errors, and Tx Overflow Errors. Use Reset Counts (BT) to reset all 15
counters.

Unrestricted Action Enable/disable the following in Accu-Setup: Display Tracker Messages (CB),
Display Box Image (CB), Display Decode Messages (CB).

Conditional Action Enable/disable the following in Accu-Setup: Display Decode Image (CB),
Display Transmit Point Image (CB). To review all Conditional Actions, click on
Display Conditions (BT) to go to Decoder / Tracking Conditions window.

Apply Actions (BT) Click on this button to apply the enabled Unrestricted or Conditional actions.
Details related to these actions are displayed in the Rolling Text and Image
Edit windows.

Rolling Text Window Displays all text-based messages related to all enabled Unrestricted and
Conditional Actions.  (Can also be viewed in AVCore.)

Decoder
Monitor

Image Edit Window Displays all captured images related to the enabled Unrestricted and
Conditional Actions. (Can also be viewed in AVCore.)

Light Curtain Current Char (hex), Current Height (in.), Glitches, Rcv Timeout Errors;
Package Present (SI)

Photoeye Input State At Connector, Glitches; Package Present (SI)
Tach Encoder Tach Count, Belt Speed, Min Belt Speed, Max Belt Speed, Deviation
Package Errors Too Long, Too Short, Too Close

Trigger

Reset Counts (BT) Click this button to reset all of the trigger counts.
Manual Focus – Adjust from 0.00 to 36.00 (SB) when enabled (CB).
Manual Gain  – Adjust from zero to 255 (SB) when enabled (CB).

Manual Control

Manual Freq – Adjust scan line from 0 to 20,000 (SB) when enabled (CB).
AVScope (BT) Click to view AVScope during any manually controlled adjustments.

Imaging

Error Counts Focus Faults, Clipped Focus, Clipped Gain, Clipped Scan Line Clock
Use Reset Counts (BT) to reset all imaging error counters.

SMIO Logging Click View SMIO Log File (BT) to review the file.Logging
Decoder Logging Enable/disable Decoder Log (CB), Tracking Log (CB), Configuration Log (CB),

and System Log (CB). Click View Selected Log Files (BT) to review the
enabled log files.

View Package Click on one of the Package ID numbers to view the captured package image.
SMIO Package Data Displays graph data for Box Height (blue line), Focus Height (green line), Gain

(orange line), & DPI (yellow line) when appropriate checkbox(es) are enabled.
Image Capture Mode Identifies the mode being used to capture images (e.g.: Start Box to Tx Point).
Change Image Capture Mode Click button to change image capture mode (BT).
Package ID Displays ID of package for which data is displayed in SMIO Package Data.
Belt Speed Displays belt speed at the time package data and image were captured.

Package
History

Box Height, Focus Height,
Gain, & DPI (CB)

These checkboxes enable/disable the display of info on the SMIO Package
Data graph. Each item is identified by colored line: Box Height (blue), Focus
Height (green), Gain (orange), and DPI (yellow).

Activate Digital Out 1 – 4 (BT) Click on the appropriate button to activate any of the digital outputs.
Indicators (SI) Indicates output condition:  white (not used), green (open), or red (closed).

Outputs

Fields Identifies the condition for each output: Not Used, Life, Noread, Read,
Multiple, Image Valid

NOTE: The following abbreviations are used in this table.
             BT = Button, CB = Check Box, DD = Drop-down menu, SB = Slider Bar, SI = Status Indicator
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APPENDIX B: PARAMETER MIN/MAX VALUES

Parameter Description Min Max
MODIFY SETUP / TRIGGER TAB

Maximum Package Length (in.) [cm.] * 4.0 [10.2] 60.0 [152.4]Trigger Mode *
Debounce (in.) [cm.] * 0.0 [0.0] 2.0 [5.1]

Photoeye Settings ** Distance to DRP (in.) [cm.] ** 0.0 [0.0] 200.0 [508.0]
Light Curtain Offset (in.) [cm.] * -5.00 [-12.70] 5.00 [12.70]
Minimum Package Height (in.) [cm.] * 0.50 [1.27] 36.0 [91.44]

Light Curtain
Settings *

Distance to DRP (in.) [cm.] * 1.0  [2.5] 200.0 [508.0]
* Only for Light Curtain or Light Curtain and Photoeye Trigger Mode.
** Only for Photoeye or Light Curtain and Photoeye Trigger Mode.

Leading Edge (in.) [cm.] -30.0 [-76.2] 30.0 [76.2]Extend Edge
Trailing Edge (in.) [cm.] -30.0 [-76.2] 30.0 [76.2]

MODIFY SETUP / TRACKING TAB
Tracking Distance To Transmit Point (in.) [cm.] (not for Immediate Tracking Mode) 1.0 [3] 200 [508]

Auto Generated Belt Speed (fpm) [mps]
             (only for Internal Belt Speed Settings)

0 [0.000] 600 [3.048]Belt Speed Settings

External Encoder Resolution ((tachs/in.) [tachs/cm.]
             (only for External Belt Speed Settings)

1.0 [2.5] 200.0 [508.0]

Relative Camera Angle (deg.) - 60.0 60.0Camera Mounting
Far Working Distance (in.) [cm.] 10.0 [25.4] 200.0 [508.0]

MODIFY SETUP / IMAGING TAB
Focus Fixed Focus Height (in.) [cm.]                       (only for Fixed Focus Mode) 0.00 51.00 [129.54]
Gain Fixed Gain                                                       (only for Fixed Gain Mode) 0 255

Fixed Frequency         (only for Fixed Frequency Scan Line Clock Mode) 0 16384Scan Line Clock
Scan Lines Per Inch        (only for Speed Comp. Scan Line Clock Mode) 80 500

MODIFY SETUP / PKG MGMT DIAG TAB
Image Compression Down Sample Image Divisor       (only for Down Sampling Comp. Mode) 1 16
MODIFY SETUP / OUTPUTS TAB
Digital Out (1 – 4) Active Time (msec) (for all four Digital Outs) 0 2000
MODIFY SETUP / TUNNEL TAB

Bright Surface Gain% 0 150Multi-Side Imaging
Gain Compensation Edge Transition Adjustment (in.) [cm] -9.9 [-25.1] 9.9 [25.1]
DM-3000 Focus
Data Setup

DM-3000 Scan Window Length (in.) [cm] 20 [51] 60 [152]

MODIFY SETUP / DIMENSIONING TAB
Left X (pixels) 0 20000
Right X (pixels) 0 20000
Vertex Offset 0 20000
Optical Center X     (Enter C for center of image) 0 20000
Expand Y -500 500
Camera Tilt Angle -60 60
Reference Height 1 0 5000
Reference X Density 1 0 20000
Reference Height 2 0 5000
Reference X Density 2 0 20000
Average Black Level 0 255
Minimum Package Dimension 0 500

Dimensioning
Parameters

Adjustment 1 0 200
DIAGNOSTICS AND UTILITIES / IMAGING TAB

Focus Height (in.) [cm.]  (enable Manual Focus) 0.00 36.00 [91.44]
Gain Value  (enable Manual Gain) 0 255

Manual Control

Scan Line Frequency  (enable Manual Freq) 0 20000
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APPENDIX C: ASCII CHARACTER CHART

The ASCII character set is used to create the host messages.
Below is a Hexadecimal and Decimal ASCII Character Chart.
See the Modify Setup / Communications Tab in Chapter 3 for more details.

HEXADECIMAL & DECIMAL CHARACTER ASCII TABLE
DEC HEX ASCII DEC HEX ASCII DEC HEX ASCII DEC HEX ASCII
000 00 ^@ NUL 032 20 SPC 064 40 @ 096 60 '
001 01 ^A SOH 033 21 ! 065 41 A 097 61 a
002 02 ^B STX 034 22 " 066 42 B 098 62 b
003 03 ^C ETX 035 23 # 067 43 C 099 63 c
004 04 ^D EOT 036 24 $ 068 44 D 100 64 d
005 05 ^E ENQ 037 25 % 069 45 E 101 65 e
006 06 ^F ACK 038 26 & 070 46 F 102 66 f
007 07 ^G BEL 039 27 ' 071 47 G 103 67 g
008 08 ^H BS 040 28 ( 072 48 H 104 68 h
009 09 ^I HT 041 29 ) 073 49 I 105 69 I
010 0A ^J LF 042 2A * 074 4A J 106 6A j
011 0B ^K VT 043 2B + 075 4B K 107 6B k
012 0C ^L FF 044 2C , 076 4C L 108 6C l
013 0D ^M CR 045 2D - 077 4D M 109 6D m
014 0E ^N SO 046 2E . 078 4E N 110 6E n
015 0F ^O SI 047 2F / 079 4F O 111 6F o
016 10 ^P DLE 048 30 0 080 50 P 112 70 p
017 11 ^Q DC1 XON 049 31 1 081 51 Q 113 71 q
018 12 ^R DC2 050 32 2 082 52 R 114 72 r
019 13 ^S DC3 XOFF 051 33 3 083 53 S 115 73 s
020 14 ^T DC4 052 34 4 084 54 T 116 74 t
021 15 ^U NAK 053 35 5 085 55 U 117 75 u
022 16 ^V SYN 054 36 6 086 56 V 118 76 v
023 17 ^W ETB 055 37 7 087 57 W 119 77 w
024 18 ^X CAN 056 38 8 088 58 X 120 78 x
025 19 ^Y EM 057 39 9 089 59 Y 121 79 y
026 1A ^Z SUB 058 3A : 090 5A Z 122 7A z
027 1B ^[ ESC 059 3B ; 091 5B [ 123 7B {
028 1C ^\ FS 060 3C < 092 5C \ 124 7C |
029 1D ^] GS 061 3D = 093 5D ] 125 7D }
030 1E ^^ RS 062 3E > 094 5E ^ 126 7E ~
031 1F ^- US 063 3F ? 095 5F _ 127 7F DEL
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APPENDIX D: APC100 DISPLAY MESSAGES

The following is a list of possible AVCore status messages that may appear on
the APC100 Decoder’s 2-line LCD display:

AVCore Status Condition Message on 2-Line Display
AVCore is starting. Line 1: Accu-Sort Sys.

Line 2: Loading
AVCore is ready for run-time operation (i.e.: ready
to read).

Line 1: Accu-Sort Sys.
Line 2: Ready

AVCore transmits a host message. (The next available line will display the data
portion of the host message. It may be
truncated if the message is too long for the
display.)

The Uninterruptible Power Supply (UPS, if
equipped) signals AVCore that AC power has
failed. AVCore has started the system shutdown
process.

Line 1: Power Failure
Line 2: Stand By

AVCore detects the software-controlled power
switch on the APC100 has been switched to the
"off" position. AVCore has started the system
shutdown process.

Line 1: Powering Down
Line 2: Stand By

AVCore has shutdown gracefully. Line 1: Decoder Offline
Line 2: Restart System

NOTE: The APC100 should also display its IP address for a few seconds when
booting. Additional information on the APC100 is provided in the manuals
provided with your equipment.
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APPENDIX E: GLOSSARY OF TERMS

Accu-Setup
The Windows®-based primary user interface that provides all the necessary functions to set up, monitor, and diagnose the
operations of an AccuVision System.

AccuVision System
This term identifies the Accu-Sort product line that utilizes CCD camera technology for imaging and decoding.

ACK
A control character sent to acknowledge that a transmission block has been received.

Active Image Width
Defines the narrowest possible active image by reducing the overall area the camera will scan for a valid bar code. For example:
In applications where codes always appear in one location of packages, the entire package does not need to be scanned, so the
active image width is set smaller, thus reducing decoding time and demand on processing resources. This is set in Accu-Setup
using the Modify Setup / Symbologies / Advanced Decoder Options (See Chapter 3.)

Address
A unique designation for the location of data or the identity of a smart device; allows each device on a single communications
line to respond to its own message.

Alignment
The position of the camera and/or light source as it relates to the target of a receiving element (i.e.: packages being tracked
through the scanning area).

Alphanumeric
Consisting of letters, numbers, and symbols. (See ASCII. Also reference the ASCII character chart, Appendix C.)

Ambient Light
Refers to the uncontrolled lighting conditions in the scanning area (i.e.: all light that is not provided by the AccuVision
illumination modules). Ambient light can interfere with successful scanning of bar codes.

Application
A use to which something is put, or how it is used. Throughout the AccuVision Sales Guide, the term application is used to
reference the customer’s needs and requirements as they relate to implementing an AccuVision solution.

ASCII  (American Standard Code for Information Interchange)
Pronounced as-kee. A standard seven bit plus parity code, representing 256 characters, established by ANSI to achieve
compatibility between data services. (Reference the ASCII character chart, Appendix C.)

Aspect Ratio
The ratio of height to width of a bar code symbol. A code twice as high as wide would have an aspect ratio of 2; a code twice as
wide as high would have an aspect ratio of  0.5”.

Asynchronous Transmission
Transmission in which the time intervals between transmitted characters may be of unequal length. Transmission is controlled by
start and stop bits at the beginning and end of each character.

Autodistinguish
The ability of bar code reading equipment to recognize a selectable number of different symbologies (whether 1D, 2D, or both)
and process the data without operator intervention; this is a prerequisite feature of bar code readers employed in open systems.
Also referred to as autodiscrimination.

Auto Generated Belt Speed (AutoTach)
Use for belt speed timing instead of using a tachometer. AccuVision systems can be setup to generate a belt speed automatically
for applications where belt speed does not vary more than 5%. This is generated by the camera’s SMIO board when the function
is selected from the Accu-Setup Modify Setup / Tracking Tab. Also referred to as AutoTach.  (See Chapter 3.)

AVCHI (AccuVision Custom Host Interface)
The AccuVision Custom Host Interface (AVCHI) is a customer-specific application designed to provide a customized interface
for systems utilizing a host computer. AVCHI provides all communications between the AccuVision system and host, including
the formatting and transmission of messages and responses to host commands.
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AVCore
The main WindowsNT®-based application running on the AccuVision decoder that provides a program interface for the decoder
as well as advanced image collection and diagnostics. Additionally, AVCore contains multiple threads for real-time data
movement and time critical processing.

Bar
The dark elements of a printed linear bar code symbology. (Referred to as elements in 2D symbologies.)

Bar Code
An array of rectangular bars and spaces arranged in a predefined pattern to represent elements of data referred to as characters.
Also referred to as bar code symbols or symbologies. (See the term Symbologies for definitions of the bar codes that can be read
by AccuVision cameras.)

Bar Code Character
A single group of bars and spaces that represent an individual number, letter, or other symbol.

Bar Code Density
The number of characters that can be represented in a linear unit of measure. Bar code density is often referred to in characters
per inch (CPI).

Bar Height
The height of the bars in a bar code.

Bar Length
The bar dimension perpendicular to the bar width.

Bar Width
The thickness of a bar measured from the edge closest to the symbol start character to the trailing edge of the same bar.

Baud Rate
A unit used to measure communications speed or data transfer rate; represents the number of discrete conditions or events per
second. (See BPS.)

BCC (Block Check Character)
Used to check transmission accuracy, a character transmitted by the sender after each message block and compared with a block
check character computed by the receiver.

BEL
A control character that is used when there is a need to call for attention; it may control alarm or attention devices.

Bed Width or Belt Width
The useable width of the conveyor belt, i.e.: belt area on which packages are transported.

Bidirectional
A bar code symbol capable of being read successfully independent of scanning direction.

Bit (Binary Digit)
The contraction of binary digit, the smallest unit of information in the binary system; a one or zero condition.

Bottom Read
When the camera is mounted under the conveyor to read codes on the bottom of boxes or on the front or back of boxes.

BPS (Bits per Second)
Unit of data transmission rate. See baud rate.

Bright Surface Gain
This is a setting (by percentage) used when imaging multiple sides of packages, typically in a tunnel application. This is set via
Accu-Setup. (See Modify Setup / Tunnel Tab in Chapter 3.)

Button
A graphic user interface that allows users to select a given software function. Instead of physically pressing a button, the user
simply clicks on the desired button to access a menu, tab screen, or function.

Button Menu
A graphic user interface that offers several buttons. The Accu-Setup Main Window offers a menu of buttons that include Save to
Camera, Modify Setup, Exit, etc. Instead of physically pressing a button, the user simply clicks on the desired button to access a
menu, tab screen, or function.
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Camera, Camera Module
Identifies the AccuVision module that is responsible for scanning and/or imaging packages that pass through the scanning area.
The camera includes several sub-components (including the camera head and SMIO board) and is responsible for the
interconnections with other devices (e.g.: decoder, trigger, tach, illumination, etc.).

Camera Head
Component subassembly of the AccuVision camera that includes the lens, auto-focusing optics (if applicable), and CCD sensor
array.

Capture count
The number of consecutive identical valid decodes that result in a valid read.

CCD Sensor Array
A series of Charged Coupled Device (CCD) photo receptors used by the camera to convert light energy into electrical energy.
(See also Tap(s).)

Character
A single group of bars and spaces in a code that represent an individual number, letter, punctuation mark or other graphic
element. Used as part of the organization, control, or representation of data.

Character, self-checking
The feature that allows a bar code reader to determine if a scanned group of elements is a valid symbol character.  If a symbology
is described as character self-checking, a single printed defect (edge error) in any symbol character does not produce a valid
character.

Character set
Those characters available for encodation in a particular automatic identification technology.

Check Character
A character (usually at the end of the code) that is used to perform a mathematical check to ensure the accuracy of a scan of the
bar code.

Codabar
For details, see Symbologies

Code 128
For details, see Symbologies

Code 39
For details, see Symbologies

Code 93
For details, see Symbologies

Code Length
The length of the bar code measured from the start of the first bar to the end of last bar.

Code Orientation
The relationship of the bar code with reference to the camera’s reading zone. Typical code orientations are Ladder and Picket
Fence.

Com Initialization String
A user-definable string of ASCII characters that can be set for the SMIO Ports by using the Modify Setup / Communications Tab
of Accu-Setup. (See Chapter 3.)

Command Version
(See Accu-Setup Main Window / Camera Type / SMIO Tab in Chapter 1.)

Communications Protocol
The rules governing exchange of information between devices connected together on the same communications line.

Configuration
The arrangement and interconnection of hardware components within a system, and the hardware and software selections that
determine the operating characteristics of the system.

Continuous code
A bar code symbology where all spaces within the symbol are parts of the characters (Interleaved 2 of 5).  There is no interactive
gap in a continuous bar code symbology.
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Conveyor Speed
The speed that the conveyor is moving, typically measured in either feet per minute (FPM) or centimeters per second (CPS).
AccuVision systems require stable/consistent conveyor speed to assure the accuracy of bar code reading.

Coplanar Illumination
An illumination source that is in the same plane / line of sight of the camera’s CCD sensor array. The AV3700 offers an LED
coplanar illumination option.

CR (Carriage Return)
An ASCII control character that moves the cursor or print mechanism to the left margin.

CRC (Cyclic Redundancy Check)
A CRC is generated by treating a message as a single, large binary number and dividing it by a specific number and keeping the
remainder, which becomes the CRC. This can be set in Accu-Setup. (See Modify Setup / Communications Tab / Host Messages /
Data Verification in Chapter 3.)

CTS (Clear to Send)
The Modem interface signal that indicates to the DTE device to begin transmission.

Data Bits
(See Serial Asynchronous Transmission Of Data.)

Data Matrix
For details, see Symbologies

Data Verification
There are three data verification options available when defining the host message via Accu-Setup: None, BCC, and CRC. (See
Modify Setup / Communications Tab / Host Message in Chapter 3.)

Decode
The process of translating a bar code into data characters using a specific set of rules for each symbology.

Decode Engine
The component of the bar code reading system that decodes the bar codes. This term is used interchangeably with Decoder, but
typically references the decoding software resident in the AccuVision APC100 Decoder.

Decoder
As part of a bar code reading system, the electronic package that receives the signals from the camera, performs the algorithm to
interpret the signals into meaningful data and provides the interface to other devices. May also be referred to as Decoder Logic.

Default(s)
Original parameters as programmed by Accu-Sort at the factory. Accu-Setup can be used to review the default settings.

Delimiter Between Codes
The separator used between multiple bar codes decoded and transmitted to the host in the same message. The delimiter is set in
Accu-Setup. (See Modify Setup / Communications Tab / Host Message in Chapter 3.)

Depth of Field (DOF)
The distance between the maximum and minimum plane in which a symbol can be read. This range is from the specified optical
throw to the far reading distance.

Density
The number of data characters which can be represented in a linear unit of measure.  Bar code density is often expressed in
characters per inch (CPI).

Dimensioning system
Used in applications that require more than the package height data provided by a photoeye or light curtain. Currently, a DM-
3000 is used to provide package dimensioning to camera-based systems.

Discrete code
A bar code or symbol where the space between characters, intercharacter gap, are not part of the code as with Code 39.  See
continuous code.

Dots Per Inch (DPI)
DPI is a measure of resolution and indicates the number of pixels per linear inch as measured at the object plane. Unless
otherwise qualified, DPI generally refers to the camera’s resolution perpendicular to the motion of the transport (i.e.: across the
conveyor). Minimum DPI identifies the lowest DPI that occurs in the system. This figure generally limits the smallest symbology
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element that may be detected. Minimum DPI Reference Distance is the linear measurement between the camera’s reference plane
(often the mounting base) and the point where the minimum DPI occurs. This is generally the largest possible distance to which
the camera can be focused. Maximum DPI identifies the highest DPI that occurs in the system. Maximum DPI Reference
Distance is the linear measurement between the camera’s reference plane (often the mounting base) and the point where the
maximum DPI occurs. This is generally the smallest possible distance to which the camera can be focused.

Downloading
The process of sending configuration parameters, operating software or related data from one source to another.

Down Sampling
A software function that reduces the amount of storage and processing time used when displaying or saving images from within
Accu-Setup. This slider bar is found on the Modify Setup / Pkg. Mgt. Diag. Tab.

Drop-down menu
A graphical user interface that allows the user to select from a list of options that are displayed when a specific function has been
selected. This options list “drops down” from the selected function. A list of drop-down menus can be found across the top of the
Accu-Setup Main Window.

DSR (Data Set Ready)
An RS232 modem interface control signal which indicates that the terminal is ready for transmission.

DSR (Data Terminal Ready)
Modem interface signal which alerts the modem that the DTE device is ready for transmission.

Duplex Transmission
See Full and Half Duplex.

EAN
European Article Number System.  The international standard bar code for retail packages.

EDI (Electronic Data Interchange)
A method by which data is electronically transmitted from one point to another.

EIA-232  (See RS-232)
EIA-422  (See RS-422)
EIA-485  (See RS-485)

Element
Dimensionally the narrowest width in a character - bar or space.

Element width
1) 1D codes: The thickness of a bar measured from the edge closest to the symbol start character to the trailing edge of the same
element.  2) 2D codes: The thickness of any element within the 2-dimensional symbol.

Encoded area
The total linear dimension consisting of all the characters of a code pattern, including start and stop characters and data.

ENQ (Enquiry)
A transmission control character used as a request for a response from a remote station. (^E)

Error
A discrepancy between a computed, observed or measured value or condition and the true, specified or theoretically correct value
or condition.

ESC (Escape)
A control character that is used to provide additional control functions. It alters the meaning of a limited number of continuously
following bit combinations.

ETX (End of Text)
A transmission control character that terminates a text.

Even Parity
A data verification method in which each character must have an even number of on bits.

Far Distance
The distance (dimensional reference) from the face of the camera to the farthest point at which a code can be successfully
scanned.
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Feet Per Minute (FPM)
Typically used to define the speed of a conveyor. Conveyor speed may also be defined in meters per second.

Field of View (FOV)
Defines the coverage area across the conveyor belt width over which the camera can detect and read bar codes. FOV is a linear
measurement of the length of the scan line and should be qualified with a “throw” distance (e.g.: 24” FOV @ 60” throw). A
maximum theoretical FOV is the absolute maximum scan line length assuming sufficient uniform illumination along the whole
scan line. Effective FOV is the useful length of the scan line as limited by the illumination and/or the camera. (For example: At a
throw of 60”, a camera may have a maximum theoretical FOV of 24” but the illumination may only cover a 20” FOV, so the
effective FOV of the camera/illumination system would be 20”.)

Flying Lead
A lead that exits the back of the connector hood on the outside of the cable jacket. It is normally attached to the drain wire or
shield and connected to the chassis of the switch, modem, etc. It can also be a hardware control lead.

Focus, Focusing
As the term suggests, they identify the camera’s means of gathering light onto the CCD sensor through the use of a lens and, in
the case of some cameras, a focusing mechanism (e.g.: voice coil).  Dynamic Focusing refers to adjusting the camera focal length
“on the fly” to accommodate varying package heights or varying distances between the camera and packages. Input is required
from a light curtain or dimensioning system. Fixed Focus identifies cameras with a focal length that remains the same (i.e.:
fixed); used by cameras to image packages that are all the same distance from the camera. The Focus Table is one of three files
stored on the APC100 that can be modified via the Utilities Menu / Modify Focus Table. (See Chapter 5.) Focus table
modification should only be done by an ASI trained and authorized technician.

Frame Grabber
Board installed in APC100 that is used to capture image data. (See GRAY IMAGE DATA.)

Front Read
The camera is mounted to read bar codes on the front (leading edge) of a box as it passes the camera. In a front read application,
the camera is typically setup at a 45 degree angle to the conveyor, mounted either above or on the side of the conveyor.

Front/Top Read
The camera is mounted to read the front and top of packages as they pass through the scanning area. In a front/top read
application, the camera is usually mounted above the conveyor positioned at a 45 degree angle to enable it to scan both the front
and top of packages.

Full Duplex (FDX)
Simultaneous, two-way, independent transmission in both directions.

Gain
A measure of amplification. More gain means more amplification. Too much gain may lead to saturation (i.e.: signals reaching a
maximum value). Accu-Setup enables the user to define a Gain Mode via the Modify Setup / Imaging Tab. The Gain Table is a
look-up table of gain setting values tabulated for various heights and speeds. It is one of three files stored on the APC100 that can
be modified via the Utilities Menu / Modify Gain Table. (See Chapter 5.) Gain table modification should only be done by an ASI
trained and authorized technician.

Gateway
A device used to connect networks using different protocols so that information can be passed from one system or network to the
other(s). (See Subnet Mask.)

Gateway Address
Like all other devices on a network, the device serving as the Gateway must also have an IP address so that devices wishing to
communicate with devices outside its own network can fine the Gateway which will forward its data. Like all other addresses, it
is displayed in the “dotted-decimal” format.

Gray Image Data
Gray scale image data is the image captured by the camera of a product as it passes through the scanning area. The gray image
data is not required for symbology decoding, but may be provided from the camera’s GRAY IMAGE DATA port to the frame
grabber in the APC100 and subsequently to the client’s host computer for processing.

Guard bars
1) The bars at the ends and center of a UPC and EAN symbol that ensure a complete scan of the bar code.  2) The optional bars
outside the quiet zone of an Interleaved 2 of 5 symbol that ensure a complete scan of the bar code.

Half Duplex (HDX)
Transmission in either direction, but not simultaneous.
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Handshaking
Exchange of predetermined signals between two devices establishing a connection. Usually part of a communica-tions protocol.

Header
A means of identifying the beginning of a message to be sent to the host. One example is <STX> or Start of Text. (See ASCII
chart, Appendix C.)

Hexadecimal
A base-16 numbering system that uses the symbols 0,1,2,3, 4,5,6,7,8,9,A,B,C,D,E,F.  (See ASCII chart, Appendix C.)

Host
1) A central controlling computer in a network system.
2) Any device on a network system that provides a controlling function to another device on the network.  3) Any intelligent
device for which another device is providing a communication interface to a network.

Illumination
Light source used with a camera to provide the lighting needed to illuminate the scanning area. Some cameras use self-contained
illumination.  There are three types of illumination used by AccuVision: 1) sodium, 2) LED, or 3) Coplanar LED.

Image Capture
Term used to define the process used by AccuVision cameras to acquire images of products as they pass through the scanning
area.

Intercharacter Gap
The space between two adjacent bar code characters in a discrete code.

Interface
A shared boundary defined by common physical interconnection characteristics, signal characteristics and meanings of
interchanged signals.

Interleaved Bar Code
A bar code that pairs characters together using bars to represent the first character and spaces to represent the second (e.g.:
Interleaved 2 of 5).

Interleaved 2 of 5 (I 2 of 5)
For details, see Symbologies

Inter-symbol no-read count
The minimum number of no-reads that must occur between symbols scanned when Self-Triggered (continuous decode) is
selected as the decode trigger.  Symbols that are not preceeded by the minimum number of no-reads are ignored.

I/O
The abbreviation for input/output. The keyboard and a printer, are examples of I/O devices. I/O activity is different from
computational activity. When a program sends a document to the printer, it is engaging in I/O activity; when the program sorts a
list of terms, it is engaging in computational activity.

IP Address (Internet Protocol Address)
IP Address is the numeric address given to a network card which enables other devices on a network to find it. For readability,
this number is displayed in “dotted-decimal” format (e.g.: 127.0.0.1)
as opposed to the binary equivalent
(e.g.: 01111111000000000000000000000001).

LAN
The acronym for local area network. A LAN system is usually confined to the same building or a few nearby buildings, with all
equipment linked by wiring dedicated specifically to the LAN.

Laser Scanner
An optical bar code reading device using a low energy laser light beam as its source of illumination.

LCD (Liquid Crystal Display)
A low-power display on the APC100 Decoder. An LCD consists of a liquid crystal solution between two sheets of polarizing
material. An electric current causes each crystal to act like a shutter that can open to allow light past or close to block the light.
(See Appendix D.)

LED (Light Emitting Diode)
A semiconductor generally made from gallium arsenide, that can serve as a visible or near infrared light source when voltage is
applied continuously or in pulses. LEDs have extremely long lifetimes when properly operated.
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LED Illumination
Low-power light emitting diode (LED) light source used by cameras to illuminate the scanning area in applications with little or
no DOF requirements where high speed is not a consideration.

Lens
Optics used in cameras for focusing light onto the CCD sensor array.  Lens Focal Length (mm) defines the lens focal length in
millimeters. The AV3700 cameras have four lens options: 38 mm, 50 mm, 85 mm, and 135 mm.

LF (Line Feed)
An ASCII control character that moves the cursor or print mechanism to the next line. (^J)

Light Curtain
A sensing device connected to the AccuVision system that uses a series of transmitters and receivers to create a “curtain of light”
that is both 90 degrees and perpendicular to the conveyor’s direction of travel. This device is used by the system to detect either
the presence and/or the height of packages as they enter the camera’s scanning area.
Linear Bar Codes
Also referred to as 1D or 1-dimensional symbologies. Examples: Code 39, I2of5, UPC.

Lines Per Inch (LPI)
Identifies the lines per inch. LPI is a measurement of resolution that indicates the number of sensor scan lines that are collected
for every inch of transport movement. In effect, LPI is the “DPI in the direction of conveyor travel”.

Matrix 2D Symbology
Examples: Aztec, DataMatrix, MaxiCode, QR Code

MaxiCode
For details, see Symbologies

Memory
A computer can contain several different forms of memory, such as RAM, ROM, and video memory. The term memory is
generally used to define RAM. When a computer has 8 MB of memory, it actually has 8 MB of RAM.

Memory Address
A specific location, usually expressed as a hexadecimal number, in the computer’s RAM.

Message
1) A meaningful combination of alphanumeric characters that establishes the content and format of a report.  2) In a
communication network, the unit of exchange at the application layer.
Message buffer
Storage register for the temporary storage of data that allows decoding to continue while the host is retrieving data from the serial
port.

Message buffer warning
An output condition that occurs when the message buffer has used a defined amount of the message buffer.

MHz
The abbreviation for megahertz.

Microprocessor
The primary computational chip inside the computer, referred to as the “brain”. The microprocessor contains an arithmetic
processing unit and a control unit. Software written for one microprocessor must usually be revised to run on another
microprocessor.

Mil
One thousandth of an inch (0.001 inch). Bars and spaces of codes are commonly referred to as being a certain number of mils
wide.

Misread
The scanner incorrectly decodes a bar code as it passes through the scan zone.

Mouse
A pointing device that controls the movement of the cursor on a screen. Mouse-aware software allows the user to activate
commands by clicking a mouse button while pointing at objects displayed on the screen. A mouse or trackball device is useful
when using the Accu-Setup for AccuVision software.

Multidrop Line
A single communications circuit that interconnects many stations, each of which contains terminal devices. See EIA-485.
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NAK (Negative Acknowledgment)
A control character used to indicate that the previous transmission block was in error and the receiver is ready to accept
retransmissions.

Narrow Bar (NB) / Narrow Space (NS)
Smallest code element, bar or space, in the bar code symbol. Also known as the X dimension.

Near Distance
The distance from the face of the camera to the closest point at which a code can be successfully scanned.

Net Mask
A numeric value that is used by devices to determine whether the device it wishes to communicate with is on the same network.
If not, the data must be forwarded via a Gateway. May also be referred to as Subnet Mask. (See Gateway, Gateway Address.)

Network
A series of stations (nodes) connected by some type of communication medium.  A network may be made up of a single link or
multiple links.

NVC
The acronym for non-valid code. Defines the condition that occurs when an object has been scanned and no bar code could be
decoded. Usually, this indicates that either no code was on the object or the code was badly damaged and could not be decoded.

No-match
An output condition in which decoded data does not match an entry in the match code table.

No-Read
When the camera is unable to decode a bar code as it passes through the scan zone.

Non-Read
The absence of data at the camera output after an attempted scan due to no code, defective code, camera failure or operator error.

Odd Parity
A data verification method in which each character must have an odd number of on bits.

Omnidirectional
Bar code orientation is unpredictable and can be at any angle. A single scan line is not sufficient to scan bar codes oriented
omnidirectionally.

One-dimensional Symbologies
Also referred to as linear codes. Examples: Code 39, I2of5, and UPC are all 1D or linear bar codes.

Operating Range
The sum of the camera’s optical throw and depth-of-field.

Optical Throw
Measured distance from the camera’s window to the near reading distance of the depth of field. Typically, this is the closest a bar
code can be to the camera’s window and still be properly decoded.

Optimum Reading Distance
Typically, the center of the depth of field (DOF).

OCR
Optical Character Recognition.

OCR Image Engine
Refers to a camera that does not include a bar code decoder. Image data is provided by the camera directly to a customer-supplied
OCR decoder.

Orientation
The alignment of the code’s bars and spaces to the camera. Often referred to as vertical (picket fence) and horizontal (ladder).
Since cameras are capable of reading bar codes omnidirectionally, bar code orientation is not as critical as it used to be with
single-line laser scanners.

Oversquare
Used to describe bar codes that are taller (from top to bottom of the bars) than they are wide (from first to last bar).

Package Spacing
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This is the spacing between items on a conveyor. Package spacing is measured one of two ways: Leading edge of one box to
leading edge of the next or trailing edge of one box to trailing edge of the next. Package spacing is critical to system operations,
especially in front read applications.

Parameter
1) A value or opinion that you specify to a program. In Accu-Setup, all user-definable parameters are selected through the use of
the various tab screens, drop-down menus, and slider bars. 2) In programming, a parameter is sometimes called a switch or an
argument.

Parity Bit
A bit that is set at “0” or “1” in a character to ensure that the total number of 1 bits in the data field is even or odd.

PDF417
For details, see Symbologies

Percent good reads
The number of successful reads per refresh period. This is valid only when the refresh period is set to 0.

Performance indicator
A bar code decoder function that counts the number of decodes during a trigger period.  When the period = 0,  the performance
indicator provides the number of decodes (up to 100 attempts).  Use the performance indicator to provide a general indication of
bar code symbol quality or verify proper setup of the scanner.

Peripheral Device
An internal or external device, such as a printer, a disk drive, or a keyboard, connected to a computer.

Photoeye
Sometimes used as a presence detector to identify objects in the camera’s reading zone. The photoeye emits a beam and is used
with a reflector to create a photoelectric circuit. When the beam is blocked by an object, breaking the circuit, a TRIGGER signal
is sent to the camera. (See also Light Curtain and Trigger.)

PLANET
For details, see Symbologies

Polling
A means of controlling devices on a multipoint line.

Port
Refers to the physical connections made to the AccuVision camera and other devices. The AccuVision camera’s ports include:
COM, HOST, GRAY IMAGE DATA.

POSTNET
For details, see Symbologies

Protocol
A formal set of conventions governing the formatting and relative timing of message exchange between two communicating
systems.

Pulses Per Inch (PPI)
Defines the number of pulses per inch of transport travel as provided by the tachometer.

Pulse Width
A change from the leading edge of a bar or space to the trailing edge of a bar or space over time. Pulse width is also referred to as
a transition.

Quad Relay Box
Optional Accu-Sort hardware device used to control up to four parallel I/O from the camera’s SMIO I/O Port.

QR Code
For details, see Symbologies

Queue
A buffer used to hold data in order until it is used or transmitted.

Quiet Zone
Required distance before the first bar and after the last bar of the code that must be free of marks or printing.

Read Zone
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Area in front of the scanner’s window in which the bar code should appear for scanning. This zone consists of the scan window
and the raster width (if used).

Reflectance
The amount of light returned from an illuminated surface. A sodium illumination will provide more reflectance than an LED
illumination.

Relative Camera Angle
The mounting angle of the camera as it relates to the conveyor surface and direction of travel. (See illustration AccuVision
Scanning Area Diagram in Chapter 1.)

Relay
Relays are simply electrical switches that are typically used to control external diverts, alarms, etc. Relay types available are
FORM A and FORM C. FORM C type relays have both normally open and normally closed contacts available while FORM A
type relays have only normally open contacts available.

Relay Output Duration
This is the time (in seconds) after the relay is energized that it should be turned off.

Relay Output Delay
The time lapse between an event and the energizing of the relay.

Request To Send (RTS)
An RS232 modem interface signal which indicates that the DTE has data to transmit.

Resolution
1) Camera resolution is referenced in pixels per inch across the belt (DPI) and in the direction of travel (LPI). 2) The narrowest
element dimension that can be distinguished by a particular reading device or printed with a particular device or method.

Response Time
The elapsed time between the generation of the last character of a message at a terminal and the receipt of the first character of
the reply. It includes terminal delay and network delay.

ROM
The acronym for read-only memory. The computer contains programs essential to its operation in ROM. A ROM chip retains its
contents even after you turn off your computer.

RS-232
Interface between data terminal equipment and data communication equipment employing serial binary data interchange.

RS-422
The Electronic Industries Association standard that specifies the electrical characteristics of balanced voltage digital interface
circuits.

RS-485
The Electronic Industries Association standard that specifies the electrical characters of generators and receivers for use in
balanced digital multipoint systems.

RS-644  (check for better definition)
Parallel Interface used with Gray Image Data and Gray Image Data Aux Ports of an AccuVision cameras

Scan Area (Scanning Area)
The location of the conveyor being scanned by the camera(s) for bar code symbologies and/or image data.

Scan Line
The line in the object plane that is currently being imaged by the camera. (See also DPI, Dots Per Inch.)

Scan Line Clock (SLC)
Identifies the signal that causes the camera to finish collecting light for the current scan and to shift the collected data out of the
camera (and begin collecting light for the next scan).The frequency of the scan line clock may vary with object height and/or
speed.

SLC (lines/sec. or hertz) = LPI * transport_speed (inches/sec.)

Self-checking
A bar code or symbol using a checking algorithm which can be independently applied to each character to guard against
undetected errors.
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Sensor
A device that detects or measures something and generates a corresponding electrical signal to an input circuit of a controller. In
the case of AccuVision cameras, a CCD sensor array is used to collect light and convert it to an electrical signal. (See How an
Image is Acquired in Chapter 1.)

Serial Port
1) I/O ports located on the AccuVision camera’s SMIO panel that are used for communications with the HOST, APC100 (COM),
etc. 2) An I/O port used most often to connect a modem or a mouse to your computer, identifiable by its 9-pin connector.

Serial Transmission
The most common transmission mode; serial, information bits are sent sequentially on a single data channel.

Serial Asynchronous Transmission Of Data
The following are common serial communications interfaces: RS232, RS422, and RS485.

When data is transmitted serially from a communications port, the information is transferred between the two devices one data bit
at a time. The data flow can follow one of three different communications modes: simplex, half duplex, or full duplex. Each
character of data within the data flow is transported in a binary bit frame called the asynchronous data frame.

The start bit begins each frame. A low voltage signal on the data communications line marks the beginning of the start bit, at
which point the receiving device begins looking for binary zeros and ones (0’s and 1’s).The following five to eight data bits (the
number depends on the format used) comprise the binary character. For error detection, an optional parity bit can define whether
the total number of zeros or ones was even or odd. There are five different parity selections as shown below:

ODD
last data bit is a logical 0 if the total number of logical 1’s in the first seven data bits is odd.

EVEN
last data bit is a logical 0 if the total number of logical 1’s in the first seven data bits is even.

MARK
last data bit is always a logical 1 (i.e.: high/mark).

SPACE
last data bit is always a logical 0 (i.e.: low/space).

OFF (NONE)
last data bit is not present.

The method used to catch errors by using parity bits is as follows: When the transmitter frames a character, it tallies the number
of 0’s and 1’s within the frame and attaches a parity bit. (The parity bit varies according to whether the total is even or odd.) The
receiving end then counts the 0’s and 1’s and compares the total to the odd or even recorded by the parity bit. If a discrepancy is
noticed by the receiving end, it can flag the error and request a retransmission of the data.

A stop bit is used to signal the end of the character. (Stop bits are typically one or two bits in length. The slower the transmission
speed, the more stop bits required for recognition of the end of the data frame.)

In addition to the direction of data flow and the data framing, there are other considerations to insure uniform transmissions.
Certain operating parameters must be followed to prevent the loss of valuable data.

The first consideration is the speed of transmission, known as baud rate. Serial data transmission is measured in bits per second
(BPS). The baud rate selections typically available are: 1200, 2400, 4800, 9600 and 19200. To enable two devices to interact,
they must both be transmitting/receiving data at the same baud rate. If it is not possible to do this, there must be a buffer
(typically additional storage memory) that accommodates the differences in communications speed.

Many serial communications links also use a flow control system to handle data transmission in addition to memory buffers.

X-ON/X-OFF Protocol
A common type of flow control is the X-ON/X-OFF protocol. When a receive buffer nears its memory capacity, the receiving
device sends an ASCII X-OFF signal to the transmitting device, telling it to stop sending data. When the memory buffer has
enough space to handle more data, the X-ON signal is sent to the transmitting device, telling it to start sending data again.

ACK/NAK Protocol
Another common protocol is ACK/NAK protocol. When the device transmits a message to the host, the host responds with either
an ACK (06H) or a NAK (15H). If the host transmits an ACK to the device, the device deletes its transmit message and the
communication sequence is complete. If the host transmits a NAK, the device will retransmit. The device resends data a
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maximum of three times. Optionally this may be changed to 1, 2, 3, or infinite retransmits by the user. If the device receives a
fourth NAK, it will delete the data in its transmit buffer and display “MAX REXMITS”.
A transmitting device ignores ACK and NAK characters received during data transmission. If, for example, a device receives a
NAK during a data transmission, it will not resend the data at the completion of the transmission.

The device also has a retransmit timer. This timer is activated each time the device transmits data to the host. If the timer runs for
two seconds (this is also changeable) and the device does not receive an ACK or NAK from the host, a timeout occurs and the
device retransmits its data. Each time the device retransmits because of a timeout, it treats the timeout the same as receiving a
NAK from the host computer. If the device does not receive an ACK before the end of the fourth timeout, it will delete the data
in its transmit buffer and display “MAX REXMITS”. The device deletes data in its transmit buffer and displays the error message
when any combination of four timeouts and NAKs from the host occurs.

When the device receives a message from the host, it calculates the BCC for the message and compares the calculated BCC to the
received BCC. If the two values match, the device transmits an ACK, ending the communication. If the values do not match, the
device transmits a NAK to the host and waits for the host to retransmit the message. The host, like the device, should retransmit a
maximum of three times.

The sequence number starts at zero (30H) and is incremented each time a device transmits a new message. When the sequence
number reaches nine (39H), it wraps around to one (31H). If the sequence number skips a number, the receiving device knows
that a message was lost. If the same sequence number is received on two sequential messages, the second message is responded
to with an ACK or NAK (as appropriate) and ignored.

Shielding
Protective covering, typically around interconnection cabling, that eliminates electromagnetic and radio frequency interference.
Proper shielding of all interconnections is necessary to assure correct operation of the AccuVision System.

Side Read
The camera is mounted to read the sides of packages as they pass through the scanning area. Sometimes side read cameras are
also positioned to read codes on the front or back of boxes as well as the side.

Signal
An impulse or fluctuating electrical quantity (i.e.: a voltage or current) the variations of which represent changes in information.

Slider bar
A graphical user interface that enables the user to select an ascending/descending value for a definable parameter by clicking on
the slider bar and then sliding (via the mouse) until the desired value is shown. For example: Maximum Package Length is
selected using a slider bar on the Modify Setup / Trigger Tab screen.

Smart I/O (SMIO)
Also referred to as the SMIO, this term identifies both the main connector panel and internal board that acts as the control center
of the AccuVision camera system. All physical interconnections between the camera, other AccuVision modules, and the outside
world occur through the SMIO. The SMIO is a single-board computer that provides real-time control of the illumination, package
detection, and package tracking, while monitoring the operation of the system, controlling imaging, and handling all
communications with the decoder, Accu-Setup user interface, and host computer.

SMIO Talk
A WindowsNT® application that provides aTCP/IP communication interface from the camera’s SMIO to the outside world.
Enables multiple external processes to occur simultaneously. AVCore, Accu-Setup, and AVCHI communicate with the camera
through SMIO Talk.

Sodium Illumination
High-power sodium lamp light source used by cameras to illuminate the scanning area in applications with larger DOF
requirements and/or where faster conveyor speeds are a consideration.

Space
The lighter elements of a 1D bar code symbol formed by the background between bars.

Specular Reflections
A condition when light is reflected back from the code’s surface at an angle equal, or nearly equal, to the angle of incidence of
the laser light. This condition makes it difficult for the camera to detect the differences in light variation caused by the code’s
bars and spaces.

Spot
The undesirable presence of an area of low light reflectance in a space of a 1D symbology.

Start and Stop characters
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1) Characters used to identify the beginning and end of a bar code. 2) Characters used to identify the beginning and end of
messages sent to the host. (See Header, Trailer, Start Bit, and Stop Bit(s).)

Stacked 2D Symbology
Where a long symbol is broken into sections and "stacked" one upon another similar to sentences in a paragraph. Extremely
compact codes. Example: PDF417.

Start Bit
In asynchronous transmission, the first bit or element in each character, normally a space, that prepares the receiving equipment
for the reception and registration of the character.

Stop Bit(s)
The last bit in an asynchronous transmission, used to indicate the end of a character, normally a mark condition, that serves to
return the line to its idle or rest state.

STX (Start of Text)
A transmission control character that precedes a text and is used to terminate a heading.

Symbol
A combination of characters including start/stop and checksum characters, as required, that form a complete scannable bar code.

Symbologies
Also known as bar codes or symbologies. There are many symbology standards being used for product identification.
Symbologies can be divided into two main categories: linear and two-dimensional (2D). (See Appendix B of the AccuVision
Sales Guide for additional information.) Below is a list of the symbologies that can be read by AccuVision Systems:

Codabar
Self-checking, numeric bar code encoding numbers and several characters (e.g.: $, -, +, ?) with a slightly higher density than
Code 39. Includes two bar/space sizes.

Code 39 (Code 3 of 9)
A bar code with a full alphanumeric character set, a unique start and stop character, and three other characters. The name is
derived from its code structure, which is 3 wide elements out of a total of 9 elements. The nine elements consist of five bars and
four spaces.

Code 93
Similar to Code 39 but requires two check characters. Code 93 was designed to provide a higher density symbology with higher
security than Code 39. Although code 93 is a higher density, it is not self-checking and therefore requires two checksums.

Code 128
A bar code symbology capable of encoding the full ASCII 128 character set. It encodes these characters using fewer code
elements per character resulting in a more compact code. It features a unique start and stop character for bidirectional and
variable length decoding, both bar and space character parity for character integrity, a check character for symbol integrity, a
function character for symbol linking, and spare function characters for unique application definition and/or future expansion.

Data Matrix
2D (two-dimensional) symbology. Two distinct characteris-tics make it easy to identify: 1) a solid line along two adjacent sides,
accompanied by 2) a pattern of alternating squares on the opposite sides. In the most common version of the symbol (known as
ECC200), the alternating square side 'corner' is always a space.

EAN
European Article Numbering System used in retail industry (a superset of UPC) used on product packaging to uniquely identify a
product and manufacturer.

Interleaved 2 of 5 (I 2of5)
A bar code with a numeric character set with different start and stop characters. The name is derived from the method used to
encode two characters. In the symbol, two characters are paired together using bars to represent the first character and the spaces
to represent the second. This interleaved structure allows information to be encoded in both the bars and the spaces. A start
character, bar and space arrangement, at one end, and a different stop character bar and space arrangement at the other end,
provide for bidirectional decoding of this symbol.

MaxiCode
2D (two-dimensional) symbology developed by the United Parcel Service. Square data elements and a round bullseye at the
center of the symbol (known as the central finder character). Maxicode has been released to the public domain for use by anyone.

PDF417
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2D (two-dimensional) symbology developed by Symbol Technologies. Appears like multiple linear codes stacked one on top of
the other. As a result of being based on linear bar codes, PDF417 is one of a few 2D symbologies that can be scanned by laser
scanners.

PLANET
Postal alpha numeric encoding technique is a tall bar/short bar symbology used by the United States Postal Service for special
services such as CONFIRM and CIPS. PLANET digits consist of three tall and two short bars and is designed as a compliment of
POSTNET.

POSTNET
Postal numeric encoding technique is a tall bar/short bar symbology used by the United States Postal Service to encode ZIP
information on letter and flat mail. POSTNET is also being used overseas: AccuVision can read both the Japanese and Australian
versions. POSTNET digits consist of two tall and three short bars.

QR Code
2D (two-dimensional) symbology. Easily recognized by square data elements and it's three part finder pattern. Sets of square-in-
a-square patterns are located in three corners of this square symbol.

UPC
Acronym for Universal Product Code.  The standard bar code type for retail packaging in the United States and Canada.

Syntax
The rules dictating how you must type a command or instruction so the computer will understand it.

System.ini file
When you start Windows, it consults the system.ini file to determine a variety of options for the Windows operating environment.
Among other things, the system.ini file records which video, mouse, and keyboard drivers are installed for Windows. Running
the Control Panel or Windows Setup program may change options in the system.ini file.

Tach (Tachometer)
Hardware device used to provide conveyor speed information to the AccuVision camera in 20 pulses per inch (20 PPI).

Tag
A collection of information associated with a single variable or I/O point.

Tap(s)
Taps (or “channels”) refer to the number of data paths out of the linear CCD sensor. A linear CCD sensor consists of a line of
light-sensitive areas. The charge collected in all these areas is shifted to a parallel array of non-light sensitive holding areas all at
once. The charges are then shifted along the second set of areas in a “bucket brigade” fashion with the last area’s charge being
shifted off the sensor entirely (for further processing). This holding area does not have to all be shifted out of a single port – the
holding line may be broken into several sections, each with it’s own “exit” from the sensor. Each “exit” is called a “tap” or
“channel”. Generally, the more “taps” the more quickly the image data may be shifted out of the sensor. Current camera
configurations offer either 2 or 4 taps. Tap Frequency (MHz) is the clock rate at which pixels are shifted out of the CCD sensor.

TCP/IP
An industry standard suite of protocols providing communications in a heterogeneous network environment. TCP/IP stands for
Transport Control Protocol/Internet Protocol.

Trailer
A means of identifying the end of a message sent to the host. One example is <ETX> or End of Text. (See ASCII chart in
Appendix C.)

Two-width symbology
A bar code symbology whose bar and spaces are characterized simply as wide or narrow.  Codabar, Code 39, and Interleaved 2 of
5 are examples of two-width symbologies.

Tracking
Process of keeping track of packages as they travel through the scanning area. Tracking can be done based on the leading edge or
trailing edge of packages. Belt speed (as monitored via the TACH signal) and camera mounting also figure into the tracking
process. (See Modify Setup / Tracking tab in Chapter 3.)

Transmit Point
The time it takes to transmit the decoded results from the time the object is first sensed (by PE or light curtain) until the
completion of transmission to the host. Transmit point is shorter (faster) for cameras because it is not required to accommodate a
scanning pattern length.

Trigger
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(Formerly known as CART, short for Carton Present)
A signal, typically provided by a photoeye or light curtain, that informs the camera of the presence of an object within the
scanning area. This signal defines for the camera the time period during which to capture image data.

Trigger Cycle
The time during which the camera is capturing image data and, in the case of symbology readers, attempting to read the bar code.
(See the Modify Setup / Trigger tab and Diagnostics & Utilities / Trigger tab.)

Two-dimensional Symbologies
More complex bar code capable of containing much larger amounts of data in a smaller image size because of using either a
stacked or matrixed construction when compared to the 1D codes. Example 2D codes: DataMatrix, MaxiCode, and PDF417.

UCC (Uniform Code Council)
The organization which administers the UPC and other retail standards.

Undersquare
Used to describe bar codes that are longer (from the first to last bar) than they are high (from the top to bottom of the bars).

UPC
For details, see Symbologies

UPS
The abbreviation for uninterruptible power supply. A battery-powered unit that automatically supplies power to your APC100
Decoder in the event of an electrical failure.

Utility, Utilities
1) A series of Accu-Setup features that enables the user to manage various functions of the AccuVision system. For further
details on these functions, see the Diagnostics and Utilities tabs and the Utilities drop-down menu of Accu-Setup.  2) A program
used to manage system resources including memory, disk drives, and printers.

Values File, VAL File
One of three files stored on the APC100 that can be modified via Accu-Setup. Values that are changed using the series of Modify
Setup tabs will only be saved when the Save to Camera or Save to Disk functions are used.

Verifier
A device that makes measurements of the bars, spaces, quiet zones and optical characteristics of a symbol to determine if the
symbol meets the requirements of a specification or standard.

Void
The undesirable presence of an area of high reflectance in a bar.

Wide Bar (WB) / Wide Space (WS)
Widest code element, bar or space, in the bar code symbol.

Wide to Narrow Ratio
Dividing the size of the wide elements by the size of the narrow elements of a bar code yields the bar and space ratios. Bar and
space ratios can differ. NOTE: If the narrow bar and narrow space are equal and the wide bar and wide space are equal then you
calculate only one ratio.

Window
A software graphical user interface that appears on a monitor with which the users interacts (via keyboard and/or mouse) to
operate various user-definable functions. In both AVCore and Accu-Setup, there are several tabs, buttons, and drop-down menus
available from the Main Window.

Write-protected
Read-only files are said to be write-protected. You can write-protect a 3.5-inch diskette by sliding its write-protect tab to the open
position and a 5.25-inch diskette by placing an adhesive label over its write-protect notch.

"X" Dimension
The dimension of the narrowest bar and/or narrowest space in a bar code.

XON
A control character sent by the receiving device to signal the transmitting device to begin sending data.

XOFF
A control character sent by the receiving device to signal the transmitting device to stop sending data.
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APPENDIX F: REVISION HISTORY

Manual
Revision #

Software
Version  #

Date Changes Made

0.3 3.1 1/23/01 Initial release of Accu-Setup for AccuVision Software Manual for Version 3.1
0.4 3.3 3/30/01 1. Define difference between Accu-Setup & SMIO Commands. (Chap.1, pg.1-18.)

2. Clarify the difference between LPI and scan line frequency pg. 1-10, 4-7).
3. Network Identification (Computer Name and Workgroup) added to the

Advanced Communications found under Modify Setup / Communications Tab.
(See Chapter 3.)

4. Reboot Decoder added to the Utilities drop-down menu. (See Chapter 5.)
5. Add notebox to Auto Backup and Auto Retrieve regarding default settings.
6. Removal of Custom Tab from Modify Setup Tabs. (See Chapter 3.)
7. Minor enhancements throughout document including bookmark/cross-references.

0.5

ECN S196

4.0 7/27/01 Revised to cover the new functionality of Accu-Setup for AccuVision, Version 4.0
1. Addition of compatibility with VisionCube dimensioning software. (See Modify

Setup / Dimensioning Tab in Chapter 3.)
2. Support added for both the Aztec and RSS symbologies. (See Modify Setup /

Symbologies Tab in Chapter 3.)
3. Supports POSTNET merging tolerances. (See Modify Setup / Symbologies Tab in

Chapter 3.)


	AVMMSC10-5.pdf
	Heading 2

	AVMMSC20-5.pdf
	Heading 2

	AVMMSC40-5.pdf
	Heading 2

	AVMMSC50-5.pdf
	Heading 2

	AVMMSC60-5.pdf
	Heading 2


